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Preface

This manual provides information about installing and using Nways Deployment
Manager.

This release of Nways Deployment Manager supports these network devices:
v 2210 Nways® Multiprotocol Router
v 2212 Access Utility
v 2216 Nways Multiaccess Connector
v 8275 Ethernet Desktop Switch

Who Should Read this Manual
This manual is intended for Network Administrator who are responsible for
managing and maintaining network device configurations.

How this Manual is Organized
This manual contains these chapters:

v “Chapter 1. Getting Started with Deployment Manager” on page 1 explains how to
install and customize Deployment Manager for your organization. It includes
information for setting up the Deployment Manager database and troubleshooting
installation problems.

v “Chapter 2. Using Deployment Manager” on page 7 provides task-based
scenarios for the most commonly used functions in Deployment Manager. It
includes step-by-step procedures and screen captures to help you get up and
running quickly.

v “Chapter 3. Understanding Deployment Manager Task Panels and Dialogs” on
page 43 lists each of the Deployment Manager task panels and menus. It
provides a description for each of the fields (both display and entry) and explains
the format requirements for entry fields.

v “Chapter 4. Understanding 2210 Task Panels and Dialogs” on page 67 lists each
of the Deployment Manager task panels and menus related to the 2210. It
provides a description for each of the fields (both display and entry) and explains
the format requirements for entry fields.

v “Chapter 5. Understanding 2212 Task Panels and Dialogs” on page 107 lists each
of the Deployment Manager task panels and menus related to the 2212. It
provides a description for each of the fields (both display and entry) and explains
the format requirements for entry fields.

v “Chapter 6. Understanding 2216 Task Panels and Dialogs” on page 139 lists each
of the Deployment Manager task panels and menus related to the 2216. It
provides a description for each of the fields (both display and entry) and explains
the format requirements for entry fields.

v “Chapter 7. Understanding 8275-416 Task Panels and Dialogs” on page 171 lists
each of the Deployment Manager task panels and menus related to the 8275. It
provides a description for each of the fields (both display and entry) and explains
the format requirements for entry fields.

Related Publications
In addition to this manual, you may find the following publications useful as
reference when using Deployment Manager.
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Nways Publications
These documents apply to Nways:

v ATM User’s Guide, SH11-3068

v Element Manager User’s Guide, GA27-4221

v Installation Guide

v Nways Manager Remote Monitor User’s Guide, SA33-0367

v Nways Remote Monitor for Windows NT User’s Guide, SA27-4195

v LAN Network Manager/Intelligent HUB Management Program User’s Guide,
GA27-4232

2210 Publications
These documents apply to the 2210:

v Introduction and Planning Guide, GA27-4068

v Installation and Initial Configuration Guide, GC30-3867

v Router Description and Configuration Scenarios, GG24-4446

v Configuration Program User’s Guide, GC30-3830

v Service and Maintenance Manual, SY27-0345

v Software User’s Guide, SC30-3681

v Using and Configuring Features, SC30-3992

v Protocol Configuration and Monitoring Reference Volume 1, SC30-3680

v Protocol Configuration and Monitoring Reference Volume 2, SC30-3865

v Event Logging System Messages Guide, SC30-3682

2212 Publications
These documents apply to the 2212:

v Introduction and Planning Guide, GA27-4215

v Installation and Initial Configuration Guide, GA27-4216

v Hardware Configuration Quick Reference, GX27-4048

v Configuration Program User’s Guide, GC30-3830

v Service and Maintenance Manual, GY27-0362

v Software User’s Guide, SC30-3988

v Using and Configuring Features, SC30-3989

v Protocol Configuration and Monitoring Reference Volume 1, SC30-3990

v Protocol Configuration and Monitoring Reference Volume 2, SC30-3991

v Event Logging System Messages Guide, SC30-3682

v

2216 Publications
These documents apply to the 2216:

v Introduction and Planning Guide, GA27-4105

v Installation and Initial Configuration Guide, GA27-4106

v Hardware Configuration Quick Reference, GX27-3988

v Service and Maintenance Manual, SY27-0350

v Configuration Program User’s Guide, GC30-3830

v Software User’s Guide, SC30-3886
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v Using and Configuring Features, SC30-3993

v Protocol Configuration and Monitoring Reference Volume 1, SC30-3884

v Protocol Configuration and Monitoring Reference Volume 2, SC30-3885

v Event Logging System Messages Guide, SC30-3682

8275 Publications
These documents apply to the 8275:

v Electronic Emission and Safety Notices

v Quick Installation Guide

v Quick Reference Card

v Installation and Planning Guide

v User’s Guide, GC30-4026

v 4-Port 100BASE-FX Feature Module Remove/Replace Instructions
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Chapter 1. Getting Started with Deployment Manager

Keeping track of the device configurations in your network can be a challenging and
time-consuming task. Just trying to determine what level of operational code or boot
code is running in a device is extremely difficult, much less trying to ensure all
devices are running the proper level of code.

Nways Deployment Manager (NwDM) is designed to make tracking and updating
device configurations easier and more efficient. It allows you to:

v Manage the operational code (load images) and boot code (PROM images) for
devices, obtaining the latest levels from IBM web sites when needed.

v Synchronize the Nways database with the NwDM database to keep the NwDM
database updated with the latest changes.

v Manage the upgrade and deployment of device configurations (including
configuration files). You can maintain multiple configurations for a specific device.

v Determine the current configuration for a specific device, and manage the loading
of new configurations into a specific device (or multiple devices) on a scheduled
basis.

This release of Nways Deployment Manager supports these network devices:
v 2210 Nways Multiprotocol Router
v 2212 Access Utility
v 2216 Nways Multiaccess Connector and Network Utility
v 8275 Model 416 Ethernet Desktop Switch

Nways Deployment Manager is installed automatically when you install Nways
Manager.

Customizing Deployment Manager
You can customize some of the operational parameters of Deployment Manager
using the properties file. The Properties file for NwDM on Windows NT is:

nways\java\properties\CfgManProperties.txt

where nways is the directory on the server where NwDM is installed.

The Properties file for NwDM on AIX is:

/usr/CML/JMA/java/properties/CfgManProperties.txt

Syntax Rules for Editing the Properties File
Follow these syntax rules when editing the Properties files:

v Comment lines begin with the pound sign (#) as the first non-blank character on
a line.

v Parameters can be entered on multiple lines. To logically continue a line on the
next line, use the backslash character (\) as the last character on the line to be
continued.

v The backslash character is a special character that gives the character following
it special meaning. Therefore, if you need to use the backslash as a literal
character, you must type two of them together (\\).
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v To specify directories in NwDM (for both Windows NT and AIX), you can use the
forward slash character. For example, you can specify mydir as a subdirectory of
the dir on the c: drive using this syntax:

v c:/thedir/mydir

Property File Contents
You can configure these operational aspects of Deployment Manager:

v Database

v Working Directories

v TFTP

v Telnet

v GUI Configuration Tools

v Job Dispatching

Database Parameters
You should have installed DB2 when you installed Nways Manager. In addition, you
should have created a DB2 database for Deployment Manager. Refer to the Nways
Manager Installation Guide (AIX or NT, depending upon your operating system) for
more information about installing and setting up DB2.

Use these parameters to specify the database information to be used by NwDM:

v JDBC Driver name . Specify the JDBC driver to be used.

v CfgManUrl . Used to specify the name of the NwDM database. The default
database name shipped with NwDM is CfgMan.

v Database User ID . Specify the user ID used for the Nways topology database or
leave the user ID blank.

v User Password . Specify the user password to be used. If you left the user ID
blank, leave this parameter blank as well.

Working Directories Parameters
Deployment Manager uses the parameters to control where files are stored during
operation. Use these parameters to specify the working directories used by Nways
Deployment Manager:

v tempDirectory . Specify the location where NwDM can store temporary files
during operation. The directory specified for this parameter must be a directory
that exists. NwDM will control the deletion of files in this directory when the files
are no longer needed.

v logDirectory . Specify the directory where NwDM can store job logs (which
provide details of job execution). The directory specified for this parameter must
point to a directory that exists. The logs are stored in this directory using this file
naming convention:

Job jobnumber.log. For example, job147.log

TFTP Parameters
Nways Deployment Manager uses a trivial file transfer protocol (TFTP) server to
communicate with network devices. The TFTP server is used as a staging area for
load images. For example, assume that you have fifteen 2210 devices located in
South Carolina. You might have one TFTP server that connects with these devices.
The TFTP server would contain the Load images and PROM code used in the
servers or network devices (routers and switches). That way, you could always
ensure that you have access to the appropriate load image and PROM code in the
event a 2210 device experiences a problem.
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NwDM is shipped with its own TFTP server for performing these functions.
However, you can choose to use your own TFTP server instead.

The TFTP server can be used to:

v Store device configurations (load images, configuration files, and PROM images)

v Send device configurations to the device.

v Receive device configurations from the device (or from another location).

TFTP functions are controlled by these parameters:

v startTftpServer . Specify yes if you want to use the TFTP server shipped with
NwDM, or no if you want to use your own TFTP server.

v tftpMaxRetries . Specify the number of times the TFTP server retries a transfer
before failing. This parameter is valid only for the TFTP server shipped with
NwDM.

v tftpTimeout . Specify the number of seconds that the TFTP server is to wait for
an acknowledgment before retrying a transfer. This parameter is valid only for the
TFTP server shipped with NwDM.

v tftpInboundDir . Specify the directory on the TFTP server to be used by clients
for operation put files. The directory you specify for this parameter will typically
be the same as the directory you specify for tftpOutboundDir . If you do not use
the TFTP server provided with Nways Deployment Manager, configure your TFTP
server to put files into this directory by default.

v tftpOutboundDir . Specify the directory on the TFTP server to be used by clients
for get operation files. The directory you specify will typically be the same as the
directory you specify for tftpInboundDir . If you do not use the TFTP server
provided with NwDM, configure your TFTP server to send files from this directory
by default.

v localTftpClientAddr . Specify the local IP address that NwDM will use. If this
parameter is blank, NwDM uses the first available IP address. If you have
multiple network interface cards and your network routing prevents TFTP servers
from reaching the IP addresses for all of them, specify an IP address that can be
reached from TFTP servers.

Telnet Parameters
NwDM operates as a Telnet client for some operations performed on network
devices. These parameters control the operation of NwDM when it serves as a
Telnet client:

v devCtl.NormalTimeout . Specify the number of seconds that NwDM will wait for
a “quick” response from a client. If the NwDM job logs contain Telnet timeout
errors for commands that normally execute very quickly, increase the value of
this parameter.

v devCtl.EraseTimeout . Specify the number of seconds that NwDM will wait for an
erase command to complete. Remember that the completion of an erase
command can take a log time. If the NwDM job logs contain Telnet timeout errors
for erase commands, increase the value of this parameter.

v devCtl.tftpGetTimeout . Specify the number of seconds that NwDM will wait for a
device to receive a file from a TFTP server. If the NwDM job logs contain Telnet
timeout errors for TFTP get or put commands, increase the value of this
parameter.

v dummyCdb . Reserved.
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GUI Configuration Tool Parameters
Nways Deployment Manager allows you to upgrade configurations, which requires
both the configuration tool for the existing configuration as well as the configuration
tool for the new configuration. If you are using configuration tools that were
originally shipped prior to July, 1998, you will need to run the Nways Manager
Config Tool Locator to tell Deployment Manager where the older configuration tools
are located. For more information about running the Config Tool Locator and
working with device configuration programs, refer to the Nways Manager Installation
Guide(AIX or NT, depending upon your operating system).

NwDM launches the GUI Configuration Tools with command-line arguments to
perform version or release upgrades and to convert configuration files between
ASCII and SRAM file formats. NwDM uses information from the GUI Configuration
Tool installation to determine where the GUI Configuration Tools are located.
Therefore, you should always use the installation program for a GUI Configuration
Tool when you install it.

This parameter controls the operation of GUI Configuration Tools by Nways
Deployment Manager:

v cfgToolTimeToLive . Specify the number of seconds that you want NwDM to wait
before halting the execution of a GUI Configuration Tool. When NwDM launches
a GUI Configuration Tool, it sets a timer to determine how long the GUI
Configuration Tool can process. If a GUI Configuration Tool has not completed
processing before the timer expires, NwDM stops the processing.

Job Dispatching Parameters
You can use NwDM to schedule jobs for managing device configurations at times
that are convenient for you. There is no limit on the number of jobs that you can
schedule. However, if too many jobs are actually running at the same time, you risk
overloading server or network resources.

This parameter controls the number of jobs that can be actually running at the
same time.

v maxJobsRunning . Specify the number of jobs that can be running at any given
point in time. You can use this parameter to ensure that NwDM does not
overload the server or the network with too much activity from the jobs that are
running.

Sample Properties File
This is a sample of the Properties file as it is shipped:
# This is the CfgMan properties file

#The following are for DB/2 only
JdbcDriverName=COM.ibm.db2.jdbc.app.DB2Driver
CfgManUrl=jdbc:db2:CfgMan

CfgManUserId=admin

CfgManPassword=admin

CfgManSchema=CFGMAN

logDirectory=CfgMan/Logs
tempDirectory=CfgMan/Temp

useOwnWindowsCfgTool=yes
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#------------------------------------------------
# TFTP Client and Server Properties
#------------------------------------------------

startTftpServer=yes
tftpMaxRetries=20
tftpTimeout=4

localTftpClientAddr=
tftpInboundDir=CfgMan/TftpSvrRoot
tftpOutboundDir=CfgMan/TftpSvrRoot

#------------------------------------------------
devCtl.NormalTimeout = 20
devCtl.EraseTimeout = 480
devCtl.tftpGetTimeout = 1800

dummyCdb=./dummy.cdb

cfgToolTimeToLive = 1800

maxJobsRunning = 10

Troubleshooting the Deployment Manager Installation
If, when you initially start Deployment Manager, you receive error messages about
accessing the database, you should check the log file for errors. The log file is:

nways\java\properties\log\NwaysManagerx.log

where:

v nways is the directory where you installed the product.

v x is the log number from 1 to 10. Each time the JMAintegrator server starts, a
new log file is opened (NwaysManager1.log through NwaysManager10.log). After
10 log files have been opened, the file name wraps to 1 again.

When choosing the log file to edit, make sure you look at the modification dates;
the most recently modified log file is the one you should open in the editor. After
you open the log file, search for the line that begins STARTING CfgManService ,
which begins the Deployment Manager initialization. Initialization is ended with the
line STARTED CfgManService .

Look for one of these errors during initialization:

v java.lang.ClassNotFoundException: COM.ibm.db2.jdbc.app.DB2Driver

This is caused by not having unzipped the db2java.zip file into the Nways either
after installing Nways, or after installing a DB2 fixpak. To resolve this error:

1. Locate the db2java.zip file in the DB2 product directory. On windows NT, the
zip file is located in drive:\sqllib\java\. On AIX, the zip file is located in
/usr/lpp/db2_05_00/java/.

2. Unzip the db2java.zip file into the appropriate directory. On Windows NT, the
directory is nways\java\websvr\code. On AIX, the directory is
/usr/CML/JMA/java/websvr/code.

3. Stop and restart the JMAintegrator process.

a. >ovstop JMAintegrator

b. >ovstart JMAintegrator
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v COM.ibm.db2.jdbc.app.DB2Exception: [IBM][CLI Driver] SQL1031N The
database directory cannot be found on the indicated file system.
SQLSTATE=58031

The CFGMAN database does not exist for Deployment Manager. Use the DB2
Control Center to create the database or issue this command from a DB2
command line:

create database CFGMAN

v COM.ibm.db2.jdbc.app.DB2Exception: [IBM][CLI Driver] SQL1403N The
username and/or password supplied is incorrect. SQLSTATE=08004

The values for the Deployment Manager database user ID and/or password are
incorrect. Edit the Properties file (see “Database Parameters” on page 2 for the
user ID and password parameters). Then stop and restart the JMAintegrator
process:

1. >ovstop JMAintegrator

2. >ovstart JMAintegrator

v COM.ibm.db2.jdbc.app.DB2Exception: [IBM][CLI Driver][DB2/NT] SQL0973N
Not enough storage is available in the ″QUERY_HEAP″ heap to process the
statement. SQLSTATE=57011

The DB2 performance parameter QUERY_HEAP_SZ for the instance needs to
be increased to 10000. On Windows NT:

1. Select the database instance, e.g. DB2.

2. Right click and select Configure...

3. Select the Performance tab from the Configure Instance dialog.

4. Select Query heap size parameter and enter the new value

On AIX:

1. Enter the command UPDATE DATABASE MANAGER CONFIGURATION
USING QUERY_HEAP_SZ 10000.

Then:

1. Stop the JMAintegrator process.>ovstop JMAintegrator .

2. Stop DB2. >db2stop .

3. Restart DB2. >db2start .

4. Restart the JMAintegrator process.>ovstart JMAintegrator

v COM.ibm.db2.jdbc.app.DB2Exception: [IBM][CLI Driver] SQL1402N Unable
to authenticate user due to unexpected system error.

The DB2 Security Manager has not been started (for NT) or has incorrect
permission bits set for db2ckpw (for AIX). On Windows NT:

1. Open the Services applet in the NT Control Panel.

2. Select the DB2 Security Server item in the services list.

3. Click Start .

On AIX, have the system administrator ensure the correct access permissions
are set for db2ckpw, and that there is enough swap/paging space allocated.
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Chapter 2. Using Deployment Manager

After you have successfully installed and customized Nways Deployment Manager,
you are ready to begin using the product. To start Deployment Manager:

v From the NetView main menu, click Tools →IBM Nways Java... →Open
Deployment Manager.

v From the OpenView main menu, click Start →IBM Nways Manager →Launch
Deployment Manager .

The Nways Deployment Manager main screen appears.

Understanding the Configuration Change Management Process
Large networks can contain literally thousands of routers and switches. Each of
these devices has a device configuration consisting of a load image and
configuration file. For some devices, such as the 2210, the configuration also
consists of a PROM image.

Nways Deployment Manager is designed to help you track and maintain device
configurations for the devices in your network. Specifically, Deployment Manager
supports the 2210, 2212, 2216, and 8275 Model 416 devices.

The general tasks for using Deployment Manager to work with devices are:

1. Create inventory records in the Deployment Manager database for each device
type using the Update Software Inventory task. Typically, you will perform this
task to obtain a list of all Load images (and PROM images if needed) from IBM
web sites. These records contain information about the Load images (such as
version and release) available for each device type.

2. After creating the inventory records, you will need to create device records for
each of the supported devices in your network. These device records contain
information about the network device, such as the IP address, SNMP read and
write community names, and operator ID and password.

When you first install Deployment Manager or when there are significant
changes to your network, you can create device records by performing the
Synchronize database tasks, which synchronizes the Deployment Manager
database with the Nways topology database.

You can also create a device record for a single device using the Create device
task.

3. After creating device records for each device, you perform a Learn
Configuration task to create a current configuration record for each device
record. The configuration record that results from a Learn Configuration task
has a configuration status of Active. It includes information about the
configuration actually loaded in device (such as the Load Image version and
release, the device ID for the device to which the configuration applies, and the
status of the configuration).

4. Over time, you will want to modify configurations in a device to incorporate
additional features and functions or move to a new version/release of the
software. To do so, you first perform an Upgrade device task, which creates a
new configuration record for the device. You can have multiple configuration
records for a device (but only one configuration record with a status of Active).
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5. Finally, after you have created a new configuration record for a device, you can
apply it to a network device using an Update device task. When you Update a
device, you actually load a new configuration into the device.

Before, you can update the configuration in a device, you must first add the
Load image, configuration files, and PROM image (if applicable) to the
Deployment Manager database. You can choose to add these files to the
database when you perform a Learn Configuration task or by using an Import
task.

Deployment Manager provides the ability to perform many of these tasks as
scheduled jobs, which allows you to determine when they will execute. In addition,
Deployment Manager allows you to manage these jobs, audit network devices to
verify configurations, and export configurations as needed.

Navigating the Deployment Manager Menus
Figure 1 shows the Deployment Manager main menu.

Figure 1. NwDM Main Menu
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Deployment Manager menus are divided into these areas:

«1¬ Navigation Tree

The navigation tree provides a hierarchical listing of the functions
available with Deployment Manager.

Folders represent categories of functions. For example, the highest level
folder is the application itself (Nways Deployment Manager). Lower level
folders include the 2210, 2212, 2216, and 8275–416 folders, each of
which contains the functions available for managing device
configurations. In addition the Software Inventory folder includes the
functions available for managing base code components, such as load
images or PROM images.

You can open the contents of a folder by clicking on the plus (+) next to
the folder. A list of pages is displayed. To close a folder, click on the
minus (-) next to it, which collapses the list of pages for this folder.
However, the folder itself remains visible.

Pages are displayed within folders; they represent the specific functions
that can be performed. To perform a task, click on the page icon or the
text to the right of the icon. The task panel is updated with information
related to that task.

For example, to add a 2210 device record to the NwDM database, click
on Create Device in the 2210 folder. The Create Device task panel is
displayed in the task panel area.

«2¬ Task Panel

The task panel shows specific panels related to the functions available
within NwDM. The left side of the task panel displays specific tasks that
can be performed, and the right side of the displays task panes
associated with each of the specific tasks.

For example, when you click Set User, the left side of the Set User task
panel displays Current User and Set User. The right side displays task
panes associated with the Current User and Set User.

«3¬ Draggable Axis

The Draggable Axis allows you to change the width of the navigation tree
and the task panel in relation to the size of the Nways Deployment
Manager interface. To have the Navigation Tree fill the entire interface,
click the right arrow at the top of the Draggable Axis. Clicking the left
arrow returns the interface to the default layout.

For example, to have the task panel fill the entire screen, click the left
arrow at the top of the Draggable Axis. Clicking the right arrow returns
the interface to the default layout.

«4¬ Tear-Off Bar

You can use the Tear-Off Bar to drag the task panel to another location
on your desktop. To move the task panel, click and hold the Tear-Off Bar
while dragging the panel to another location with your mouse.

If you tear-off the Task Panel, it continues to work. Clicking an item on
the navigation tree will create a new task panel in the Nways Deployment
Manager interface.
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Working with Deployment Manager Filters and Tables
Nways Deployment Manager serves as a database for information about the
devices in your network. Therefore, Nways Deployment Manager can potentially
have information about thousands of devices. Filters provide a way for you to
search for specific information rather than having to scroll through the entire
contents of the database to find what you are looking for.

Most task panels contain a filter pane that you can use to search the database. You
fill in the fields for a filter and then click Apply Filter . The results are returned in the
form of a Filtered List. From this list, you can select records to be added to the
Custom List, which allows you to store the results from several different database
queries, add them all to a single list, and perform operations against that list.

Filters are tables that contain three columns:

v Property column. The Property column displays all of the properties available for
you to search.

v Comparison Operator column. The Comparison Operator column displays the
comparison operator used for searching.

v The Expression column displays the value for the property. When you apply a
filter, Nways Deployment Manager compares this value (using the Comparison
Operator) to the values of the property for all records in the database.

Comparison Operators
Nways Deployment Manager uses standard SQL comparison operators. The In
comparison operator is the default operator. To select a different comparison
operator, click on a cell in the Comparison Operator column. Then click on the box
to the right of the operator and select the operator that you want to use.

The comparison operators are:

v in . Determines if the value of the property in the database is in the set of values
specified in the Expression column of the filter.

v not in . Determines if the value of the property in the database is not the set of
values specified in the Expression column of the filter.

v like . Determines if the value of the property in the database matches the string
pattern specified in the Expression column of the filter. When using the Like
comparison operator, you can specify the percent symbol (%) in place of zero or
more characters in the Expression column. You can also specify the underscore
symbol (_) in place of a single character.

Note: You cannot use the Like comparison operator with numbers.

For example, if you are searching for a property value of ″abc def″ using Like,
and in the Expression column you specify:

– a%. The record will be found.

– a%f. The record will be found.

– a_c def . The record will be found.

– abc def_ . The record will not be found. In this case, the underscore symbol
represents a character that must be present in the property value. There is no
character left after ″abc def″ is compared with the property value.

– abc def% . The record is found. The percent symbol represents zero or more
characters.
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v between . Determines if the value of the property in the database is within the
range of values (including endpoints) specified in the Expression column of the
filter. To specify a range in the Expression column, use value1 and value2, where
value1 is less than value2.

For example, if you are searching for a property value of ″42″ using between,
and in the Expression column you specify:

– 1 and 100 . The record will be found.

– 1 and 42 . The record will be found.

– 42 and 1 . The record will not be found. The first value specified must be less
than the second value specified.

You can also specify Between to compare strings. When comparing strings, you
must enclose both strings in single quotes. For example, if you are searching for
a property value of ″pqr″ using Between, and in the Expression column you
specify:

– ’a’ and ’z’ . The record will be found.

– ’a’ and ’s’ . The record will be found.

– ’a’ and ’p’ . The record will not be found. The string ″pqr″ is greater than the
character ″p″.

v is null . Determines if the value of the property in the database is missing. If you
specify Is Null, you do not specify a value in the Expression column.

v is not null . Determines if the value of the property exists. If you specify Is Not
Null, you do not specify a value in the Expression column.

v =. Determines if the value of a property is equal to the value you specified in the
Expression column.

v <>. Determines if the value of a property is not equal to the value you specified
in the Expression column.

v >. Determines if the value of a property is greater than the value you specified in
the Expression column.

v >=. Determines if the value of a property is greater than or equal to the value you
specified in the Expression column.

v <. Determines if the value of a property is less than the value you specified in the
Expression column.

v <=. Determines if the value of a property is less than or equal to the value you
specified in the Expression column.

Entering Data in the Expression Column
To enter data in the Expression column:

1. Click on the cell to be changed in the Expression column. The cell changes
color and an I-beam cursor appears in the cell.

2. Type data into the cell.

3. Press Enter or move the cursor out of the table cell.

You can cut data from cells, copy data between cells, and paste data into cells. If
you are using Windows NT:

v To cut data from a cell, highlight the data to be cut and press Ctrl-x .

v To copy data to a cell, highlight the data to be copied press Ctrl-c .

v To paste data into a cell, place the cursor into the cell where the data is to be
pasted and press Ctrl-v . You must first cut or copy data before you can paste it.
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You can also use expressions in this column, or you can specify multiple values by
separating each value with a comma (,).

Setting the User ID
When you start Deployment Manager, the Set User panel is displayed in the Task
panel.

NwDM uses the user ID to track who is performing a task. For example, the user ID
is displayed in audit records and job logs. Therefore, you should set the user ID
each time you use Deployment Manager.

To set the user ID:

1. Click in the User id field to edit the user ID. Type in the desired user ID.

2. Click Apply to change the user ID. The user ID you selected will be in effect
until you close Deployment Manager (or set a new user ID).

3. A confirmation dialog is displayed. Click OK to close the dialog.

4. The user ID you entered is displayed in the Current user id field.
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Managing Software Inventory
IBM provides updates for the operational code for network devices. These load
images can be new base releases, program temporary fixes (PTFs), or emergency
program temporary fixes (EPTFs). In addition, IBM updates the Boot and Diagnostic
Code (PROM images) for devices such as the 2210.

You can use Deployment Manager to maintain these different images. In fact,
Deployment Manager needs access to these images to upgrade and update device
configurations.

Two steps are required to update the software inventory in the NwDM database:

1. Edit software inventory properties to specify where the load images and PROM
images are located.

2. Launch the inventory update process to actually update the NwDM database.
Deployment Manager uses the software inventory properties to obtain the
inventory file and update the database.

The process of updating software inventory loads information about load images
and PROM images into the Deployment Manager database, but it does not actually
put the load images and PROM images into the database. Before using these
images to update configurations in network devices, you must first import them into
the database.

Updating Software Inventory Properties
Follow these steps to update the software inventory properties:

1. From the navigation tree, click Edit software inventory properties to display
the Edit Software Inventory Properties panel.

2. Click the down arrow in the Inventory file source field to choose the appropriate
download site. Click IBM-North America . Notice that the other fields are
automatically updated to reflect your choice.

3. In the Products pane, make sure the appropriate devices are selected. You can
update the properties for 2210, 2212, 2216, and 8275 Model 416 (8275-416).

4. Click Apply to save these properties.

5. A Save confirmation dialog is displayed. Click OK to close the dialog.

When you invoke Update Software Inventory, Deployment Manager uses these
properties to obtain the inventory file.
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Updating the Software Inventory
Follow these steps to update the software inventory in the NwDM database:

1. From the navigation tree, click Update software inventory to display the
Inventory Update panel.

2. Enter a valid user ID and password to access the site you specified as the
Inventory file source in the Edit Software Inventory Properties task panel. In this
case, a user ID of anonymous is valid for the IBM-North America site. Enter
your e-mail address as the password.

3. Click Apply to begin the update process.

4. The Update software inventory task starts immediately. The Progress window
displays messages reflecting the current status.

The process may take a while, especially if this is the first time you have
updated software inventory. When the task is completes successfully, the
Progress window displays:

Updates for all requested products complete

Viewing the List of Load Images
After the Update Software Inventory task completes, you can view a list of all load
images found by Deployment Manager for each device. Follow these steps to see
the list of load images available for the 2210:

1. From the navigation tree, click Load Images from the 2210 folder to display the
Load Images task panel for the device. You may need to expand the 2210
folder first.

2. Use the Filter task pane to define the criteria used to search for load images. In
this case, simply leave each of the fields in the Filter task pane blank and click
Apply Filter .

Clicking Apply Filter without refining the search criteria will return all load
images defined in the NwDM database for that product. Keep in mind that this
list can be extremely large. Therefore you typically want to refine your search
criteria.

3. The results of the search are displayed in the Filtered List task pane. In addition
to the load image name, the Filtered List task pane displays the software
version and release to which the load image applies, the PTF to which the load
image applies, and the length of the load image.

Notice that the length of all load images is 0. This means that the load image is
defined to Deployment Manager, but it is not actually loaded in the NwDM
database. You will need to import the load image (or upload it during the Learn
2210 task) before it can be used to update a network device.
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Populating the Deployment Manager Database
When you initially install NwDM, or when your network changes significantly, the
NwDM database needs to be updated to reflect the changes in your network.
Adding specific devices individually may take a significant amount of time.
Therefore, you can use the Synchronize Databases task to synchronize the NwDM
database with the Nways topology database.

Follow these steps to synchronize the Nways NetView topology database with the
NwDM database:

1. From the navigation tree, click Synchronize databases .

2. Click Start now to begin the synchronization process immediately after you click
Apply.

3. Click Apply to begin database synchronization.

4. When the Confirmation dialog is displayed, click OK to close the dialog.

During database synchronization, any new devices are automatically created, and
all SNMP read and write community names are updated. In addition,
recommendations for handling discrepancies between databases are listed in the
job log.

The Synchronize Database task may take quite a while to complete, depending on
the size of your network. While the job is processing, you can view the status of the
job.

Viewing Job Status
Most Deployment Manager tasks are performed as scheduled jobs. Jobs provide
you with the flexibility of deciding when a task is performed as well as deciding
what tasks are required to complete successfully before other tasks are performed.

When NwDM processes a job, the results of that processing are stored in a job log,
which is a file that resides on the NwDM server. The directory where NwDM stores
job logs is determined by the logDirectory property in the NwDM Properties file. For
more information about the Properties file, see “Customizing Deployment Manager”
on page 1.

As discussed, the Synchronize Databases task can take a significant amount of
time to complete. Follow these steps to view the status of the Synchronize
Database task:

1. From the navigation tree, click Jobs to display the Managing Jobs task panel.

2. In the Job Filter pane, click on the empty cell in the Job Type row to edit it.

3. The Synchronize Databases job has a job type of SYNCHDB. Therefore, type
SYNCHDB in the cell and press Enter .

4. Click Apply Filter to search the NwDM database for all jobs that have a job
type of SYNCHDB.

Note: To view all jobs currently stored in the NwDM database in the Jobs List
pane, click Apply Filter on a blank Job Filter pane.

5. The results of the search are displayed in the Jobs List pane. You may need to
click Jobs List to display the pane.

Notice the Status column for the Synchronize databases job. A status of
Running means the job is still processing. If the Synchronize Databases job
completes with no errors, the status will be Finished.
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6. Select the Synchronize Databases job by clicking on any cell in the row.

7. Click Job Details to see the details of the Synchronize Databases job. The Job
Details pane provides information about the scheduling of the job and includes
remarks about the job processing.

8. Click View Log to display the job log, which provides specific details about the
processing.

9. Click OK to close the job log.
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Learning about Device Configurations
The Learn Configuration task enables NwDM to store information about the
configuration that is currently loaded in a device. After the Synchronize Databases
task completes, you will need to perform the Learn Configuration task for all devices
(2210, 2212, 2216, and 8275-416).

Follow these steps to perform the Learn Configuration task for 2210 devices:

1. From the navigation tree, click Learn configurations from the 2210 folder (you
may need to expand the 2210 folder first). The Learn Configuration task panel is
displayed.

2. In the Options pane, click Start now to immediately schedule the job (when you
click Apply).

3. Make sure all 2210 devices are selected in the Candidates pane.

4. Click Apply to begin the Learn Configurations task for 2210 devices.

5. The Learn Configurations dialog is displayed with the number of jobs scheduled
from the Learn Configurations task. NwDM schedules a separate job for each
device selected in the Candidates pane. Click OK to close the dialog.

6. You can view the status of each of the jobs from the Managing Jobs task panel.
To view the status, follow the steps described in “Viewing Job Status” on
page 15 (search for jobs with a job type of LEARN2210 instead of a job type of
SYNCHDB).
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Working with 2210 Devices
Typical tasks that you can perform with 2210 devices include:

v Adding a 2210 record to the Deployment Manager database (see “Adding a 2210
Device Record to the Deployment Manager Database”).

v Auditing a 2210 configuration (see “Auditing a 2210 Configuration” on page 20).

v Upgrading a 2210 configuration (see “Upgrading a 2210 Configuration” on
page 22).

v Updating a 2210 configuration (see “Updating a 2210 Configuration” on page 24).

v Updating the PROM code in a 2210 (see “Updating the PROM Code in a 2210”
on page 25).

Adding a 2210 Device Record to the Deployment Manager Database
The Synchronize Databases task creates device records in the NwDM database for
all 2210 devices in the network. The disadvantage of using the Synchronize
Database task is that it can take quite a while to complete processing. Therefore,
use the 2210 Create Device task to add a single 2210 device record to the NwDM
database.

Follow these steps to add a single 2210 device record to the database:

1. From the navigation tree, click Create Device from the 2210 folder to display
the Create 2210 Device task panel.

2. Fill in these fields on the Create Device task panel (click the empty box next to
the field to enter information for the field):

Device Name
Enter a name by which you want this device to be known within NwDM.

Note: NwDM does not check to make sure that the device name is
unique, which means that you can have multiple devices with the
same device name. Using your own naming convention can
make it easy to filter devices when you search the NwDM
database.

IP Address
Enter a valid IP address or host name for this device.

Operator ID
Enter the operator ID defined for the 2210, if it exists.

Password
Enter the password associated with the operator ID.

SNMP Read Community Name
Enter the SNMP read community name to which the 2210 belongs. The
default is public.

SNMP Write Community Name
Enter the SNMP write community name to which the 2210 belongs.

TFTP server IP address
Enter the IP address for the TFTP server with which the 2210 can
communicate.

3. Click Apply to create the device in the NwDM database.
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Updating the NwDM Database with the Device Configuration
After adding the 2210 device record to the NwDM database, you need to update
the database with the configuration information for the device.

Follow these steps to perform the Learn Configuration task for this 2210, which
adds a configuration record (with a status of Active) to the NwDM database:

1. From the navigation tree, click Learn configurations from the 2210 folder. The
Learn Configuration task panel is displayed.

2. In the Options pane:

a. Click Start now to immediately schedule the job (when you click Apply)

b. Click Upload load image if needed to add the load image to the database.
Uploading the load image to the database makes it available for use in other
2210 devices. You must upload the image into the Deployment Manager
database before you can use it to update network device load images.

3. In the Candidates pane:

a. Click Reset All to deselect all 2210 devices. You only want to learn the
configuration for the device you just added.

b. Click the Learn checkbox for the device that you just created.

4. Click Apply to begin the Learn Configuration task for the 2210 devices.

5. The Learn Configurations dialog is displayed. Click OK to close the dialog.

6. You can view the status of each of the jobs from the Jobs from the Managing
Jobs task panel. To view the status, follow the steps described in “Viewing Job
Status” on page 15 (instead of searching on job type, search for the Device ID
of the device you created).
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Auditing a 2210 Configuration
When you add a 2210 device to the Deployment Manager database and perform a
Learn Configuration for that task (see “Learning about Device Configurations” on
page 17), information about that configuration is added to the database. However,
configurations can change over time. Auditing a 2210 configuration ensures that the
configuration stored in the NwDM database as the Active configuration for the
device matches the configuration that is actually loaded in the device.

Note: Audits can only be performed on configurations that have a version status of
Active.

Deployment Manager compares these properties to audit a 2210:

v Model

v Amount of memory

v TFTP server

v Load image

v PROM image level

Follow these steps to audit a 2210 configuration:

1. From the navigation tree, click Configurations from the 2210 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2210 devices currently
stored in the NwDM database.

Remember that you can also use the Filter pane to refine your search. For
example, you could choose 3 for Image Version field, 2 for Image Release field,
and prom_2.37 for the PROM field to display only those devices that meet that
criteria.

3. In the Filtered List pane, click the row of each device to be audited to select the
device. To select multiple rows, press and hold Ctrl while clicking the rows.

4. Click Process selected... to display the pop-up menu for the Filtered List pane.

5. Click Audit selected... to display the Audit 2210 Configuration task panel.

6. Click Start now and then click Submit to begin the audit process.

7. Click OK to close the Job Scheduled dialog.

Viewing Audit Records
While the Audit 2210 job is processing, you can view the status of the job from the
Managing Jobs task pane. To view the job status, follow the steps described in
“Viewing Job Status” on page 15 (search for jobs with a job type of AUDIT2210
instead of SYNCHDB).

After the Audit 2210 job is complete, you can view the audit record, which provides
details about whether the audit succeeded or failed. Follow these steps to view an
audit record.

1. From the navigation tree, click Audit Records to display the Audit Records task
panel.

2. Click Apply Filter from the Filter pane to display all audit records. Remember,
you can choose to refine your search based on the Filter pane.

3. In the Filtered List pane, click the audit record that you want to view. The Result
field displays whether the audit was successful or failed.

4. Click Process selected... to display the Pop-up menu.
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5. Click View Details for selected... to view details about the audit. If the audit
failed, the audit details describe where the failure occurred.

6. Click OK to close the dialog.
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Upgrading a 2210 Configuration
From time to time, the configuration in a 2210 device needs to be upgraded to a
new version. For example, assume that a 2210 device in your network is currently
running Multiprotocol Routing Services Version 3.2 and a PROM Version 2.37. You
want to create a new configuration for this device, upgrading the operational code
to MRS Version 3.3 and the PROM to version 2.40.

Note: Upgrading a 2210 configuration creates a new configuration version only in
the Deployment Manager database. This way you can ensure the
configuration is correct before you actually load it in a 2210 device. To load a
configuration into a 2210 device, you must update a 2210 configuration. For
more information about loading a configuration into a 2210 device, see
“Updating a 2210 Configuration” on page 24.

Deployment Manager can maintain multiple configurations for a device. Each of
these configurations has a different status. The configuration that matches the one
actually loaded in the 2210 device has a status of Active. The NwDM database can
only have one Active configuration for a 2210. Other configurations will typically
have a status of:

v Inactive . Inactive versions are complete and can be loaded in the 2210 device.

v Incomplete . Incomplete versions are missing some data. They cannot be loaded
in the 2210 device.

In addition, Deployment Manager uses a status of nascent for configurations that
are in the process of becoming the Active configuration and obsolescent for
configurations that are in the process of becoming inactive.

Follow these steps to upgrade a configuration:

1. From the navigation tree, click Configurations from the 2210 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2210 devices currently
stored in the NwDM database.

3. In the Filtered List pane, click the row for each device for which you want to
upgrade the configuration.

4. Click Process Selected... to display the pop-up menu for the Filtered List
pane.

5. Click Upgrade selected... to display the Upgrade 2210 Configuration Dialog.

6. From the Upgrade 2210 Configurations dialog, click Start Now .

7. If the configuration that you chose to upgrade is the Active configuration for the
device, you must click Create New Version . The upgraded configuration will
have a status of Inactive.

8. Click Use Selected Load Image to choose the load image used for this
upgraded configuration.

9. Click Select Image... to choose the appropriate load image from a list of
available load images.

10. From the Filter pane of the Select 2210 Load Image dialog, enter a 3 for the
Version property and a 3 for the Release property.

To enter data on the Filter pane, click the blank cell in the row for the
appropriate property, type information in the cell, and press Enter or click
another cell.

11. Click Apply Filter to display the load images.
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12. In the Filtered List pane, click the row for the Version 3 Release 3 load image
(MRS.F00) to select it.

To use this Load Image, it must be uploaded into the NwDM database. You
can add a Load Image to a database using either the Create Device task (see
“Adding a 2210 Device Record to the Deployment Manager Database” on
page 18) or from the Load Images task panel.

13. Click Apply to use that load image in the upgrade process.

14. From the Upgrade 2210 Configuration Dialog, click Upgrade PROM .

15. For the PROM name, type prom_2.40 .

To use this PROM level, it must be loaded in the NwDM database. For more
information about loading the PROM image into the database, see “Uploading
a PROM Image into the NwDM Database” on page 25.

16. Click Submit to start the Upgrade 2210 task. For more information about view
the status of a job, see “Viewing Job Status” on page 15. The job type for an
upgrade 2210 tasks is UPGCFG2210.

Viewing the Upgraded Configuration
When the Upgrade 2210 Configuration task is complete, the device will have
multiple configurations listed in the NwDM database. Follow these steps to view all
of the configurations for a device:

1. From the navigation tree, click Configurations from the 2210 folder to display
the Configurations task panel.

2. From the Filter pane, enter either the device ID or the device name of the 2210
for which you just upgraded the configuration.

3. Click Apply Filter to display all configuration for that 2210 in the Filtered List
pane.

4. Notice that two configurations are displayed. Remember, however, that only one
configuration is the Active configuration (the configuration actually loaded in the
2210). The upgraded configuration is listed as the Inactive configuration. To
make it the Active configuration, perform the Update 2210 Configuration task.
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Updating a 2210 Configuration
Updating a 2210 configuration actually loads the configuration into a 2210 device. In
addition, the Load Image and PROM Images are updated, if necessary. When you
update a 2210 configuration, the configuration you choose must have a
configuration status of Inactive.

Follow these steps to update a 2210 configuration:

1. From the navigation tree, click Configurations from the 2210 folder to display
the Process Configs task panel.

2. In the Filter task pane, click Apply Filter to display all 2210 configurations in
the Filter List pane.

3. In the Filtered task pane, click the 2210 configuration to be updated. Remember
that to update the 2210, the configuration you select must have a status of
Inactive.

4. Click Process Selected... display the configurations pop-up menu and click
Update selected... to display the Update 2210 Dialog.

5. Click Start now to begin the update job immediately when you click Submit.

6. Click the down arrow for the Reload option and click Reload Immediately to
restart the 2210 device immediately after the new configuration has been
loaded.

Note: The 2210 must be restarted for the new configuration to take effect.
Therefore, you will typically select Timed Load for this field, and enter an
off-peak time in the Timed Load field to minimize any disruptions that
may be caused by the 2210 restarting.

Be careful when entering the time for the 2210 to restart. The time you
enter is based on the time zone of the server where the NwDM database
is located (which may not be the same time zone where the 2210 or you
are located).

If you choose No Reload, you must restart the 2210 manually.

7. Click the down arrow for the Bank Option and click Erase inactive if needed .
Deployment Manager will erase files (except for the Active load image) stored in
the 2210 IBD only if space is needed to store the new configuration.

8. Click Submit to begin the Update 2210 Configuration task. To view the status of
the job use the Managing Jobs task panel. For information about the Managing
Jobs task panel, see “Viewing Job Status” on page 15 (an Update 2210
Configuration job has a job status of UPDATE2210).
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Updating the PROM Code in a 2210
You can use Deployment Manager to update just the PROM code (boot and
diagnostic code) that is currently loaded in a 2210 to a new version and release
level. Before updating to a more recent PROM level, however, the PROM image for
that level must be stored in the NwDM database.

Uploading a PROM Image into the NwDM Database
Follow these steps to load a PROM image into the NwDM database:

1. From the navigation tree, click PROM Images from the 2210 folder to display
the PROM Images task panel.

2. In the Filter pane, click Apply Filter to display all PROM Images available to
Deployment Manager in the Filtered List pane. Information about these images
was added to the NwDM database when software inventory was updated. See
“Updating the Software Inventory” on page 14 for information on updating
software inventory.

Notice that the length of the PROM images is 0. This means that a copy of the
PROM image does not currently exist in the NwDM database. Before you can
update a 2210 device with a new PROM image, the new image must have
been previously imported into the database.

3. Assume the PROM image you want to upload is version 2.40. Click
prom_2.40 in the Filtered List pane to select it.

4. Click Process Selected... to display the Filtered List pop-up menu.

5. Click Import Selected PROM Image files... to import the PROM image into
the NwDM database. The Import 2210 PROM Images dialog, consisting of
several tabs, is displayed. For more information about the importing PROM
images, see “2210 PROM Images” on page 95.

6. Use the Method tab to specify how the PROM image is accessed. Click Use
specified download URL and then click Next .

7. Use the Download URL tab to specify the URL where the PROM image is
located. Click IBM-North America and then click Next .

8. Use the FTP tab to specify how to access the URL. Because you selected
IBM-North America in the Download URL tab, defaults for FTP host and user
ID are displayed. If you require the use of a socks server, click Use socks
server and fill in the server host name and port. Enter your e-mail address for
the password and then click Next .

9. Use the Results tab to start the import process and view the status. Click
Import . The Messages box displays information about the import process.

10. When the import process is complete, click Apply Filter from the Filter pane to
refresh the list of PROM images. Notice that the PROM image you just
imported now has a length other than 0.

Loading the PROM Image into the 2210
After uploading the PROM image into the NwDM database, you can update a 2210
device to use that PROM image. Follow these steps to update the PROM image in
a 2210:

1. From the navigation tree, click Configurations from the 2210 folder to display
the Process Configs task panel.

2. Assume that the 2210 device for which you want to update the PROM level is
currently using PROM level 2.37 and you want to update the PROM level to
2.40. Scroll down the Filter list until you see the PROM Level property.
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3. Click in the empty cell to edit it and type prom_2.37 .

4. Click Apply Filter to display in the Filtered List all devices that have a PROM
level of 2.37.

5. Click a 2210 device in the Filtered List to select the device. You could also
choose to update the PROM level for more than one device displayed in the
Filtered List. To select multiple devices, press the Ctrl key while clicking the
devices. Clicking Select All will select all of the devices in the Filtered List.

Note: PROM Level updates can only be performed on 2210 devices that have
an Active configuration (Active is displayed in the Version Status field).

6. Click Process Selected to display the pop-up menu and click Update PROM
Level on selected... to display the Update 2210 PROM Levels dialog.

7. Click PROM Level to specify the PROM level.

8. Click Select PROM... to display the Select 2210 PROM Image dialog.

9. From the Select 2210 PROM Image dialog, click the empty cell for Name and
enter prom_2.40 .

10. Click Apply Filter to display the PROM in the Filtered List.

11. From the Filtered List, click the PROM to select it and then click Apply .

12. From the Update 2210 PROM Level dialog, click Start now , which will start
the Update 2210 PROM Level task when you click Submit.

Note: Typically, you will want to click Schedule job and choose a start time
for the job that is during a slow period (such as early in the morning).
Updating the PROM level will force the 2210 device to automatically be
restarted.

13. Click the Erase IBD pull down. The Erase IBD controls the disposition of
PROM Images that are currently stored in the IBD.

14. Click Erase Inactive if needed to erase Inactive PROM images from the IBD
only if there is not enough space in the IBD to store this PROM image.

15. Click Submit to begin the Update PROM Image task.

26 NwDM User’s Guide



Working with 2212 Devices
Typical tasks that you can perform with 2212 devices include:

v Adding a 2212 record to the Deployment Manager database (see “Adding a 2212
Device Record to the Deployment Manager Database” on page 28).

v Auditing a 2212 configuration (see “Auditing a 2212 Configuration” on page 29).

v Upgrading a 2212 configuration (see “Upgrading a 2212 Configuration” on
page 30).

v Updating a 2212 configuration (see “Updating a 2212 Configuration” on page 31).
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Adding a 2212 Device Record to the Deployment Manager Database
The Synchronize Databases task creates device records in the NwDM database for
all 2212 devices in the network. The disadvantage of using the Synchronize
Databases task is that it can take quite a while to complete processing. Therefore,
use the 2212 Create Device task to add a single 2212 device record to the NwDM
database.

Follow these steps to add a single 2212 device record to the database:

1. From the navigation tree, click Create Device from the 2212 folder to display
the Create Device task panel.

2. Fill in these fields on the Create Device task panel (click the empty box next to
the field to enter information for the field):

Device Name
Enter a name by which you want this device to be known within NwDM.

Note: NwDM does not check to make sure that the device name is
unique, which means that you can have multiple devices with the
same device name. Using your own naming convention can
make it easy to filter devices when you search the database.

IP Address
Enter a valid IP address or host name for this device.

Operator ID
Enter the operator ID defined for the 2212, if it exists.

Password
Enter the password associated with the operator ID.

SNMP Read Community Name
Enter the SNMP write community name to which the 2212 belongs. The
default is public.

SNMP Write Community Name
Enter the SNMP read community name to which the 2212 belongs.

TFTP server IP address
Enter the IP address for the TFTP server with which the 2212 can
communicate.

3. Click Apply to create the device in the NwDM database.

Updating NwDM with the Device Configuration
After adding the 2212 to the NwDM database, you need to update the database
with the configuration information for the device.

Follow these steps to perform the Learn Configuration task for this 2212:

1. From the navigation tree, click Learn configurations from the 2212 folder. The
Learn Configuration task panel is displayed.

2. In the Options pane:

a. Click Start now to immediately schedule the job (when you click Apply)

b. Click Upload load image if needed to add the load image to the database.
Uploading the load image to the database makes it available for use in other
2212 devices. You must upload the load image into the Deployment
Manager database before you can use it to update 2212 device load
images.

3. In the Candidates pane:
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a. Click Reset All to deselect all 2212 devices. You only want to learn the
configuration for the device you just added.

b. Click the Learn checkbox for the device that you just created.

4. Click Apply to begin the Learn Configuration task for the 2212 devices.

5. The Learn Configurations dialog is displayed. Click OK to close the dialog.

6. You can view the status of each of the jobs from the Jobs from the Managing
Jobs task panel. To view the status, follow the steps described in “Viewing Job
Status” on page 15 (instead of searching on job type, search for the Device ID
of the device you created).

Auditing a 2212 Configuration
When you add a 2212 device to the Deployment Manager database and perform a
Learn Configuration for that task, information about that configuration is added to
the database. However, configurations can change over time. Auditing a 2212
configuration ensures that the configuration stored in the NwDM database as the
Active configuration for the device matches the configuration that is actually loaded
in the device.

Note: Audits can only be performed on configurations that have a version status of
Active.

Deployment Manager compares these properties to audit a 2212:

v Model

v Amount of memory

v TFTP server

v Load image

Follow these steps to audit a 2212 configuration:

1. From the navigation tree, click Configurations from the 2212 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2212 devices currently
stored in the NwDM database.

Remember that you can also use the Filter pane to refine your search.

3. In the Filtered List pane, click the row of each device to be audited to select the
device. To select multiple rows, press and hold Ctrl while clicking the rows.

4. Click Process selected... to display the pop-up menu for the Filtered List pane.

5. Click Audit selected... to display the Audit 2212 Configuration task panel.

6. Click Start now and then click Submit to begin the audit process.

7. Click OK to close the Job Scheduled dialog.

Viewing Audit Records
While the Audit 2212 job is processing, you can view the status of the job from the
Managing Jobs task pane. To view the job status, follow the steps described in
“Viewing Job Status” on page 15 (search for jobs with a job type of AUDIT2212
instead of SYNCHDB).

After the Audit 2212 job is complete, you can view the audit record, which provides
details about whether the audit succeeded or failed. Follow these steps to view an
audit record.

1. From the navigation tree, click Audit Records to display the Audit Records task
panel.

Chapter 2. Using Deployment Manager 29



2. Click Apply Filter from the Filter pane to display all audit records. Remember,
you can choose to refine your search based on the Filter pane.

3. In the Filtered List pane, click the audit record that you want to view. The Result
field displays whether the audit was successful or failed.

4. Click Process selected... to display the Pop-up menu.

5. Click View Details for selected... to view details about the audit. If the audit
failed, the audit details describe where the failure occurred.

6. Click OK to close the dialog.

Upgrading a 2212 Configuration
From time to time, the configuration in a 2212 device needs to be upgraded to a
new version. For example, assume that a 2212 device in your network is currently
running Access Integration Services (AIS) Version 3.2 and you want to create a new
configuration for this device, upgrading the operational code to AIS Version 3.3.

Note: Upgrading a 2212 configuration creates a new configuration version only in
the Deployment Manager database. This way you can ensure the
configuration is correct before you actually load it in a 2212 device. To load a
configuration into a 2212 device, you must update a 2212 configuration. For
more information about loading a configuration into a 2212 device, see
“Updating a 2212 Configuration” on page 31.

Deployment Manager can maintain multiple configurations for a device. Each of
these configurations has a different status. The configuration that matches the one
actually loaded in the 2212 device has a status of Active. The NwDM database can
only have one Active configuration for a 2212. Other configurations will typically
have a status of:

v Inactive . Inactive versions are complete and can be loaded in the 2212 device.

v Incomplete . Incomplete versions are missing some data. They cannot be loaded
in the 2212 device.

In addition, Deployment Manager uses a status of nascent for configurations that
are in the process of becoming the Active configuration and obsolescent for
configurations that are in the process of becoming inactive.

Follow these steps to upgrade a configuration:

1. From the navigation tree, click Configurations from the 2212 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2212 devices currently
stored in the NwDM database.

3. In the Filtered List pane, click the row for each device for which you want to
upgrade the configuration.

4. Click Process Selected... to display the pop-up menu for the Filtered List
pane.

5. Click Upgrade selected... to display the Upgrade 2212 Configuration Dialog.

6. From the Upgrade 2212 Configurations dialog, click Start Now .

7. If the configuration that you chose to upgrade is the Active configuration for the
device, you must click Create New Version . The upgraded configuration will
have a status of Inactive.

8. Click Use Selected Load Image to choose the load image used for this
upgraded configuration.
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9. Click Select Image... to choose the load image from a list of available load
images.

10. From the Filter pane of the Select 2210 Load Image Dialog, enter a 3 for the
Version and a 2 for the Release.

To enter data on the Filter pane, click the blank cell in the row for the
appropriate property, type information in the cell, and press Enter or click
another cell.

11. Click Apply Filter to display the load images.

12. In the Filtered List pane, click the row for the Version 3 Release 3 load image
(AIS_EH1.zip) to select it.

To use this Load Image, it must be uploaded into the NwDM database. You
can add a Load Image to a database using either the Create Device task (see
“Adding a 2212 Device Record to the Deployment Manager Database” on
page 28) or from the Load Images task panel.

13. Click Apply to use that load image in the upgrade process.

14. Click Submit to start the Upgrade 2212 task. For more information about view
the status of a job, see “Viewing Job Status” on page 15. The job type for an
upgrade 2212 tasks is UPGCFG2212.

Viewing the Upgraded Configuration
When the Upgrade 2212 Configurations task is complete, the device will have
multiple configurations listed in the NwDM database. Follow these steps to view all
of the configurations for a device:

1. From the navigation tree, click Configurations in the 2212 folder to display the
Configurations task panel.

2. From the Filter pane, enter either the device ID or the device name of the 2212
for which you just upgraded the configuration.

3. Click Apply Filter to display all configuration for that 2212 in the Filtered List
pane.

4. Notice that two configurations are displayed. Remember, however, that only one
configuration is the Active configuration (the configuration actually loaded in the
2212). The upgraded configuration is listed as the Inactive configuration. To
make it the Active configuration, perform the Update 2212 Configuration task.

Updating a 2212 Configuration
Updating a 2212 configuration actually loads the configuration into a 2212 device. In
addition, the Load Image is updated, if necessary. When you update a 2212
configuration, the configuration you choose must have a configuration status of
Inactive.

Follow these steps to update a 2212 configuration:

1. From the navigation tree, click Configurations from the 2212 folder to display
the Process Configs task panel.

2. In the Filter task pane, click Apply Filter to display all 2212 configurations in
the Filter List pane.

3. In the Filtered task pane, click the 2212 configuration to be updated. Remember
that to update the 2212, the configuration you select must have a status of
Inactive.

4. Click Process Selected... display the configurations pop-up menu and click
Update selected... to display the Update 2212 Dialog.

5. Click Start now to begin the update job immediately when you click Submit.
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6. Click the down arrow for the Reload option and click Reload Immediately to
restart the 2210 device immediately after the new configuration has been
loaded.

Note: The 2212 must be restarted for the new configuration to take effect.
Therefore, you will typically select Timed Load for this field, and enter an
off-peak time in the Timed Load field to minimize any disruptions that
may be caused by the 2212 restarting.

Be careful when entering the time for the 2212 to restart. The time you
enter is based on the time zone of the server where the NwDM database
is located (which may not be the same time zone where the 2212 or you
are located).

If you choose No Reload, you must restart the 2212 manually.

7. Click the down arrow for the Bank Option and click Erase inactive if needed .
Deployment Manager will erase files (except for the Active load image) stored in
the 2210 IBD only if space is needed to store the new configuration.

8. Click Submit to begin the Update 2212 Configuration task. To view the status of
the job use the Managing Jobs task panel. For information about the Managing
Jobs task panel, see “Viewing Job Status” on page 15 (an Update 2212
Configuration job has a job status of UPDATE2212).
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Working with 2216 Devices
Typical tasks that you can perform with 2216 devices include:

v Adding a 2216 record to the Deployment Manager database (see “Adding a 2216
Device Record to the Deployment Manager Database” on page 34).

v Auditing a 2216 configuration (see “Auditing a 2216 Configuration” on page 35).

v Upgrading a 2216 configuration (see “Upgrading a 2216 Configuration” on
page 36).

v Updating a 2216 configuration (see “Updating a 2216 Configuration” on page 37).
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Adding a 2216 Device Record to the Deployment Manager Database
The Synchronize Databases task creates device records in the NwDM database for
all 2216 devices in the network. The disadvantage of using the Synchronize
Databases task is that it can take quite a while to complete processing. Therefore,
use the 2216 Create Device task to add a single 2216 device record to the NwDM
database.

Follow these steps to add a single 2216 device record to the database:

1. From the navigation tree, click Create Device from the 2216 folder to display
the Create Device task panel.

2. Fill in these fields on the Create Device task panel (click in the empty box next
to the field to enter information for that field):

Device Name
Enter a name by which you want this device to be known within NwDM.

Note: NwDM does not check to make sure that the device name is
unique, which means that you can have multiple devices with the
same device name. Using your own naming conventions makes
it easy to filter devices when you search the NwDM database.

IP Address
Enter a valid IP address or host name for this device.

Operator ID
Enter the operator ID defined for the 2216, if it exists.

Password
Enter the password associated with the operator ID.

SNMP Read Community Name
Enter the SNMP write community name to which the 2216 belongs. The
default is public.

SNMP Write Community Name
Enter the SNMP read community name to which the 2216 belongs.

TFTP server IP address
Enter the IP address for the TFTP server with which the 2216 can
communicate.

3. Click Apply to create the device in the NwDM database.

Updating NwDM with the Device Configuration
After adding the 2216 to the NwDM database, you need to update the database
with the configuration information for the device.

Follow these steps to perform the Learn Configuration task for this 2216:

1. From the navigation tree, click Learn configurations from the 2216 folder. The
Learn Configuration task panel is displayed.

2. In the Options pane:

a. Click Start now to immediately schedule the job (when you click Apply)

b. Click Upload load image if needed to add the load image to the database.
Uploading the load image to the database makes it available for use in other
2216 devices. You must upload the load image into the database before
using it to update a 2216 device load images.

3. In the Candidates pane:
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a. Click Reset All to deselect all 2216 devices. You only want to learn the
configuration for the device you just added.

b. Click the Learn checkbox for the device that you just created.

4. Click Apply to begin the Learn Configuration task for the 2216 devices.

5. The Learn Configurations dialog is displayed. Click OK to close the dialog.

6. You can view the status of each of the jobs from the Jobs from the Managing
Jobs task pane. To view the status, follow the steps described in “Viewing Job
Status” on page 15 (instead of searching on job type, search for the Device ID
of the device you created).

Auditing a 2216 Configuration
When you add a 2216 device to the Deployment Manager database and perform a
Learn Configuration for that task, information about that configuration is added to
the database. However, configurations can change over time. Auditing a 2216
configuration ensures that the configuration stored in the NwDM database as the
Active configuration for the device matches the configuration that is actually loaded
in the device.

Note: Audits can only be performed on configurations that have a version status of
Active.

Deployment Manager compares these properties to audit a 2216:

v Model

v Amount of memory

v TFTP server

v Load image

Follow these steps to audit a 2216 configuration:

1. From the navigation tree, click Configurations from the 2216 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2216 devices currently
stored in the NwDM database.

Remember that you can also use the Filter pane to refine your search.

3. In the Filtered List pane, click the row of each device to be audited to select the
device. To select multiple rows, press and hold Ctrl while clicking the rows.

4. Click Process selected... to display the pop-up menu for the Filtered List pane.

5. Click Audit selected... to display the Audit 2216 Configuration task panel.

6. Click Start now and then click Submit to begin the audit process.

7. Click OK to close the Job Scheduled dialog.

Viewing Audit Records
While the Audit 2216 job is processing, you can view the status of the job from the
Managing Jobs task pane. To view the job status, follow the steps described in
“Viewing Job Status” on page 15 (search for jobs with a job type of AUDIT2216
instead of SYNCHDB).

After the Audit 2216 job is complete, you can view the audit record, which provides
details about whether the audit succeeded or failed. Follow these steps to view an
audit record.

1. From the navigation tree, click Audit Records to display the Audit Records task
panel.
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2. Click Apply Filter from the Filter pane to display all audit records. Remember,
you can choose to refine your search based on the Filter pane.

3. In the Filtered List pane, click the audit record that you want to view. The Result
field displays whether the audit was successful or failed.

4. Click Process selected... to display the Pop-up menu.

5. Click View Details for selected... to view details about the audit. If the audit
failed, the audit details describe where the failure occurred.

6. Click OK to close the dialog.

Upgrading a 2216 Configuration
From time to time, the configuration in a 2216 device needs to be upgraded to a
new version. For example, assume that a 2216 device in your network is currently
running Multiprotocol Access Services (MAS) Version 3.2 and you want to create a
new configuration for this device, upgrading the operational code to MAS Version
3.3.

Note: Upgrading a 2216 configuration creates a new configuration version only in
the Deployment Manager database. This way you can ensure the
configuration is correct before you actually load it in a 2216 device. To load a
configuration into a 2216 device, you must update a 2216 configuration. For
more information about loading a configuration into a 2216 device, see
“Update 2216 Configuration” on page 167.

Deployment Manager can maintain multiple configurations for a device. Each of
these configurations has a different status. The configuration that matches the one
actually loaded in the 2216 device has a status of Active. The NwDM database can
only have one Active configuration for a 2216. Other configurations will typically
have a status of:

v Inactive . Inactive versions are complete and can be loaded in the 2216 device.

v Incomplete . Incomplete versions are missing some data. They cannot be loaded
in the 2216 device.

In addition, Deployment Manager uses a status of nascent for configurations that
are in the process of becoming the Active configuration and obsolescent for
configurations that are in the process of becoming inactive.

Follow these steps to upgrade a configuration:

1. From the navigation tree, click Configurations from the 2216 folder to display
the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 2216 devices currently
stored in the NwDM database.

3. In the Filtered List pane, click the row for each device for which you want to
upgrade the configuration.

4. Click Process Selected... to display the pop-up menu for the Filtered List
pane.

5. Click Upgrade selected... to display the Upgrade 2216 Configuration Dialog.

6. From the Upgrade 2216 Configuration Dialog, click Start Now .

7. If the configuration that you chose to upgrade is the Active configuration for the
device, you must click Create New Version . The upgraded configuration will
have a status of Inactive.

8. Click Use Selected Load Image to choose the load image used for this
configuration.
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9. Click Select Image... to choose a load image from a list of load images.

10. From the Filter pane of the Select 2216 Load Image Dialog, enter a 3 for the
Version and a 3 for the Release.

Remember, to enter data on the Filter pane, click the blank cell in the row for
the appropriate field. Then type information in the cell and press Enter or click
another cell.

11. Click Apply Filter to display the load image.

12. In the Filtered List pane, click the row for the Version 3 Release 3 load image
(MAS_CF1.zip) to select it.

To use this Load Image, it must be loaded in the NwDM database. You can
add a Load Image to a database using either the Create Device task (see
“Adding a 2216 Device Record to the Deployment Manager Database” on
page 34) or from the Load Images task panel.

13. Click Apply to use that load image in the upgrade process.

14. Click Submit to start the Upgrade 2216 task. For more information about view
the status of a job, see “Viewing Job Status” on page 15. The job type for an
upgrade 2216 tasks is UPGCFG2216.

Viewing the Upgraded Configuration
When the Upgrade 2216 Configuration task is complete, the device will have
multiple configurations listed in the NwDM database. Follow these steps to view all
of the configurations for a device.

1. From the navigation tree, click Configurations from the 2216 folder to display
the Configurations task panel.

2. From the Filter pane, enter either the device ID or the device name of the 2216
for which you just upgraded the configuration.

3. Click Apply Filter to display all configuration for that 2216 in the Filtered List
pane.

4. Notice that two configurations are displayed. Remember, however, that only one
configuration is the Active configuration (the configuration actually loaded in the
2216). The upgraded configuration is listed as the Inactive configuration. To
make it the Active configuration, perform the Update 2216 Configuration task.

Updating a 2216 Configuration
Updating a 2216 configuration actually loads the configuration into a 2216 device. In
addition, the Load Image is updated, if necessary. When you update a 2216
configuration, the configuration you choose must have a configuration status of
Inactive.

Follow these steps to update a 2216 configuration:

1. From the navigation tree, click Configurations from the 2216 folder to display
the Process Configs task panel.

2. In the Filter task pane, click Apply Filter to display all 2216 configurations in
the Filter List pane.

3. In the Filtered task pane, click the 2216 configuration to be updated. Remember
that to update the 2216, the configuration you select must have a status of
Inactive.

4. Click Process Selected... display the configurations pop-up menu and click
Update selected... to display the Update 2216 Dialog.

5. Click Start now to begin the update job immediately when you click Submit.
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6. Click the down arrow for the Reload option and click Reload Immediately to
restart the 2216 device immediately after the new configuration has been
loaded.

Note: The 2216 must be restarted for the new configuration to take effect.
Therefore, you will typically select Timed Load for this field, and enter an
off-peak time in the Timed Load field to minimize any disruptions that
may be caused by the 2216 restarting.

Be careful when entering the time for the 2216 to restart. The time you
enter is based on the time zone of the server where the NwDM database
is located (which may not be the same time zone where the 2216 or you
are located).

If you choose No Reload, you must restart the 2216 manually.

7. Click the down arrow for the Bank Option and click Erase inactive if needed .
Deployment Manager will erase files (except for the Active load image) stored in
the 2216 only if space is needed to store the new configuration.

8. Click Submit to begin the Update 2216 Configuration task. To view the status of
the job use the Managing Jobs task panel. For information about the Managing
Jobs task panel, see “Viewing Job Status” on page 15 (an Update 2216
Configuration job has a job status of UPDATE2216).
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Working with 8275 Model 416 Devices
Typical tasks that you can perform with 8275 Model 416 devices include:

v Adding an 8275-416 record to the Deployment Manager database (see “Adding
an 8275 Model 416 Device Record to the Deployment Manager Database” on
page 40).

v Auditing an 8275-416 configuration (see “Auditing an 8275-416 Configuration” on
page 41).

v Updating an 8275-416 configuration (see “Updating an 8275-416 Configuration”
on page 42).
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Adding an 8275 Model 416 Device Record to the Deployment Manager
Database

The Synchronize Databases task creates device records in the NwDM database for
all 8275-416 devices in the network. The disadvantage of using the Synchronize
Databases task is that it can take quite a while to complete processing. Therefore,
use the 8275-416 Create Device task to add a single 8275-416 device record to the
NwDM database.

Follow these steps to add a single 8275-416 device record to the database:

1. From the navigation tree, click Create Device from the 8275-416 folder to
display the Create 8275-416 Device task panel.

2. Fill in these fields on the Create Device task panel (click the empty box next to
the field to enter information for the field):

Device Name
Enter a name by which you want this device to be known within NwDM.

Note: NwDM does not check to make sure that the device name is
unique, which means that you can have multiple devices with the
same device name. Using your own naming conventions makes
it easy to filter devices when you search the NwDM database.

IP Address
Enter a valid IP address or host name for this device.

Operator ID
Enter the operator ID defined for the 8275-416, if it exists.

Password
Enter the password associated with the operator ID.

SNMP Read Community Name
Enter the SNMP write community name to which the 8275-416 belongs.
The default is public.

SNMP Write Community Name
Enter the SNMP read community name to which the 8275-416 belongs.

TFTP server IP address
Enter the IP address for the TFTP server with which the 8275-416 can
communicate.

3. Click Apply to create the device in the NwDM database.

Updating NwDM with the Device Configuration
After adding the 8275-416 to the NwDM database, you need to update the
database with the configuration information for the device.

Follow these steps to perform the Learn Configuration task for this 8275-416:

1. From the navigation tree, click Learn configurations from the 8275-416 folder.
The Learn Configurations task panel is displayed.

2. In the Options pane:

a. Click Start now to immediately schedule the job (when you click Apply)

3. In the Candidates pane:

a. Click Reset All to deselect all 8275-416 devices. You only want to learn the
configuration for the device you just created.

b. Click the Learn checkbox for the device that you just created.
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4. Click Apply to begin the Learn Configuration task for the 8275-416 devices.

5. The Learn Configurations dialog is displayed. Click OK to close the dialog.

6. You can view the status of each of the jobs from the Jobs from the Managing
Jobs task pane. To view the status, follow the steps described in “Viewing Job
Status” on page 15 (search for jobs with a job type of LEARN8275m416).

Auditing an 8275-416 Configuration
When you add an 8275-416 device to the Deployment Manager database and
perform a Learn Configuration for that task (see 17), information about that
configuration is added to the database. However, configurations can change over
time. Auditing an 8275-416 configuration ensures that the configuration stored in the
NwDM database as the Active configuration for the device matches the
configuration that is actually loaded in the device.

Note: Audits can only be performed on configurations that have a version status of
Active.

Deployment Manager compares these properties to audit an 8275-416:

v Model

v Amount of memory

v TFTP server

v Load image

Follow these steps to audit an 8275-416 configuration:

1. From the navigation tree, click Configurations from the 8275-416 folder to
display the Configurations task panel.

2. Click Apply Filter in the Filter pane to display all of the 8275-416 devices
currently stored in the NwDM database.

Remember that you can also use the Filter pane to refine your search.

3. In the Filtered List pane, click the row of each device to be audited to select the
device.

4. Click Process selected... to display the pop-up menu for the Filtered List pane.

5. Click Audit selected... to display the Audit 8275-416 Configuration task panel.

6. Click Start now and then click Submit to begin the audit process.

7. Click OK to close the Job Scheduled dialog.

Viewing Audit Records
While the Audit 8275-16 job is processing, you can view the status of the job from
the Managing Jobs task panel. To view the job status, follow the steps described in
“Viewing Job Status” on page 15 (search for jobs with a job type of
AUDIT8275m416 instead of SYNCHDB).

After the Audit 8275-416 job is complete, you can view the audit record, which
provides details about whether the audit succeeded or failed. Follow these steps to
view an audit record.

1. From the navigation tree, click Audit Records to display the Audit Records task
panel.

2. Click Apply Filter from the Filter pane to display all audit records. Remember,
you can choose to refine your search based on the Filter pane.

3. In the Filtered List pane, click the audit record that you want to view. The Result
field displays whether the audit was successful or failed.
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4. Click Process selected... to display the Pop-up menu.

5. Click View Details for selected... to view details about the audit. If the audit
failed, the audit details describe where the failure occurred.

6. Click OK to close the dialog.

Updating an 8275-416 Configuration
Updating an 8275-416 configuration actually loads the configuration into the
8275-416 device. In addition, the Load Image are updated, if necessary. When you
update an 8275-416 configuration, the configuration you choose must have a
configuration status of Inactive.

Follow these steps to update an 8275-416 configuration:

1. From the navigation tree, click Configurations to display the Process Configs
task panel.

2. In the Filter task pane, click Apply Filter to display all 8275-416 configurations
in the Filter List pane.

3. In the Filtered task pane, click the 8275-416 configuration to be updated.
Remember that to update the 8275-416, the configuration you select must have
a status of Inactive.

4. Click Process Selected... display the configurations pop-up menu and click
Update selected... to display the Update 8275-416 Dialog.

5. Click Start now to begin the update job immediately when you click Submit.

6. Click the down arrow for the Reset option and click Reload Immediately to
restart the 8275-416 device immediately after the new configuration has been
loaded.

Note: The 8275-416 must be restarted for the new configuration to take effect.

7. Click the down arrow for the Bank Option and click Erase inactive if needed .
Deployment Manager will erase files (except for the Active load image) stored in
the 8275-416 only if space is needed to store the new configuration.

8. Click Submit to begin the Update 8275-416 Configuration task. To view the
status of the job use the Managing Jobs task panel. For information about the
Managing Jobs task panel, see “Viewing Job Status” on page 15 (an Update
8275-416 Configuration job has a job status of UPDATE8275m416).
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Chapter 3. Understanding Deployment Manager Task Panels
and Dialogs

This chapter describes each of the task panels and dialogs provided with Nways
Deployment Manager. For each task panel or dialog, this chapter provides:

v Screen capture showing the task panel or dialog

v Description of the task panel or dialog

v Table listing each field, the purpose of the field, and valid values.

v Description of the available pop-up menu selections.

v Description of the available action buttons.
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Set User
Use the Set User task panel to set the user for the current Deployment Manager
session. To display the Set User task panel, click Set User from the navigation tree.

This field... Is used to... It can contain...

Current user id Display the user ID currently signed on to
this Deployment Manager session.

Blank when you initially sign
on, this field displays the
value you enter for User ID
when you click Apply.

User id Specify the user ID to be used for this
Deployment Manager session. The user
ID is displayed in audit records and job
logs.

Up to 32 text characters
representing the user ID. The
default is the logon user ID.

These action buttons are available for the Set User task panel:

Apply Sets the current user ID to the specified user ID. Exiting the Set User task
panel without clicking Apply will cause any changes you entered on this
task panel to be lost.

Clicking Apply displays a confirmation dialog. Click OK to clear the dialog.

Refresh
Clears any information entered on the Set User task panel.

Help Displays help for this task panel.
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Jobs
Many of the tasks performed with Deployment Manager are performed as jobs. The
Jobs task panel provides a way for you to manage these jobs.

To display the Jobs task panel, click Jobs from the navigation tree.

The Jobs task panel is divided into these panes:

v Job Filter

v Jobs List

v Job Details

You can display the help panel for the Jobs task panel by clicking Help .

Job Filter Pane
The Job Filter pane provides a way to search the Deployment Manager database
for jobs. The Filter pane is a table containing these columns:

v Properties. The Properties column is a list of job properties on which you can
search theNwDM database.

v Comparison Operator. The Comparison Operator column lists all of the ways to
refine the search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the Job
records found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Jobs List pane.

Job Filter Properties
You can search on these job properties:

This
property...

Is used to describe...

Job ID The identifier for a job. Jobs are numbered sequentially within the NwDM
database.
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This
property...

Is used to describe...

Job Type How the job was scheduled. Job Type can have one of these values:

v LEARN2210 - jobs scheduled as Learn 2210 tasks

v LEARN2212 - jobs scheduled as Learn 2212 tasks

v LEARN2216 - jobs scheduled as Learn 2216 tasks

v LEARN8275m416 - jobs scheduled as Learn 8275 Model 416 tasks

v AUDIT2210 - jobs scheduled as Audit 2210 tasks

v AUDIT2212 - jobs scheduled as Audit 2212 tasks

v AUDIT2216 - jobs scheduled as Audit 2216 tasks

v AUDIT8275m416 - jobs scheduled as Audit 8275 Model 416 tasks

v SYNCHDB - jobs scheduled as Synchronize Databases tasks

v UPDATE2210 - jobs scheduled as Update 2210 tasks

v UPDATE2212 - jobs scheduled as Update 2212 tasks

v UPDATE2216 - jobs scheduled as Update 2216 tasks

v UPDATE8275m416 - jobs scheduled as Update 8275 Model 416 tasks

v UPGCFG2210 - jobs scheduled as Upgrade 2210 configuration task

v UPGCFG2212 - jobs scheduled as Upgrade 2212 configuration task

v UPGCFG2216 - jobs scheduled as Upgrade 2216 configuration tasks

Earliest Start The earliest date and time that the job can be started. The date and time
are based on the time zone of the server where the NwDM database is
stored.

The Earliest Start property has the format yy/mm/dd:hh/mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)

Latest Start The Latest Start property is the latest date and time that the job can be
started. If the job is not started by this date and time, it will not start at all.

The date and time are based on the time zone of the server where the
NwDM database is stored.

The Latest Start property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)
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This
property...

Is used to describe...

Status The status of the job, which can be:

v Scheduled - the job is scheduled, but has not started

v Running - the job has started and is currently running

v Stopped - the job has stopped due to an error. The Job Log displays the
details about the error.

v Finished - the job completed successfully.

For jobs that have a status of Stopped or Finished, the Job Log contains
additional information about the Job Log.

Started At The date and time that the job actually started. The date and time are
based on the time zone of the server where the NwDM database is stored.

The Started At property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)

Finished At The date and time that the job completed (either stopped or finished). The
date and time are based on the time zone of the server where the NwDM
database is stored.

The Finished At property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)

Created At The date and time that the job was scheduled. The date and time are
based on the time zone of the server where the NwDM database is stored.

The Created At property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)

Created By The user ID that scheduled the job. The user ID is based on the ID entered
on the Set User task panel.

Predecessor The Job ID of the job that is scheduled to run before this job runs. The
predecessor job must complete successfully (have a status of finished)
before this job can start.

Results A summary of events that occurred while the job ran. The job log provides
detailed information about the job.
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Job Filter Comparison Operators
Over time the number of job records stored in the NwDM database can grow to be
quite large. Using comparison operators allow you to refine your search of the
database so that only job records that meet specific criteria are returned. For a list
of the comparison operators and information about entering data into the Job
Record filter, see “Working with Deployment Manager Filters and Tables” on
page 10.

Jobs List Pane
The results of the search from the Job Filter are displayed in the Jobs List task
pane.

The Jobs List task pane displays each job as a separate row. To select a job, click
in anywhere in the row, which highlights the row. Use one of these methods to
select multiple jobs:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the job is displayed in each of the columns. To reorder the
columns, press Ctrl and Shift keys, and then click on the header of the column you
want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Jobs List by the values in a column. Click the column header
to sort the Jobs List in ascending order by the values in that column. Click the
column header again to sort the values for that column in descending order.

Jobs List Action Buttons
Use the Jobs List action button to perform actions on one or more selected jobs.
These action buttons are displayed for the Jobs List task pane:

Clicking this button... Performs this action...

Select All Selects all jobs listed in the Jobs List task pane.

Unselect All Deselects all selected jobs listed in the Jobs List task pane.

Delete Selected... Delete job records from the NwDM database. The Confirm Job
Delete dialog is displayed. Click Yes to delete the jobs.

Delete Log of selected... Delete job logs from the NwDM database. The Confirm Job Log
Delete dialog is displayed. Click Yes to delete job logs.

Kill selected... Stop jobs that are currently processing. The Confirm Killing Jobs
dialog is displayed. Click Yes to stop processing.

Restart selected... Restart stopped jobs. The Confirm Restarting Jobs dialog is
displayed. Click Yes to restart the job.

Jobs List Pop-Up Menu
To display the Jobs List pop-up menu, select one or more rows and right click.

In addition to the actions available from the action buttons, these actions are
available from the Jobs List pop-up menu:
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Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Jobs List task pane. From the Visible Column dialog, click
the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Jobs List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

For example, these columns are hidden by default in the Jobs List task
pane:

v Latest start

v Created by

v Created at

v Predecessor

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Jobs List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Jobs List
task pane.

Print... Displays the Print dialog, which allows you to print selected job records.
From the Print dialog, verify the print information is correct and click
Print .

Print Preview... Displays a preview of how the selected job records will print. Click Close
to return to the Jobs List task pane.

Job Details Pane
The Job Details task pane displays specific properties about a selected job. The
properties displayed in the Job Details task pane for a job are determined by the
type of job. For example, the Reload Option property specifies when a device is
restarted after a new configuration has been loaded into the device. This property is
maintained only for Update Configuration job types. It has no meaning for any other
job types.

In addition to the fields listed in the Job Filter task pane, these fields are displayed
for AUDIT2210, AUDIT2212, AUDIT2216, and AUDIT8275m416 job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

Version The version number of the configuration. You can have multiple versions of
a configuration stored in NwDM for each device. Configuration versions are
numbered sequentially starting with zero (0).

In addition to the fields listed in the Job Filter task pane, these fields are displayed
for LEARN8275m416 job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

Version The version number of the configuration. You can have multiple versions of
a configuration stored in NwDM for each device. Configuration versions are
numbered sequentially starting with zero (0).
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In addition to the fields listed in the Job Filter task pane, these fields are displayed
for LEARN2210, LEARN2212, and LEARN2216 job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

Version The version number of the configuration. You can have multiple versions of
a configuration stored in NwDM for each device. Configuration versions are
numbered sequentially starting with zero (0).

Upload
Image

Used to specify whether or not the load image for the device is loaded in
the NwDM database. The Upload Image can be:

v True . The load image is loaded into the database

v False . The load image is not loaded into the database

These fields are displayed for the UPGCFG2210 job type:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

Version The version number of the configuration. You can have multiple versions of
a configuration stored in NwDM for each device. Configuration versions are
numbered sequentially starting with zero (0).

Create New
Version

Whether or not a New version should be created in the NwDM database
when the configuration version is upgraded. The Create New Version can
be:

v True . NwDM creates a new version in the database.

v False . NwDM does not create a new version.

Load Image The name of the load image associated with a configuration.

Image
Version

The software version to which the load image applies.

Image
Release

The software release to which the load image applies.

Use Latest
PROM

Whether or not the latest PROM level that is compatible with the 2210
device is to be used when the configuration is upgraded. The Use Latest
PROM property can be:

v True . Use the latest PROM level when the configuration is upgraded.

v False . Do not use the latest PROM level.

PROM Level The PROM level to be used when the configuration is upgraded.

These fields are displayed for the UPGCFG2212 and UPGCFG2216 job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

Version The version number of the configuration. You can have multiple versions of
a configuration stored in NwDM for each device. Configuration versions are
numbered sequentially starting with zero (0).
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This
property...

Is used to describe...

Create New
Version

Whether or not a New version should be created in the NwDM database
when the configuration version is upgraded. The Create New Version can
be:

v True . NwDM creates a new version in the database.

v False . NwDM does not create a new version.

Load Image The name of the load image associated with a configuration.

Image
Version

The software version to which the load image applies.

Image
Release

The software release to which the load image applies.

These fields are displayed for the UPDATE2210, UPDATE2212, and UPDATE2216
job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

From Version The version number of the configuration that is listed as the Active
configuration for the 2210, 2212, or 2216 device.

To Version The version number of the configuration to which the 2210, 2212, or 2216 is
going to be updated.

Reload
Option

When the 2210, 2212, or 2216 is restarted after the configuration has been
loaded into the device. The Reload Option can be:

v No Reload . Do not restart the device. However, the configuration will not
take effect until the device has been restarted.

v Reload Immediately . Restart the device as soon as the configuration
has been downloaded into the device.

v Timed Load . Restart the device at the date and time specified by the
Timed Load property.

Timed Load If the Reload Option property is set to Timed Load, the date and time that
the device is to be restarted. The date and time are based on the time zone
of the server where the NwDM database is stored.

The Timed Load property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)

Bank Option The disposition of load images that are currently loaded in the 2210, 2212,
or 2216. The Bank Option can be:

v Erase None . Do not erase any files that are currently stored in the
device.

v Erase Inactive if Needed . Erase any files stored in the device (except
the active image file), if necessary, to make run for the new configuration.

v Erase Any . Erase all files stored in the device.
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This
property...

Is used to describe...

State Indicates the current state of the update job. The State can be:

v Init . The initial phase.

v Prepare . The Prepare phase. During the Prepare phase, NwDM
performs these actions:

– Loads the code and configuration on the TFTP server.

– Deactivates timed load.

– Erases IDB banks (based on option in Erase IBD property).

– Downloads the code and configuration as needed.

– Modifies the status of the ″from″ configuration loaded in the NwDM
database to Obsolescent and the ″to″ configuration to Nascent.

v Perform . The Perform phase. During the Perform phase, NwDM
performs these actions:

– Verifies the contents of the IBD.

– Verifies the 2210, 2212, or 2216 boot entries.

– Reloads or restarts the device depending on the Reload option.

v Verify . The Verify phase. During the Verify phase, NwDM performs these
actions:

– Verifies the PROM image (for the 2210), the load image, and the
configuration.

– Modifies the status of the configuration loaded in the NwDM database
of the ″from″ configuration to Inactive and the ″to″ configuration to
Active.

Configuration
File Name

The actual filename of the configuration file as it will be stored in the IBD
and on the TFTP server.

Configuration
File
Checking

How NwDM checks the configuration file loaded in the device against the
configuration file in the NwDM database. The Configuration File Checking
can be:

v Disallow mismatches . If the two files do not match, the Update
configuration job stops with an error.

v Allow mismatches . Even if the two files do not match, the Update
configuration job continues.
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This
property...

Is used to describe...

Stop At State The state at which the update configuration should stop processing. The
Stop At State can be:

v Init . The initial phase.

v Prepare . The Prepare phase. During the Prepare phase, NwDM
performs these actions:

– Loads the code and configuration on the TFTP server.

– Deactivates timed load.

– Erases IDB banks (based on option in Erase IBD property).

– Downloads the code and configuration as needed.

– Modifies the status of the ″from″ configuration loaded in the NwDM
database to Obsolescent and the ″to″ configuration to Nascent.

v Perform . The Perform phase. During the Perform phase, NwDM
performs these actions:

– Verifies the contents of the IBD.

– Verifies the 2210, 2212, or 2216 boot entries.

– Reloads or restarts the device.

v Verify . The Verify phase. During the Verify phase, NwDM performs these
actions:

– Verifies the PROM image (for the 2210), the load image, and the
configuration.

– Modifies the status of the configuration loaded in the NwDM database
to either Inactive or Active.

These fields are displayed for the UPDATE8275m416 job types:

This
property...

Is used to describe...

Device ID The identifier of the device for which this job applies.

From Version The version number of the configuration that is listed as the Active
configuration for the 8275-416 device.

To Version The version number of the configuration to which the 8275-416 is going to
be updated.

Reset Option When the 8275-416 is restarted after the configuration has been loaded into
the device. The Reload Option can be:

v No Reload . Do not restart the device. However, the configuration will not
take effect until the device has been restarted.

v Reload Immediately . Restart the device as soon as the configuration
has been downloaded into the device.

v Timed Load . Restart the device at the date and time specified by the
Timed Load property.

Reset Started
At

The Reset Started At property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)
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This
property...

Is used to describe...

State Indicates the current state of the update job. The State can be:

v Init . The initial phase.

v Prepare . The Prepare phase. During the Prepare phase, NwDM
performs these actions:

– Loads the code and configuration on the TFTP server.

– Deactivates timed load.

– Downloads the code and configuration as needed.

– Modifies the status of the ″from″ configuration loaded in the NwDM
database to Obsolescent and the ″to″ configuration to Nascent.

v Perform . The Perform phase. During the Perform phase, NwDM
performs these actions:

– Verifies the 8275-416 boot entries.

– Reloads or restarts the device depending on the Reload option.

v Verify . The Verify phase. During the Verify phase, NwDM modifies the
status of the configuration loaded in the NwDM database of the ″from″
configuration to Inactive and the ″to″ configuration to Active.

Configuration
File Name

The actual filename of the configuration file as it will be stored in the device
and on the TFTP server.

Download
Option

How NwDM checks the configuration file loaded in the device against the
configuration file in the NwDM database. The Download Option can be:

v Disallow mismatches . If the two files do not match, the Update
configuration job stops with an error.

v Allow mismatches . Even if the two files do not match, the Update
configuration job continues.

Upload
Option

The Upload Option can be

v Init . The initial phase.

v Prepare . The Prepare phase. During the Prepare phase, NwDM
performs these actions:

– Loads the code and configuration on the TFTP server.

– Deactivates timed load.

– Downloads the code and configuration as needed.

– Modifies the status of the ″from″ configuration loaded in the NwDM
database to Obsolescent and the ″to″ configuration to Nascent.

v Perform . The Perform phase. During the Perform phase, NwDM
performs these actions:

– Verifies the 2210 or 2212 boot entries.

– Reloads or restarts the device.

v Verify . The Verify phase. During the Verify phase, NwDM performs these
actions:

– Verifies the PROM image (for the 2210), the load image, and the
configuration.

– Modifies the status of the configuration loaded in the NwDM database
to either Inactive or Active.
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This
property...

Is used to describe...

Stop At State The state at which the update configuration should stop processing. The
Stop At State can be:

v Init . The initial phase.

v Prepare . The Prepare phase. During the Prepare phase, NwDM
performs these actions:

– Loads the code and configuration on the TFTP server.

– Deactivates timed load.

– Downloads the code and configuration as needed.

– Modifies the status of the ″from″ configuration loaded in the NwDM
database to Obsolescent and the ″to″ configuration to Nascent.

v Perform . The Perform phase. During the Perform phase, NwDM
performs these actions:

– Verifies the 2210, 2212, or 2216 boot entries.

– Reloads or restarts the device.

v Verify . The Verify phase. During the Verify phase, NwDM performs these
actions:

– Verifies the load image and the configuration.

– Modifies the status of the configuration loaded in the NwDM database
to either Inactive or Active.

Editing Job Details
From the Job Details task pane, you can make changes to job properties and run
the job again. To edit the properties for a job, click in the cell containing the
property value, and type in the new information. Then, press Enter or move the
cursor to another property value. When all changes are complete, click Apply
Changes .

The editable properties for jobs of type SYNCHDB are:

v Earliest start

v Latest start

v Predecessor

The editable properties for jobs of type LEARN2210, LEARN2212, or LEARN2216
are:

v Earliest start

v Latest start

v Predecessor

v Device ID

v Version

v Upload image

The editable properties for jobs of type AUDIT2210 or AUDIT2212 are:

v Earliest start

v Latest start

v Predecessor

v Device ID
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v Version

The editable properties for jobs of type UPDATE2210, UPDATE2212, or
UPDATE2216 are:

v Earliest start

v Latest start

v Predecessor

v From version

v To version

v Reload option

v Timed load

v Bank option

v Configuration file name

v Configuration file checking

v Stop at state

The editable properties for jobs of type UPDATE9285m416 are:

v Earliest start

v Latest start

v Predecessor

v From version

v To version

v Reset option

v Download option

v Upload option

v Stop at state

The editable properties for jobs of type UPGCFG2210, UPGCFG2212, or
UPGCFG2216 are:

v Earliest start

v Latest start

v Predecessor

v Device ID

v Version

v Create new version

v Load image

v Version

v Release

Job Details Action Buttons
Use the Jobs Details action button to perform actions on one or more selected jobs.
These action buttons are displayed for the Job Details task pane:

Clicking this
button...

Performs this action...

Apply Changes Applies the changes made when you edited the job details.

Delete job Deletes the job record from the NwDM database.
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Clicking this
button...

Performs this action...

Restart job Restarts a stopped job. Typically, you will click Restart job after editing
the job details.

View log Displays the job log for this job. The job log provides specific information
about job processing.

Delete log Deletes the job log from the NwDM database.

Kill job Stops a job from processing.
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Audit Records
To find out whether the configuration actually loaded in a device matches the
configuration listed as active in the Deployment Manager database, you perform an
Audit task. Deployment Manager maintains a list of all audits performed for each
device. You can use the Audit Records task panel to manage audit records.

To display the Audit Records task panel, click Audit Records from the navigation
tree.

The Audit Records task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Audit Records task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
audit records. The Filter pane is a table containing these columns:

v Properties. The Properties column is a list of audit record properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists all of the ways to
refine the search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the Job
records found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Audit Record Filter Properties
You can search on these audit record properties:

This
property...

Is used to describe ...

Job ID The identifier for a job. Jobs are numbered sequentially within the NwDM
database.

Version The configuration version in the NwDM database for which the audit is
being performed.

Device ID The identifier for the device for which the audit is being performed.

Performed At The date and time that the audit task completed. The date and time are
based on the time zone of the server where the NwDM database is stored.

The Performed At property has the format yy/mm/dd hh:mn d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month (1-31)

v hh is the hour of the day (1-24)

v mn is the minute of the hour (1-60)

v d is either AM (before noon) or PM (before midnight)
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This
property...

Is used to describe ...

Result A determination of whether or not the audit was successful. The Result
property can have a value of either successful or failed.

Details A summary of the details regarding audit processing. The specific details
are stored in the job log for the Audit task.

Audit Record Filter Comparison Operators
Over time the number of audit records stored in the NwDM database can grow to
be quite large. Using comparison operators allow you to refine your search of the
database so that only audit records that meet specific criteria are returned. For a list
of the comparison operators and information about entering data into the Audit
Record filter, see “Working with Deployment Manager Filters and Tables” on
page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each audit record as a separate row. To select
an audit record, click in anywhere in the row, which highlights the row. Use one of
these methods to select multiple audit records:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the audit record is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected audit
records. These action buttons are displayed for the Jobs List task pane:

Clicking this button... Performs this action...

Select All Selects all audit record listed in the Filtered List task pane.

Unselect All Deselects all selected audit records listed in the Filtered List
task pane.

Process Selected... Displays the pop-up menu for the Filtered List task pane.

Add Selected to custom
list...

Add the selected audit records to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:
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Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Filtered List and click Ok.

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected audit
records. From the Print dialog, verify the print information is correct and
click Print .

Print Preview... Displays a preview of how the selected audit records will print. Click
Close to return to the Filtered List task pane.

View details for
selected...

Displays details about the selected audit records.

View job logs
for selected...

Displays job logs for the selected audit records.

Delete
selected...

Deletes the selected audit record from the NwDM database.

Delete job logs
for selected...

Deletes all jobs logs for the selected audit records.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of audit records based on
the results of applying multiple filters. For example, assume you want to work with
all audit records for two 2210 devices. First, you would generate a list of audit
records for a specific device ID in the Filtered List pane (using the = comparison
operator to specify Device ID = devicename). Next, you would select any or all of
those records and click Add selected to custom list to add them to the Custom
List pane. Then, you would apply a filter to generate a list of audit records for a
different device ID. Again, select any or all of these records and apply them to the
custom list. The result is a custom list based on the results of different filters.
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Synchronize Databases
When NwDM is initially installed or when your network has significant changes, you
can also synchronize the NwDM database with the NetView or OpenView topology
database. Depending on the size of the topology database, database
synchronization may take a significant amount of time to complete.

Database synchronization runs as a scheduled job. Therefore you can use the Jobs
task panel to view the status of the job.

During synchronization, NwDM compares the list of devices in its database that
have configurations with a configuration status of Active with the list of devices in
the topology database. NwDM:

v Adds the device to its database if the device exists in the topology database but
not in the NwDM database. After synchronization is complete, perform a Learn
task for the device to add configuration information for the device to the NwDM
database.

v Updates configuration information for any devices in the NwDM database for
which the SNMP read or write community names are changed.

v Records in the job log any devices that exist in the NwDM database but do not
exist in the topology database. You can delete these devices from the NwDM
database.

v Records in the job log any devices for which the device type has changed.
Typically, a change in the device type is a result of an IP address reassignment.
Perform a Learn task for the device to update configuration information for the
device in the NwDM database.

To display the Synchronize Databases task panel, click Synchronize Databases
from the navigation tree.

This field... Is used to... It can contain...

Earliest start Enter the earliest date and time that the
Synchronize Databases task can start.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)
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This field... Is used to... It can contain...

Latest start Enter the latest date and time that the
Synchronize Databases task can start.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Start the Synchronize Databases task
immediately (when you click Apply ).

Check mark if the box is
selected.

These action buttons are available for the Synchronize Databases task panel:

Apply Schedules the Synchronize Databases task as a job..

Help Displays help for this task panel.
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Software Inventory-Edit Software Inventory Properties
Use the Edit Software Inventory Properties task panel to specify where the software
components inventory file is located. Deployment Manager uses the information you
specify for Edit Software Inventory Properties to perform the Update Software
Inventory task (see “Software Inventory-Update Software Inventory” on page 65).

To display the Edit Software Inventory task panel, click Edit software inventory
properties from the Software Inventory folder of the navigation tree.

The Edit Software Inventory Properties task panel is divided into these panes:

v Inventory Source

v Products

After updating the information on the Edit Software Inventory Properties task panel,
click Apply to save your changes. You can display the help panel for this task panel
by clicking Help .

Inventory Source Pane
Use the Inventory Source pane to specify the location where the software
components are located.

This field... Is used to... It can contain...

Inventory file
source

Select the source site used to obtain the
software inventory file.

IBM-North America

IBM-Europe

Other FTP server

Existing files

FTP host name Specify the host name of the location
where the software inventory file is
located.

A valid FTP host name or IP
address where the software
inventory file is located.

If you selected IBM-North
America or IBM-Europe this
field is automatically set to
the appropriate FTP host
name.

Socks host
name

Specify the server name of the Socks
server.

A valid host name or IP
address of the Socks server.

Socks host port Specify the port to be used for accessing
the Socks server.

A valid port number between
1 and 65535 inclusive. The
default is 1080.

Remote
directory

Specify the directory on the server where
the software inventory file is located.

A valid directory on the
server.

If you selected IBM-North
America or IBM-Europe this
field is automatically set to
the appropriate directory.

Local server
directory

Specify the directory on the Deployment
Manager server where the software
inventory file is located.

A valid directory on the
NwDM server. Fill in this field
only if you selected Existing
Files as the Inventory File
Source.
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Products Pane
The Products task pane lists the network device types. Click the devices for which
you want to obtain software component information. You can obtain software
component information for these network devices:

v 2210

v 2212

v 2216

v 8275-416
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Software Inventory-Update Software Inventory
Deployment Manager maintains an inventory of software components that are
available for network devices. These software components include:

v Operational Code. Deployment Manager maintains load images for network
devices. These load images can be base releases of the operational code,
program temporary fixes (PTFs), or emergency program temporary fixes
(EPTFs).

v Boot and Diagnostic Code. For the 2210, Deployment Manager maintains an
inventory of all PROM code images available for network devices.

When you initially install Deployment Manager and as new software components
become available, you need to update the NwDM database to reflect all available
components. When you perform the Update Software Inventory task Deployment
Manager uses the properties defined in the Edit Software Inventory Properties task
(see page xx ) to obtain an XML file that contains information about the software
components.

Updating the software inventory provides information to Deployment Manager about
the load images and PROM images (for the 2210) available for a network device. It
does not actually upload load images or PROM images into the NwDM database.
Before using load images or PROM images to update a network device, you must
first import the image into the database.

Note: If you are updating the software inventory from an IBM networking web site,
the inventory loaded reflects what is on the site. There may be slight delays
before images are available for download as the images are actually put on
the web site and mirrored to other sites.

To display the Update Software Inventory task panel, click Update software
inventory from the Software Inventory folder of the navigation tree.

Click Apply to update software inventory. To display the help panel for this task
panel by clicking Help .

Inventory Update Pane
Use the Inventory Update pane to specify the user ID and password for the web
site you specified in the Update Software Inventory Properties task.

This field... Is used to... It can contain...

User ID Specify the user ID for accessing the web
site where the software inventory file is
located.

A valid user ID. The default
is anonymous (which is
acceptable as the password
for the IBM sites).

Password Specify the password associated with the
user ID.

A valid password. If you
specified an IBM site as the
location of the software
inventory file, enter your
e-mail address as the
password.

The Update Software Inventory task is an interactive task. When you click Apply ,
the Progress window displays the current status of the task.
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Chapter 4. Understanding 2210 Task Panels and Dialogs

This chapter describes each of the task panels and dialogs provided with Nways
Deployment Manager for managing 2210 configurations. For each task panel or
dialog, this chapter provides:

v Description of the task panel or dialog

v Table listing each field, the purpose of the field, and valid values.

v Description of the available pop-up menu selections.

v Description of the available action buttons.
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Create 2210 Device
Use the 2210 Create Device task panel to create a 2210 in the Deployment
Manager database. After creating the device, you will typically perform a 2210
Learn Configuration task to update the database with information about the device
configuration.

To display the 2210 Create Device task panel, click Create device from the 2210
folder of the navigation tree.

After updating the information in the 2210 Create Device task panel, click Apply to
start the job. Deployment Manager creates a device in the database based on the
information you entered in the Main pane. In addition, an initial configuration is
created for the device (version 0) and set to a status of Incomplete. Schedule a
2210 Learn Configuration task to create an Active configuration version based on
the 2210 device.

You can display the help panel for this task panel by clicking Help .

Main Pane
Use the Main pane to specify information about the device to be created.

This field... Is used to... It can contain...

Device Name Specify the name of this device in the
NwDM database.

Up to 254 characters
denoting the device name.

NwDM does not check to
make sure that the device
name is unique, which
means that you can have
multiple devices with the
same device name.

IP Address The IP address for this device. A valid IP address or host
name.

Operator ID The operator ID used for accessing this
device, if the device has been configured
for login protection.

A valid operator ID.

Password The password that corresponds to the
operator ID.

A valid password.

SNMP read
community
name

The SNMP read community to which this
device belongs.

The SNMP read community
name. The default is public.

SNMP write
community
name

The SNMP write community to which this
device belongs.

The SNMP write community
name.

TFTP Server IP
Address

The IP address of an TFTP server with
which this device can communicate.

A valid IP address of a TFTP
server.
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2210 Configurations
The 2210 Configurations task panel provides a way to manage device
configurations. You can store multiple configurations for a 2210 device. Each
configuration has a unique version associated with it and a configuration version
status, which can be one of these values:

v Active . The active configuration is the configuration that is currently loaded in,
and operational for, the 2210 device.

v Inactive . An inactive configuration is a configuration that can be loaded into the
2210 device. It contains all the components (load image, PROM image, and
configuration file) necessary to become the active configuration.

v Incomplete . An incomplete configuration is one that contains only a portion of
the components necessary to become an active configuration. It cannot be
loaded into a 2210 device.

Note: There are actually two additional states for a configuration. A configuration
can be in the state of nascent , which means the configuration is in the
process of becoming the active configuration, or the state of obsolescent ,
which means the configuration is in the process of becoming an inactive
configuration.

To display the 2210 Configuration task panel, click Configurations from the 2210
folder of the navigation tree.

The Configurations task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Configurations task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
configurations. The Filter pane contains these columns:

v Properties. The Properties column is a list of configuration properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the
Configurations found in the database using the comparison operator you
specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.
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Configuration Filter List Properties
You can search on these configuration properties:

This
property...

Is used to describe...

Device ID The identifier of the device. NwDM creates the Device ID when the device
is added to the NwDM database (using either the 2210 Create Device task
or Synchronize Databases task).

Device Name The name of the device. You specified the device name when you added
the device to the NwDM database using the 2210 Create Device task.

Model The model number of the 2210, such as 12T, 12E, or 1U4.

Flash (MB) The amount of flash memory installed in the device (in megabytes).

DRAM (MB) The amount of dynamic memory installed in the device (in megabytes).

Version The configuration version. NwDM can maintain multiple version of a
configuration. Different configuration versions for a device are numbered
sequentially beginning with 0.

Address The IP address or host name for the device.

Version
status

The status of the configuration version. Version status can be one of these
values:

v Active . The active configuration is the configuration considered by
NwDM to be actually loaded in the 2210.

v Inactive . An inactive configuration is a configuration that can be loaded
into the 2210 device. It contains all of the components (load image,
PROM image, and updated configuration file) necessary to become an
active configuration.

v Incomplete . An incomplete configuration is one that contains only a
portion of the components necessary to become an active configuration.
It cannot be loaded into a 2210 device.

v Nascent . A nascent configuration is a configuration that is in the process
of moving from an inactive status to an active status.

v Obsolescent . An obsolescent configuration is a configuration that is in
the process of moving from an active status to an inactive status.

Approval
status

The approval status of the configuration version. Approval status can be
one of these values:

v Approved .

v Unapproved .

v Rejected .

Commit
status

The commit status of the configuration version. Approval status can be one
of these values:

v Committed . When the configuration version has been committed, the
configuration is locked (no changes can be made to the configuration).

v Uncommitted . When the configuration version is uncommitted, changes
can be made to the configuration.

Remarks Text data that has been entered for this configuration.

Modified by The user ID of the person who last changed the configuration. For new
configurations, the Modified by property contains the user ID of the person
who created the configuration.

Modified at Date and time this configuration was added to the database.

SNMP read
community
name

The SNMP read community to which the device belongs.
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This
property...

Is used to describe...

SNMP write
community
name

The SNMP write community to which the device belongs.

Operator ID The operator ID used to access the device if it has been configured for
login protection.

Operator
password

The password associated with the operator ID.

TFTP server The IP address or host name of the TFTP server that can communicate
with the 2210.

PROM level The PROM level used with this configuration.

Config
format

The format used for the configuration file. It can have one of these values:

v SRAM.

v ASCII.

Config
Modified at

The date and time the configuration was last changed.

Config length The amount of memory (in bytes) used in the NwDM database for storing
the configuration Load image. If the Load image is not stored in the NwDM
database (it may reside on a TFTP server for example), the value of this
property is 0

Load image The name of the load image.

Image
version

The software version corresponding to the load image.

Image
release

The software release corresponding to the load image.

Image PTF The PTF corresponding to the load image.

Configuration Comparison Operators
Over time the number of configurations stored in the NwDM database can grow to
be quite large. Using comparison operators allow you to refine your search of the
database so that only configurations that meet specific criteria are returned. For a
list of the comparison operators and information about entering data into the
Configuration filter, see “Working with Deployment Manager Filters and Tables” on
page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each configuration as a separate row. To select
a configuration, click in anywhere in the row, which highlights the row. Use one of
these methods to select multiple configurations:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the configuration is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.
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You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected
configurations. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all configurations listed in the Filtered List task pane.

Unselect All Deselects all selected configurations listed in the Filtered List
task pane.

Select active Selects all active configurations listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected configurations to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

For example, these columns are hidden by default in the Configurations
Filtered List task pane:

v Approval status

v Commit status

v Flash (MB)

v DRAM (MB)

v Remarks

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected job records.
From the Print dialog, verify the print information is correct and click
Print .

Print Preview... Displays a preview of how the selected job records will print. Click Close
to return to the Jobs List task pane.
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Clicking... Performs this action...

Clone
selected...

Makes a new copy of selected configurations so you can create new
configurations without having to reenter each of the fields. When you
click Clone selected... , the Confirm Configuration Cloning dialog is
displayed. Click Yes to continue.

The cloned configuration contains the same configuration properties as
the original configuration with these exceptions:

v Version status. If you clone an active configuration, the cloned
configuration will have a status of inactive. Otherwise, the cloned
configuration will have the same status as the original configuration.

v Approval status. The Approval status of a cloned configuration is set to
Unapproved.

v Commit status. The Commit status is set to Uncommitted.

v Modified by. The Modified by property is set to the current user ID.

v Modified at. The Modified at property is set to the current date and
time.

Approve
selected...

Sets the Approval status property to Approved. When the Confirm
Approve Configurations dialog is displayed, click Yes to approve selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Reject
selected...

Sets the Approval status property to Rejected. When the Confirm Reject
Configurations dialog is displayed, click Yes to reject selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Commit
selected...

Sets the Commit status to Committed. When the Confirm Configuration
Commit dialog is displayed, click Yes to commit the configuration.

Committed configurations are locked; they cannot be modified. You can
only commit configurations with a status of Active or Inactive.

Modify
selected...

Displays the Modify Properties dialog, which you can use to modify
properties for configurations.

Delete
selected...

Deletes the configuration from the NwDM database. When the Confirm
Configuration Delete dialog is displayed, click Yes to delete
configurations.
Note: If a device has no configurations listed in the NwDM database, the
device is also deleted from the database.

Learn
selected...

Displays the Learn 2210 Configuration task panel, which you can use to
create active configurations based on configuration currently loaded in
the device. See “Learn 2210 Configurations” on page 75 for more
information about the Learn 2210 Configuration Dialog.

Upgrade
selected...

Displays the Upgrade 2210 Configuration dialog, which you can use to
create upgraded configurations in the NwDM database. See “Upgrade
2210 Configurations” on page 77 for information about the Upgrade 2210
Configuration dialog.

Import
selected...

Displays the Import 2210 Configuration dialog, which you can use to
import configurations into the NwDM database. See “Import 2210
Configurations” on page 79 for information about importing configurations.

Export
selected...

Displays the Export 2210 Configuration dialog, which you can use to
export configurations from the NwDM database. See “Export 2210
Configurations” on page 82 for information about exporting configurations.
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Clicking... Performs this action...

Update
selected...

Displays the Update 2210 Configuration dialog, which you can use to
load active configurations from the NwDM database into a device. See
“Update 2210 Configuration” on page 104 for information about updating
a configuration.

Update PROM
level on
selected...

Displays the Update PROM Levels dialog, which you can use to load a
new PROM image into a device.

Audit selected... Displays the Audit 2210 Configuration dialog, which you can use to audit
2210 configurations to ensure the configuration version with a status of
Active in the NwDM database matches the configuration actually loaded
in the device.

View audit
records of
selected...

Displays the View 2210 Audit Records dialog, which you can use to view
audit records for a device.

View latest
audit records of
selected...

Displays the View Latest 2210 Audit Records dialog, which you can use
to view the latest audit records for a device.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of Configuration records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of Configuration records with a version status of active for the
Filtered List pane that. Next, you would select any or all of those records and click
Add selected to custom list to add them to the Custom List pane. Then, you
would apply a filter to generate a list of Configuration records with an approval
status of Approved. Again, select any or all of these records and apply them to the
custom list. The result is a custom list based on the results of different filters.
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Learn 2210 Configurations
Use the 2210 Learn Configurations task panel to discover the current state of a
2210 and to set a configuration version for the device that reflects that state. You
can also choose to upload the load image for this configuration into the Nways
Deployment Manager database.

The 2210 Learn Configurations task is a scheduled job. If it completes successfully,
any previously active configuration defined for this device becomes inactive, and the
learned configuration becomes the active configuration for the device.

Use one of these methods to display the 2210 Learn Configurations task panel:

v Click Learn configurations from the 2210 folder of the navigation tree.

v Select a configuration from the Filtered List or Custom List of the Configurations
task panel, click Process selected... , and then click Learn selected... . See
“2210 Configurations” on page 69 for more information about the Configurations
task panel.

The 2210 Learn Configurations task panel is divided into these panes:

v Options

v Candidates

After updating the information on the 2210 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2210 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to schedule when the learn task will occur.

This field... Is used to... It can contain...

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)
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This field... Is used to... It can contain...

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2210 Learn Configuration
task should begin immediately (when you
click Apply).

A check mark if the box is
selected.

Upload load
image if needed

Specify that a copy of the load image in
the 2210 should be uploaded to the
NwDM database.

NwDM will not upload the PROM image.

A check mark if the box is
selected.

Candidates Pane
The Candidates pane displays a list of 2210 devices for which the Learn
Configurations task can be performed. The list of 2210 devices displayed depends
on how you arrived at the 2210 Learn Configurations task panel:

v If you selected Learn Configurations from the 2210 folder of the navigation tree,
the list of 2210 devices will include all 2210 devices for which the current
configuration version number in the Nways Deployment Manager database is 0.

v If you selected Learn Selected... from the Filtered List pane or Custom List pane
of the Configurations panel, the list of 2210 devices will include all 2210 devices
selected on that pane.

Candidates Action Buttons
Use the Candidates action button to perform actions from the Candidates pane.
These action buttons are displayed for the Candidates pane:

Clicking this button... Performs this action...

Set all Selects all candidates listed in the Candidates pane.

Reset all Deselects all candidates listed in the Candidates pane.
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Upgrade 2210 Configurations
Use the Upgrade 2210 Configurations dialog to create an upgraded configuration
file for either a new or existing configuration. The upgraded configuration is added
only to the NwDM database. To actually load the upgraded configuration in a
device, you must perform an Update 2210 configuration task.

To display the Upgrade 2210 Configurations dialog, select a configuration from the
Filter List pane or the Custom List pane of the Configurations task panel, click
Process selected... , and then click Upgrade selected... .

Fill in these fields for the Upgrade 2210 Configurations dialog:

This field... Is used to... It can contain...

Start now Specify that the Upgrade 2210
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Create new
version

Specify whether NwDM is to create a
new configuration version on which to
perform the upgrade.

If you are upgrading an active
configuration, you must click this box.

A check mark if the box is
selected.

Use selected
load image

Specify the load image that is to be used
for the upgraded configuration.

A dot if the radio button is
selected.
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This field... Is used to... It can contain...

Image name Specify the name of the load image to
use for the upgraded configuration.

If you do not know the image name, you
can click Select image to display the
Select Image dialog.

A valid path name and load
image name.

Use latest load
image matching
version/release

Specify that the latest load image that
matches the Version number and
Release number should be used.

A dot if the radio button is
selected.

Version Specify the version number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image version.

Release Specify the release number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image
release.

Upgrade PROM Specify whether the PROM should also
be upgraded.

A check mark if the box is
selected.

Use latest
available PROM
image

Specify that the latest available PROM
image corresponding to the device should
be used for the upgraded configuration.

A check mark if the box is
selected.

PROM level Specify the PROM level to be used for
the upgraded configuration.

You can choose a PROM level by clicking
Select PROM image to display the
Select PROM Image dialog.

The name of a valid PROM
image.

Use these action buttons from the Upgrade 2210 Configurations dialog:

Clicking this button... Performs this action...

Submit Schedules the Upgrade 2210 Configurations task as a job.

Cancel Exits the Upgrade 2210 Configurations dialog without
scheduling the task as a job.

Help Displays help for the Upgrade 2210 Configurations dialog.
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Import 2210 Configurations
The Import 2210 Configuration dialog allows you to import a configuration file into
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Import 2210 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2210
Configurations panel, click Process selected... , and then click Import selected... .

The Import 2210 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to import the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Import from Server File Import the configuration from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the configuration from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the configuration from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the configuration file.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the configuration file.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID.

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the File tab to specify information about the file name to be used for importing
the configuration file and the directory where the configuration file is currently
located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are importing only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are importing more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The imported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the configuration file
is located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the import
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a naming convention).

After entering information for the FTP tab, click Next to display the Misc tab or
Back to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be imported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Source format The format currently used for the source
configuration file.

ASCII

SRAM

Target format
for database

The format to be used when storing the
configuration file in the NwDM database.

SRAM

Version The software version to which this
configuration file applies.

A valid version number.

Release The software release to which this
configuration file applies.

A valid release number.

After entering information for the FTP tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the configuration file.

Click Import to begin importing the configuration file. The Import Configuration task
is an interactive task. The current status of the import task is displayed in the
Message window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2210 Configurations
The Export 2210 Configurations dialog allows you to export a configuration file from
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Export 2210 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2210
Configurations panel, click Process selected... , and then click Export selected... .

The Export 2210 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to export the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the configuration to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the configuration to a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Export the configuration to an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the configuration file will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported
configuration file will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the configuration file will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
will be exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the file name to be used for exporting
the configuration file and the directory where the configuration file will be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are exporting only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are exporting more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The exported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the exported
configuration file will be located. Use a
forward slash (/) to separate directories
and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a file naming
convention).

After entering information for the File tab, click Next to display the Misc tab or Back
to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be exported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Target format The format currently used for the
exported configuration file.

If you choose to export the file in a format
that differs from the current format of the
file as it is stored in the NwDM database,
NwDM uses the GUI Configuration Tool
to convert the file to the requested
format.

ASCII

SRAM

Version The software version to which the
exported configuration file applies.

A valid version number.

Release The software release to which the
exported configuration file applies.

A valid release number.

After entering information for the Misc tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin exporting the configuration file.
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Click Export to begin exporting the configuration file. The Export Configuration task
is an interactive task. The current status of the export task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.
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2210 Load Images
Load images contain the operational code that runs in a 2210. Information about
specific load images is initially loaded into the NwDM database when you update
software inventory for the 2210 (you also have the option of loading the actual Load
Image into the database at that time). These load images correspond to the
operational code releases of the 2210 software.

Use the Load Images task panel to manage 2210 load images. To display the 2210
Load Images task panel, click Load images from the 2210 folder in the navigation
tree.

The Load Images task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Load Images task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
load images. The Filter pane contains these columns:

v Properties. The Properties column is a list of load image properties on which you
can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the load
images found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Load Image Filter List Properties
You can search on these load image properties:

This
property...

Is used to describe...

Name The name of the load image.

Version The MRS software version to which this load image applies.

Release The MRS software release to which this load image applies.

PTF The program temporary fix (PTF) to which this load image applies.

Flash bytes The amount of flash memory (in bytes) required for this load image.

Modified at Date and time this load image was added to the database.

Download
URL

The URL where the load image can be found.

Information
URL

The URL where information about this load image can be found.

Image length The number of bytes in the NwDM database taken up by this load image. If
the load image is not stored in the database, this value is 0.

Build name An identifier used by NwDM to identify this load image.
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This
property...

Is used to describe...

Minimum
PROM level

The minimum PROM level required to support this load image.

Configuration Comparison Operators
Over time the number of load images stored in the NwDM database can grow to be
quite large. Using comparison operators allow you to refine your search of the
database so that only load images that meet specific criteria are returned. For a list
of the comparison operators and information about entering data into the Load
Images filter, see “Working with Deployment Manager Filters and Tables” on
page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each load image as a separate row. To select a
load image, click anywhere in the row, which highlights the row. Use one of these
methods to select multiple load images:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the load image is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected load
images. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all load images listed in the Filtered List task pane.

Unselect All Deselects all selected load images listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected load images to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:
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Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected load image
records. From the Print dialog, verify the print information is correct and
click Print .

Print Preview... Displays a preview of how the selected load image records will print.
Click Close to return to the Jobs List task pane.

Delete selected
image files...

Deletes selected load images from the NwDM database. When the
Confirm Load Image File Delete dialog is displayed, click Yes to delete
the load image.

Import selected
image files...

Displays the Import 2210 Load Images dialog, which you can use to
import a load image into the NwDM database. See “Import 2210 Load
Images” on page 89 for information about importing a load image.

Export selected
image files...

Displays the Export 2210 Load Images dialog, which you can use to
export a load image from the NwDM database. See “Export 2210 Load
Images” on page 92 for information about exporting a load image.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of load image records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of load image records with a length of 0 for the Filtered List
pane that. Next, you would select any or all of those records and click Add
selected to custom list to add them to the Custom List pane. Then, you would
apply a filter to generate a list of load image records that apply to MRS Version 3.
Again, select any or all of these records and apply them to the custom list. The
result is a custom list based on the results of different filters.
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Import 2210 Load Images
The Import 2210 Load Images dialog allows you to import a load image into the
NwDM database. To display the Import 2210 Load Images dialog, select one or
more load images from either the Filtered List task pane or the Custom List task
pane of the 2210 Load Images task panel, click Process selected , and then click
Import selected image files... .

The Import 2210 Load Images dialog contains these tabs:

v Method

v TFTP

v Download URL

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Use specified download
URL

Import the load image from an FTP server. You can use this
option to import the load image from an IBM web site. When
you click Next , the Download URL tab is displayed.

Import from Server File Import the load image from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the load image from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the load image from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the load image.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

Download URL Tab
Use the Download URL tab to provide the URL information for importing the load
image.

Enter this information on the Download URL tab:

This field... Is used to specify... It can contain...

Override
download URL
host with

The download host to use. If you choose
IBM-North America or IBM-Europe, the
FTP tab is updated to with the
appropriate information.

No override - use download
URL host

IBM-North America

IBM-Europe

Other FTP Host

After entering information for the Download URL tab, click Next to display the FTP
tab or Back to return to the previous tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the load image.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.
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File Tab
Use the File tab to specify information about the directory where the load image is
currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the load image is
located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Host Directory, or FTP Host
Directory, depending on the import
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the load image.

Click Import to begin importing the load image. The Import Load Images task is an
interactive task. The current status of the import task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2210 Load Images
The Export 2210 Load Images dialog allows you to export a load image from the
NwDM database.

To display the Export 2210 Load Images, select one or more load images from
either the Filtered List task pane or the Custom List task pane of the 2210 Load
Images panel, click Process selected... , and then click Export selected image
files... .

The Export 2210 Load Images dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the load image to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the load image to a TFTP server. When you click Next ,
the TFTP tab is displayed.

Use FTP Export the load image to an FTP server. When you click Next ,
the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the load image will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported load
image will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the load image will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image will be
exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the File tab to specify information about the directory where the load image will
be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the exported load
image will be located. Use a forward
slash (/) to separate directories and
subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.
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Results Tab
Use the Results tab to begin exporting the load image.

Click Export to begin exporting the load image. The Export Load Image task is an
interactive task. The current status of the export task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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2210 PROM Images
PROM images contain the boot and diagnostic code that run in a 2210. Information
about specific PROM images is initially loaded into the NwDM database when you
update software inventory for the 2210.

Use the PROM Images task panel to manage 2210 PROM images. To display the
2210 PROM Images task panel, click PROM images from the 2210 folder of the
navigation tree.

The PROM Images task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the PROM Images task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
PROM images. The Filter pane contains these columns:

v Properties. The Properties column is a list of PROM image properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the PROM
images found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

PROM Image Filter List Properties
You can search on these PROM image properties:

This
property...

Is used to describe...

Name The name of the PROM image.

Modified at Date and time this PROM image was added to the database.

Download
URL

The URL where the PROM image can be found.

Information
URL

The URL where information about this PROM image can be found.

Image length The number of bytes in the NwDM database taken up by this PROM image.
If the PROM image is not stored in the database, this value is 0.

Configuration Comparison Operators
Over time the number of PROM image records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only PROM image records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the PROM images filter, see “Working with Deployment Manager Filters and
Tables” on page 10.
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Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each PROM image as a separate row. To
select a PROM image, click anywhere in the row, which highlights the row. Use one
of these methods to select multiple PROM images:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the PROM image is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected
PROM images. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all PROM images listed in the Filtered List task pane.

Unselect All Deselects all selected PROM images listed in the Filtered List
task pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected PROM images to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected PROM image
records. From the Print dialog, verify the print information is correct and
click Print .
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Clicking... Performs this action...

Print Preview... Displays a preview of how the selected PROM image records will print.
Click Close to return to the Jobs List task pane.

Delete selected
PROM image
files...

Deletes selected PROM image files from the NwDM database. When the
Confirm PROM Image File Delete dialog is displayed, click Yes to delete
the PROM image.

Import selected
PROM image
files...

Displays the Import 2210 PROM Images dialog, which you can use to
import a PROM image into the NwDM database. See “Import 2210
PROM Images” on page 98 for information about importing a load image.

Export selected
PROM image
files...

Displays the Export 2210 PROM Images dialog, which you can use to
export a PROM image from the NwDM database. See “Export 2210
PROM Images” on page 101 for information about exporting a load
image.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of PROM image records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of PROM image records with a length of 0 for the Filtered
List pane that. Next, you would select any or all of those records and click Add
selected to custom list to add them to the Custom List pane. Then, you would
apply a filter to generate a list of PROM image records that apply were modified at
a specific date and time. Again, select any or all of these records and apply them to
the custom list. The result is a custom list based on the results of different filters.
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Import 2210 PROM Images
The Import 2210 PROM Images dialog allows you to import a PROM image into the
NwDM database. To display the Import 2210 PROM Images dialog, select one or
more PROM images from either the Filtered List task pane or the Custom List task
pane of the 2210 PROM Images task panel, click Process selected... , and then
click Import selected PROM image files... .

The Import 2210 PROM Images dialog contains these tabs:

v Method

v TFTP

v Download URL

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the PROM image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Use specified download
URL

Import the PROM image from an FTP server. You can use this
option to import the PROM image from an IBM web site. When
you click Next , the Download URL tab is displayed.

Import from Server File Import the PROM image from the NwDM server. When you
click Next , the File tab is displayed.

Use TFTP Import the PROM image from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the PROM image from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the load image.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the PROM image is
located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

Download URL Tab
Use the Download URL tab to provide the URL information for importing the PROM
image.

Enter this information on the Download URL tab:

This field... Is used to specify... It can contain...

Override
download URL
host with

The download host to use. If you choose
IBM-North America or IBM-Europe, the
FTP tab is updated to with the
appropriate information.

No override - use download
URL host

IBM-North America

IBM-Europe

Other FTP Host

After entering information for the Download URL tab, click Next to display the FTP
tab or Back to return to the previous tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the PROM image.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the PROM image is
located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID.

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.
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File Tab
Use the File tab to specify information about the directory where the PROM image
is currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the PROM image is
located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Host Directory, or FTP Host
Directory, depending on the import
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the PROM image.

Click Import to begin importing the PROM image. The Import PROM Images task is
an interactive task. The current status of the import task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2210 PROM Images
The Export 2210 PROM Images dialog allows you to export a PROM image from
the NwDM database.

To display the Export 2210 PROM Images, select one or more PROM images from
either the Filtered List task pane or the Custom List task pane of the 2210 PROM
Images panel, click Process selected... , and then click Export selected PROM
image files... .

The Export 2210 PROM Images dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the PROM image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the PROM image to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the PROM image to a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Export the PROM image to an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the PROM image will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported PROM
image will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the PROM image will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the PROM image will
be exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the File tab to specify information about the directory where the PROM image
will be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the exported PROM
image will be located. Use a forward
slash (/) to separate directories and
subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.
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Results Tab
Use the Results tab to begin exporting the PROM image.

Click Export to begin exporting the PROM image. The Export PROM Image task is
an interactive task. The current status of the export task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.
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Update 2210 Configuration
When you update a 2210 configuration, you are changing the configuration that is
currently loaded in a 2210 (the active configuration) to another configuration that
you select. The configuration that you select must have a configuration status of
inactive. Configuration updates are scheduled as jobs (you can use the Managing
Jobs panel to view the status of an update job.

After updating the information on the 2210 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2210 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to specify this information about the update task:

This field... Is used to... It can contain...

Earliest start Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2210 Update
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.
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This field... Is used to... It can contain...

Reload Option Determine when the 2210 device is to be
restarted after the configuration has been
applied. These options are available:

v No Reload. The 2210 device is not
restarted. However, the new
configuration will not take effect in the
2210 until a reload is performed.

v Reload immediately. Restart the 2210
to load the new configuration
immediately after NwDM downloads it
to the 2210.

v Timed load. Restart the 2210 to load
the new configuration at the time
specified in the Timed Load field.

No reload

Reload immediately

Timed load

Timed load Specify the date and time that the reload
should begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Bank Option Specify how configurations currently
loaded into the IBD should be handled.
These options are available:

v Erase none. Do not erase any
configurations that are currently in the
IBD.

v Erase available if needed. Erase any
available configurations that are
currently in the IBD, if necessary.

v Erase any. Erase any configurations
that are currently in the IBD.

Erase none

Erase available if needed

Erase any

Configuration
file checking

Determines whether or not mismatches
are allowed when the device
configuration file is checked with the
configuration file in the NwDM database.

Disallow mismatches

Allow mismatches
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This field... Is used to... It can contain...

Stop at state Specify when processing for this update
job will stop. These options are available:

v None. Do not stop processing.

v Next state. Stop processing when the
current state is complete.

v Init. The initial phase.

v Prepare.The Prepare phase. During
the Prepare phase, NwDM performs
these actions:

– Loads the code and configuration
on the TFTP server.

– Deactivates timed load.

– Erases IDB banks (based on option
in Erase IBD property).

– Downloads the code and
configuration as needed.

– Modifies the status of the ″from″
configuration loaded in the NwDM
database to Obsolescent and the
″to″ configuration to Nascent.

v Perform. The Perform phase. During
the Perform phase, NwDM performs
these actions:

– Verifies the contents of the IBD.

– Verifies the 2210 boot entries.

– Reloads or restarts the device.

v Verify. The Verify phase. During the
Verify phase, NwDM performs these
actions:

– Verifies the PROM image, the load
image, and the configuration.

– Modifies the status of the
configuration loaded in the NwDM
database to either Inactive or
Active.

None

Next state

Init

Prepare

Perform

Verify
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Chapter 5. Understanding 2212 Task Panels and Dialogs

This chapter describes each of the task panels and dialogs provided with Nways
Deployment Manager for managing 2212 configurations. For each task panel or
dialog, this chapter provides:

v Description of the task panel or dialog

v Table listing each field, the purpose of the field, and valid values.

v Description of the available pop-up menu selections.

v Description of the available action buttons.
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Create 2212 Device
Use the 2212 Create Device task panel to create a 2212 in the Deployment
Manager database. After creating the device, you will typically perform a 2212
Learn Configuration task to update the database with information about the device
configuration.

To display the 2212 Create Device task panel, click Create device from the 2212
folder of the navigation tree.

After updating the information in the 2212 Create Device task panel, click Apply to
start the job. Deployment Manager creates a device in the database based on the
information you entered in the Main pane. In addition, an initial configuration is
created for the device (version 0) and set to a status of Incomplete. Schedule a
2212 Learn Configuration task to create an Active configuration version based on
the 2212 device.

You can display the help panel for this task panel by clicking Help .

Main Pane
Use the Main pane to specify information about the device to be created.

This field... Is used to... It can contain...

Device Name Specify the name of this device in the
NwDM database.

Up to 254 characters
denoting the device name.

NwDM does not check to
make sure that the device
name is unique, which
means that you can have
multiple devices with the
same device name.

IP Address The IP address for this device. A valid IP address or host
name.

Operator ID The operator ID used for accessing this
device, if the device has been configured
for login protection.

A valid operator ID.

Password The password that corresponds to the
operator ID.

A valid password.

SNMP read
community
name

The SNMP read community to which this
device belongs.

The SNMP read community
name. The default is public.

SNMP write
community
name

The SNMP write community to which this
device belongs.

The SNMP write community
name.

TFTP Server IP
Address

The IP address of an TFTP server to
which this device can communicate.

A valid IP address of a TFTP
server.
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2212 Configurations
The 2212 Configurations task panel provides a way to manage device
configurations.You can store multiple configurations for a 2212 device. Each
configuration has a unique version associated with it and a configuration version
status, which can be one of these values:

v Active . The active configuration is the configuration that is currently loaded in,
and operational for, the 2212 device.

v Inactive . An inactive configuration is a configuration that can be loaded into the
2212 device. It contains all the components (load image and configuration file)
necessary to become the active configuration.

v Incomplete . An incomplete configuration is one that contains only a portion of
the components necessary to become an active configuration. It cannot be
loaded into a 2212 device.

Note: There are actually two additional states for a configuration. A configuration
can be in the state of nascent , which means the configuration is in the
process of becoming the active configuration, or the state of obsolescent ,
which means the configuration is in the process of becoming an inactive
configuration.

To display the 2212 Configuration task panel, click Configurations from the 2212
folder of the navigation tree.

The Configurations task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Configurations task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
configurations. The Filter pane contains these columns:

v Properties. The Properties column is a list of configuration properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the
Configurations found in the database using the comparison operator you
specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.
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Configuration Filter List Properties
You can search on these job properties:

This
property...

Is used to describe...

Device ID The identifier of the device. NwDM creates the Device ID when the device
is added to the NwDM database (using either the 2212 Create Device task
or Synchronize Databases task).

Device Name The name of the device. You specified the device name when you added
the device to the NwDM database using the 2212 Create Device task.

Model The model number of the 2212.

Version The configuration version. NwDM can maintain multiple version of a
configuration. Different configuration versions for a device are numbered
sequentially beginning with 0.

Address The IP address or host name for the device.

Version
status

The status of the configuration version. Version status can be one of these
values:

v Active . The active configuration is the configuration considered by
NwDM to be actually loaded in the 2212.

v Inactive . An inactive configuration is a configuration that can be loaded
into the 2212 device. It contains all of the components (load image,
PROM image, and updated configuration file) necessary to become an
active configuration.

v Incomplete . An incomplete configuration is one that contains only a
portion of the components necessary to become an active configuration.
It cannot be loaded into a 2212 device.

v Nascent . A nascent configuration is a configuration that is in the process
of moving from an inactive status to an active status.

v Obsolescent . An obsolescent configuration is a configuration that is in
the process of moving from an active status to an inactive status.

Approval
status

The approval status of the configuration version. Approval status can be
one of these values:

v Approved .

v Unapproved .

v Rejected .

Commit
status

The commit status of the configuration version. Approval status can be one
of these values:

v Committed . When the configuration version has been committed, the
configuration is locked (no changes can be made to the configuration).

v Uncommitted . When the configuration version is uncommitted, changes
can be made to the configuration.

Remarks Text data that has been entered for this configuration.

Modified by The user ID of the person who last changed the configuration. For new
configurations, the Modified by property contains the user ID of the person
who created the configuration.

Modified at Date and time this configuration was added to the database.

SNMP read
community
name

The SNMP read community to which the device belongs.

SNMP write
community
name

The SNMP write community to which the device belongs.
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This
property...

Is used to describe...

Operator ID The operator ID used to access the device if it has been configured for
login protection.

Operator
password

The password associated with the operator ID.

TFTP server The IP address or host name of the TFTP server that can communicate
with the 2212.

Config
format

The format used for the configuration file. It can have one of these values:

v SRAM.

v ASCII.

Config
Modified at

The date and time the configuration was last changed.

Config length The amount of memory (in bytes) used in the NwDM database for storing
the configuration Load image. If the Load image is not stored in the NwDM
database (it may reside on a TFTP server for example), the value of this
property is 0

Load image The name of the load image.

Image
version

The software version corresponding to the load image.

Image
release

The software release corresponding to the load image.

Image PTF The PTF corresponding to the load image.

Config Date The date the configuration was added to the database.

Image Date The date the load image was added to the database.

Configuration Comparison Operators
Over time the number of configuration records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only configuration records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Configuration filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each configuration as a separate row. To select
a configuration, click anywhere in the row, which highlights the row. Use one of
these methods to select multiple configurations:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the configuration is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.
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You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected
configurations. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all configurations listed in the Filtered List task pane.

Unselect All Deselects all selected configurations listed in the Filtered List
task pane.

Select active Selects all active configurations listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected configurations to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

For example, these columns are hidden by default in the Configurations
Filtered List task pane:

v Approval status

v Commit status

v Flash (MB)

v DRAM (MB)

v Remarks

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected job records.
From the Print dialog, verify the print information is correct and click
Print .

Print Preview... Displays a preview of how the selected job records will print. Click Close
to return to the Jobs List task pane.
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Clicking... Performs this action...

Clone
selected...

Makes a new copy of selected configurations so you can create new
configurations without having to reenter each of the fields. When you
click Clone selected... , the Confirm Configuration Cloning dialog is
displayed. Click Yes to continue.

The cloned configuration contains the same configuration properties as
the original configuration with these exceptions:

v Version status. If you clone an active configuration, the cloned
configuration will have a status of inactive. Otherwise, the cloned
configuration will have the same status as the original configuration.

v Approval status. The Approval status of a cloned configuration is set to
Unapproved.

v Commit status. The Commit status is set to Uncommitted.

v Modified by. The Modified by property is set to the current user ID.

v Modified at. The Modified at property is set to the current date and
time.

Approve
selected...

Sets the Approval status property to Approved. When the Confirm
Approve Configurations dialog is displayed, click Yes to approve selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Reject
selected...

Sets the Approval status property to Rejected. When the Confirm Reject
Configurations dialog is displayed, click Yes to reject selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Commit
selected...

Sets the Commit status to Committed. When the Confirm Configuration
Commit dialog is displayed, click Yes to commit the configuration.

Committed configurations are locked; they cannot be modified. You can
only commit a configuration with a status of active or inactive.

Modify
selected...

Displays the Modify Properties dialog, which you can use to modify
properties for configurations.

Delete
selected...

Deletes the configuration from the NwDM database. When the Confirm
Configuration Delete dialog is displayed, click Yes to delete selected
configurations.
Note: If a device has no configurations listed in the NwDM database, the
device is also deleted from the database.

Learn
selected...

Displays the Learn 2212 Configuration task panel, which you can use to
create active configurations based on configuration currently loaded in
the device. See “Learn 2212 Configurations” on page 115 for more
information about the Learn 2212 Configuration Dialog.

Upgrade
selected...

Displays the Upgrade 2212 Configuration dialog, which you can use to
create upgraded configurations in the NwDM database. See “Upgrade
2212 Configurations” on page 117 for information about the Upgrade
2212 Configuration dialog.

Import
selected...

Displays the Import 2212 Configuration dialog, which you can use to
import configurations into the NwDM database. See “Import 2212
Configurations” on page 119 for information about importing
configurations.
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Clicking... Performs this action...

Export
selected...

Displays the Export 2212 Configuration dialog, which you can use to
export configurations from the NwDM database. See “Export 2212
Configurations” on page 122 for information about exporting
configurations.

Update
selected...

Displays the Update 2212 Configuration dialog, which you can use to
load the active configuration from the NwDM database into a device. See
“Update 2212 Configuration” on page 135 for information about updating
configurations.

Audit selected... Displays the Audit 2212 Configuration dialog, which you can use to audit
2212 configurations to ensure the configuration version with a status of
Active in the NwDM database matches the configuration actually loaded
in the device.

View audit
records of
selected...

Displays the View 2212 Audit Records dialog, which you can use to view
audit records for a device.

View latest
audit records of
selected...

Displays the View Latest 2212 Audit Records dialog, which you can use
to view the latest audit records for a device.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of Configuration records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of Configuration records with a version status of active for the
Filtered List pane that. Next, you would select any or all of those records and click
Add selected to custom list to add them to the Custom List pane. Then, you
would apply a filter to generate a list of Configuration records with an approval
status of Approved. Again, select any or all of these records and apply them to the
custom list. The result is a custom list based on the results of different filters.
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Learn 2212 Configurations
Use the 2212 Learn Configurations task panel to discover the current state of a
2212 and to set a configuration version for the device that reflects that state. You
can also choose to upload the load image for this configuration into the Nways
Deployment Manager database if it does not already exist.

The 2212 Learn Configurations task is a scheduled job. If it completes successfully,
any previously active configuration defined for this device becomes inactive, and the
learned configuration becomes the active configuration for the device.

Use one of these methods to display the 2212 Learn Configurations task panel:

v Click Learn configurations from the 2212 folder of the navigation tree.

v Select a configuration from the Filtered List or Custom List of the Configurations
task panel, click Process selected... , and then click Learn selected... . See
“2212 Configurations” on page 109 for more information about the 2212
Configurations task panel.

The 2212 Learn Configurations task panel is divided into these panes:

v Options

v Candidates

After updating the information on the 2212 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2212 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to schedule when the learn task will occur.

This field... Is used to... It can contain...

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)
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This field... Is used to... It can contain...

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v hh is the hour of the day
(1-24)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2212 Learn Configuration
task should begin immediately (when you
click Apply).

A check mark if the box is
selected.

Upload load
image if needed

Specify that a copy of the load image in
the 2212 should be uploaded to the
NwDM database.

A check mark if the box is
selected.

Candidates Pane
The Candidates pane displays a list of 2212 devices for which the Learn
Configurations task can be performed. The list of 2212 devices displayed depends
on how you arrived at the 2212 Learn Configurations task panel:

v If you selected Learn Configurations from the 2212 folder of the navigation tree,
the list of 2212 devices will include all 2212 devices for which the current
configuration version number in the Nways Deployment Manager database is 0.

v If you selected Learn Selected... from the Filtered List pane or Custom List pane
of the Configurations panel, the list of 2212 devices will include all 2212 devices
selected on that pane.

Candidates Action Buttons
Use the Candidates action button to perform actions from the Candidates pane.
These action buttons are displayed for the Candidates pane:

Clicking this button... Performs this action...

Set all Selects all candidates listed in the Candidates pane.

Reset all Deselects all candidates listed in the Candidates pane.
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Upgrade 2212 Configurations
Use the Upgrade 2212 Configurations dialog to create an upgraded configuration
file for either a new or existing configuration. The upgraded configuration is added
only to the NwDM database. To actually load the upgraded configuration in a
device, you must perform an Update 2212 configuration task.

To display the Upgrade 2212 Configurations dialog, select a configuration from the
Filter List pane or the Custom List pane of the 2212 Configurations task panel, click
Process selected... , and then click Upgrade selected... .

Fill in these fields for the Upgrade 2212 Configurations dialog:

This field... Is used to... It can contain...

Start now Specify that the Upgrade 2212
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Create new
version

Specify whether NwDM is to create a
new configuration version on which to
perform the upgrade.

If you are upgrading an active
configuration, you must click this box.

A check mark if the box is
selected.

Use selected
load image

Specify the load image that is to be used
for the upgraded configuration.

A dot if the radio button is
selected.
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This field... Is used to... It can contain...

Image name Specify the name of the load image to
use for the upgraded configuration.

If you do not know the image name, you
can click Select image to display the
Select Image dialog. See xxx for
information about the Select Image
dialog.

A valid path name and load
image name.

Use latest load
image matching
version/release

Specify that the latest load image that
matches the Version number and
Release number should be used.

A dot if the radio button is
selected.

Version Specify the version number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image version.

Release Specify the release number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image
release.

Use these action buttons from the Upgrade 2212 Configurations dialog:

Clicking this button... Performs this action...

Submit Schedules the Upgrade 2212 Configurations task as a job.

Cancel Exits the Upgrade 2212 Configurations dialog without
scheduling the task as a job.

Help Displays help for the Upgrade 2212 Configurations dialog.
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Import 2212 Configurations
The Import 2212 Configuration dialog allows you to import a configuration file into
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Import 2212 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2212
Configurations panel, click Process selected... , and then click Import selected... .

The Import 2212 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to import the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Import from Server File Import the configuration from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the configuration from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the configuration from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the configuration file.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the configuration file.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID.

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the FTP tab to specify information about the file name to be used for importing
the configuration and the directory where the configuration file is currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are importing only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are importing more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The imported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the configuration file
is located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the import
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a naming convention).

After entering information for the FTP tab, click Next to display the Misc tab or
Back to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be imported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Source format The format currently used for the source
configuration file.

ASCII

SRAM

Target format
for database

The format to be used when storing the
configuration file in the NwDM database.

SRAM

Version The software version to which this
configuration file applies.

A valid version number.

Release The software release to which this
configuration file applies.

A valid release number.

After entering information for the FTP tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the configuration file.

Click Import to begin importing the configuration file. The Import Configuration task
is an interactive task. The current status of the import task is displayed in the
Message window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2212 Configurations
The Export 2212 Configurations dialog allows you to export a configuration file from
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Export 2212 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2212
Configurations panel, click Process selected... , and then click Export selected... .

The Export 2212 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to export the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the configuration to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the configuration to a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Export the configuration to an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the configuration file will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported
configuration file will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the configuration file will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
will be exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the file name to be used for exporting
the configuration file and the directory where the configuration file will be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are exporting only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are exporting more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The exported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the exported
configuration file will be located. Use a
forward slash (/) to separate directories
and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a file naming
convention).

After entering information for the File tab, click Next to display the Misc tab or Back
to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be exported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Target format The format currently used for the
exported configuration file.

If you choose to export the file in a format
that differs from the current format of the
file as it is stored in the NwDM database,
NwDM uses the GUI Configuration Tool
to convert the file to the requested
format.

ASCII

SRAM

Version The software version to which the
exported configuration file applies.

A valid version number.

Release The software release to which the
exported configuration file applies.

A valid release number.

After entering information for the Misc tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin exporting the configuration file.
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Click Export to begin exporting the configuration file. The Export Configuration task
is an interactive task. The current status of the export task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.

Chapter 5. Understanding 2212 Task Panels and Dialogs 125



2212 Load Images
Load images contain the operational code that runs in a 2212. Information about
specific load images is initially loaded into the NwDM database when you update
software inventory for the 2212 (you also have the option of loading the actual Load
Image into the database at that time). These load images correspond to the
operational code releases of the 2212 software.

Use the Load Images task panel to manage 2212 load images. To display the 2212
Load Images task panel, click Load images from the 2212 folder of the navigation
tree.

The Load Images task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Load Images task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
load images. The Filter pane contains these columns:

v Properties. The Properties column is a list of load image properties on which you
can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the load
images found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Load Image Filter List Properties
You can search on these load image properties:

This
property...

Is used to describe...

Name The name of the load image.

Version The software version to which this load image applies.

Release The software release to which this load image applies.

PTF The program temporary fix (PTF) to which this load image applies.

Modified at Date and time this load image was added to the database.

Download
URL

The URL where the load image can be found.

Information
URL

The URL where information about this load image can be found.

Image length The number of bytes in the NwDM database taken up by this load image. If
the load image is not stored in the database, this value is 0.

Build name An identifier used by NwDM to identify this load image.
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Configuration Comparison Operators
Over time the number of load image records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only load image records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Load images filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each load image as a separate row. To select a
load image, click anywhere in the row, which highlights the row. Use one of these
methods to select multiple load images:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the load image is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected load
images. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all load images listed in the Filtered List task pane.

Unselect All Deselects all selected load images listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected load images to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.
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Clicking... Performs this action...

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected load image
records. From the Print dialog, verify the print information is correct and
click Print .

Print Preview... Displays a preview of how the selected load image records will print.
Click Close to return to the Jobs List task pane.

Delete selected
image files...

Deletes selected load images from the NwDM database. When the
Confirm Load Image File Delete dialog is displayed, click Yes to delete
the load image.

Import selected
image files...

Displays the Import 2212 Load Images dialog, which you can use to
import a load image into the NwDM database. See “Import 2212 Load
Images” on page 129 for information about importing a load image.

Export selected
image files...

Displays the Export 2212 Load Images dialog, which you can use to
export a load image from the NwDM database. See “Export 2212 Load
Images” on page 132 for information about exporting a load image.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of load image records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of load image records with a length of 0 for the Filtered List
pane that. Next, you would select any or all of those records and click Add
selected to custom list to add them to the Custom List pane. Then, you would
apply a filter to generate a list of load image records that apply to MRS Version 3.
Again, select any or all of these records and apply them to the custom list. The
result is a custom list based on the results of different filters.
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Import 2212 Load Images
The Import 2212 Load Images dialog allows you to import a load image into the
NwDM database. To display the Import 2212 Load Images dialog, select one or
more load images from either the Filtered List task pane or the Custom List task
pane of the 2212 Load Images task panel, click Process selected... , and then click
Import selected image files... .

The Import 2212 Load Images dialog contains these tabs:

v Method

v TFTP

v Download URL

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Use specified download
URL

Import the load image from an FTP server. You can use this
option to import the load image from an IBM web site. When
you click Next , the Download URL tab is displayed.

Import from Server File Import the load image from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the load image from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the load image from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the load image.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

Download URL Tab
Use the Download URL tab to provide the URL information for importing the load
image.

Enter this information on the Download URL tab:

This field... Is used to specify... It can contain...

Override
download URL
host with

The download host to use. If you choose
IBM-North America or IBM-Europe, the
FTP tab is updated to with the
appropriate information.

No override - use download
URL host

IBM-North America

IBM-Europe

Other FTP Host

After entering information for the Download URL tab, click Next to display the FTP
tab or Back to return to the previous tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the load image.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.
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File Tab
Use the File tab to specify information about the directory where the load image is
currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the load image is
located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Host Directory, or FTP Host
Directory, depending on the import
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the load image.

Click Import to begin importing the load image. The Import Load Images task is an
interactive task. The current status of the import task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2212 Load Images
The Export 2212 Load Images dialog allows you to export a load image from the
NwDM database.

To display the Export 2212 Load Images, select one or more load images from
either the Filtered List task pane or the Custom List task pane of the 2212 Load
Images panel, click Process selected... , and then click Export selected image
files... .

The Export 2212 Load Images dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the load image to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the load image to a TFTP server. When you click Next ,
the TFTP tab is displayed.

Use FTP Export the load image to an FTP server. When you click Next ,
the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the load image will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported load
image will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the load image will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image will be
exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the File tab to specify information about the directory where the load image will
be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the exported load
image will be located. Use a forward
slash (/) to separate directories and
subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Chapter 5. Understanding 2212 Task Panels and Dialogs 133



Results Tab
Use the Results tab to begin exporting the load image.

Click Export to begin exporting the load image. The Export Load Image task is an
interactive task. The current status of the export task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Update 2212 Configuration
When you update a 2212 configuration, you are changing the configuration that is
currently loaded in a 2212 (the active configuration) to another configuration that
you select. The configuration that you select must have a configuration status of
inactive. Configuration updates are scheduled as jobs (you can use the Managing
Jobs panel to view the status of an update job.

After updating the information on the 2212 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2212 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to specify this information about the update task:

This field... Is used to... It can contain...

Earliest start Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2212 Update
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.
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This field... Is used to... It can contain...

Reload Option Determine when the 2212 device is to be
restarted after the configuration has been
applied. These options are available:

v No Reload. The 2212 device is not
restarted. However, the new
configuration will not take effect in the
2212 until a reload is performed.

v Reload immediately. Restart the 2212
to load the new configuration
immediately after NwDM downloads it
to the 2212.

v Timed load. Restart the 2212 to load
the new configuration at the time
specified in the Timed Load field.

No reload

Reload immediately

Timed load

Timed load Specify the date and time that the reload
should begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Bank Option Specify how configurations currently
loaded into the IBD should be handled.
These options are available:

v Erase none. Do not erase any
configurations that are currently in the
IBD.

v Erase available if needed. Erase any
available configurations that are
currently in the IBD, if necessary.

v Erase any. Erase any configurations
that are currently in the IBD.

Erase none

Erase available if needed

Erase any

Configuration
file checking

Determines whether or not mismatches
are allowed when the device
configuration file is checked with the
configuration file in the NwDM database.

Disallow mismatches

Allow mismatches
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This field... Is used to... It can contain...

Stop at state Specify when processing for this update
job will stop. These options are available:

v None. Do not stop processing.

v Next state. Stop processing when the
current state is complete.

v Init. The initial phase.

v Prepare.The Prepare phase. During
the Prepare phase, NwDM performs
these actions:

– Loads the code and configuration
on the TFTP server.

– Deactivates timed load.

– Erases IDB banks (based on option
in Erase IBD property).

– Downloads the code and
configuration as needed.

– Modifies the status of the ″from″
configuration loaded in the NwDM
database to Obsolescent and the
″to″ configuration to Nascent.

v Perform. The Perform phase. During
the Perform phase, NwDM performs
these actions:

– Verifies the contents of the IBD.

– Verifies the 2212 boot entries.

– Reloads or restarts the device.

v Verify. The Verify phase. During the
Verify phase, NwDM performs these
actions:

– Verifies the PROM image, the load
image, and the configuration.

– Modifies the status of the
configuration loaded in the NwDM
database to either Inactive or
Active.

None

Next state

Init

Prepare

Perform

Verify
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Chapter 6. Understanding 2216 Task Panels and Dialogs

This chapter describes each of the task panels and dialogs provided with Nways
Deployment Manager for managing 2216 configurations. For each task panel or
dialog, this chapter provides:

v Description of the task panel or dialog

v Table listing each field, the purpose of the field, and valid values.

v Description of the available pop-up menu selections.

v Description of the available action buttons.
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Create 2216 Device
Use the 2216 Create Device task panel to create a 2216 in the Deployment
Manager database. After creating the device, you will typically perform a 2216
Learn Configuration task to update the database with information about the device
configuration.

To display the 2216 Create Device task panel, click Create device from the 2216
folder of the navigation tree.

After updating the information in the 2216 Create Device task panel, click Apply to
start the job. Deployment Manager creates a device in the database based on the
information you entered in the Main pane. In addition, an initial configuration is
created for the device (version 0) and set to a status of Incomplete. Schedule a
2216 Learn Configuration task to create an Active configuration version based on
the 2216 device.

You can display the help panel for this task panel by clicking Help .

Main Pane
Use the Main pane to specify information about the device to be created.

This field... Is used to... It can contain...

Device Name Specify the name of this device in the
NwDM database.

Up to 254 characters
denoting the device name.

NwDM does not check to
make sure that the device
name is unique, which
means that you can have
multiple devices with the
same device name.

IP Address The IP address for this device. A valid IP address or host
name.

Operator ID The operator ID used for accessing this
device, if the device has been configured
for login protection.

A valid operator ID.

Password The password that corresponds to the
operator ID.

A valid password.

SNMP read
community
name

The SNMP read community to which this
device belongs.

The SNMP read community
name. The default is public.

SNMP write
community
name

The SNMP write community to which this
device belongs.

The SNMP write community
name.

TFTP Server IP
Address

The IP address of an TFTP server to
which this device can communicate.

A valid IP address of a TFTP
server.
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2216 Configurations
The 2216 Configurations task panel provides a way to manage device
configurations.You can store multiple configurations for a 2216 device. Each
configuration has a unique version associated with it and a configuration version
status, which can be one of these values:

v Active . The active configuration is the configuration that is currently loaded in,
and operational for, the 2216 device.

v Inactive . An inactive configuration is a configuration that can be loaded into the
2216 device. It contains all the components (load image and configuration file)
necessary to become the active configuration.

v Incomplete . An incomplete configuration is one that contains only a portion of
the components necessary to become an active configuration. It cannot be
loaded into a 2216 device.

Note: There are actually two additional states for a configuration. A configuration
can be in the state of nascent , which means the configuration is in the
process of becoming the active configuration, or the state of obsolescent ,
which means the configuration is in the process of becoming an inactive
configuration.

To display the 2216 Configuration task panel, click Configurations from the 2216
folder of the navigation tree.

The Configurations task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Configurations task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
configurations. The Filter pane contains these columns:

v Properties. The Properties column is a list of configuration properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the
Configurations found in the database using the comparison operator you
specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.
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Configuration Filter List Properties
You can search on these job properties:

This
property...

Is used to describe...

Device ID The identifier of the device. NwDM creates the Device ID when the device
is added to the NwDM database (using either the 2216 Create Device task
or Synchronize Databases task).

Device Name The name of the device. You specified the device name when you added
the device to the NwDM database using the 2216 Create Device task.

Model The model number of the 2216.

Version The configuration version. NwDM can maintain multiple version of a
configuration. Different configuration versions for a device are numbered
sequentially beginning with 0.

Address The IP address or host name for the device.

Version
status

The status of the configuration version. Version status can be one of these
values:

v Active . The active configuration is the configuration considered by
NwDM to be actually loaded in the 2216.

v Inactive . An inactive configuration is a configuration that can be loaded
into the 2216 device. It contains all of the components (load image,
PROM image, and updated configuration file) necessary to become an
active configuration.

v Incomplete . An incomplete configuration is one that contains only a
portion of the components necessary to become an active configuration.
It cannot be loaded into a 2216 device.

v Nascent . A nascent configuration is a configuration that is in the process
of moving from an inactive status to an active status.

v Obsolescent . An obsolescent configuration is a configuration that is in
the process of moving from an active status to an inactive status.

Approval
status

The approval status of the configuration version. Approval status can be
one of these values:

v Approved .

v Unapproved .

v Rejected .

Commit
status

The commit status of the configuration version. Approval status can be one
of these values:

v Committed . When the configuration version has been committed, the
configuration is locked (no changes can be made to the configuration).

v Uncommitted . When the configuration version is uncommitted, changes
can be made to the configuration.

Remarks Text data that has been entered for this configuration.

Modified by The user ID of the person who last changed the configuration. For new
configurations, the Modified by property contains the user ID of the person
who created the configuration.

Modified at Date and time this configuration was added to the database.

SNMP read
community
name

The SNMP read community to which the device belongs.

SNMP write
community
name

The SNMP write community to which the device belongs.
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This
property...

Is used to describe...

Operator ID The operator ID used to access the device if it has been configured for
login protection.

Operator
password

The password associated with the operator ID.

TFTP server The IP address or host name of the TFTP server that can communicate
with the 2216.

Config
format

The format used for the configuration file. It can have one of these values:

v SRAM.

v ASCII.

Config
Modified at

The date and time the configuration was last changed.

Config length The amount of memory (in bytes) used in the NwDM database for storing
the configuration Load image. If the Load image is not stored in the NwDM
database (it may reside on a TFTP server for example), the value of this
property is 0

Load image The name of the load image.

Image
version

The software version corresponding to the load image.

Image
release

The software release corresponding to the load image.

Image PTF The PTF corresponding to the load image.

Config
Format Date

The date the configuration was added to the database.

Load Image
Date

The date the load image was added to the database.

Configuration Comparison Operators
Over time the number of configuration records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only configuration records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Configuration filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each configuration as a separate row. To select
a configuration, click anywhere in the row, which highlights the row. Use one of
these methods to select multiple configurations:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the configuration is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

Chapter 6. Understanding 2216 Task Panels and Dialogs 143



You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected
configurations. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all configurations listed in the Filtered List task pane.

Unselect All Deselects all selected configurations listed in the Filtered List
task pane.

Select active Selects all active configurations listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected configurations to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

For example, these columns are hidden by default in the Configurations
Filtered List task pane:

v Approval status

v Commit status

v Flash (MB)

v DRAM (MB)

v Remarks

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected job records.
From the Print dialog, verify the print information is correct and click
Print .

Print Preview... Displays a preview of how the selected job records will print. Click Close
to return to the Jobs List task pane.
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Clicking... Performs this action...

Clone
selected...

Makes a new copy of selected configurations so you can create new
configurations without having to reenter each of the fields. When you
click Clone selected... , the Confirm Configuration Cloning dialog is
displayed. Click Yes to continue.

The cloned configuration contains the same configuration properties as
the original configuration with these exceptions:

v Version status. If you clone an active configuration, the cloned
configuration will have a status of inactive. Otherwise, the cloned
configuration will have the same status as the original configuration.

v Approval status. The Approval status of a cloned configuration is set to
Unapproved.

v Commit status. The Commit status is set to Uncommitted.

v Modified by. The Modified by property is set to the current user ID.

v Modified at. The Modified at property is set to the current date and
time.

Approve
selected...

Sets the Approval status property to Approved. When the Confirm
Approve Configurations dialog is displayed, click Yes to approve selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Reject
selected...

Sets the Approval status property to Rejected. When the Confirm Reject
Configurations dialog is displayed, click Yes to reject selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Commit
selected...

Sets the Commit status to Committed. When the Confirm Configuration
Commit dialog is displayed, click Yes to commit the configuration.

Committed configurations are locked; they cannot be modified. You can
only commit a configuration that has a status of active or inactive.

Modify
selected...

Displays the Modify Properties dialog, which you can use to modify
properties for configurations.

Delete
selected...

Deletes the configuration from the NwDM database. When the Confirm
Configuration Delete dialog is displayed, click Yes to delete selected
configurations.
Note: If a device has no configurations listed in the NwDM database, the
device is also deleted from the database.

Learn
selected...

Displays the Learn 2216 Configuration task panel, which you can use to
create active configurations based on configuration currently loaded in
the device. See “Learn 2216 Configurations” on page 147 for more
information about the Learn 2216 Configuration Dialog.

Upgrade
selected...

Displays the Upgrade 2216 Configuration dialog, which you can use to
create upgraded configurations in the NwDM database. See “Upgrade
2216 Configurations” on page 149 for information about the Upgrade
2216 Configuration dialog.

Import
selected...

Displays the Import 2216 Configuration dialog, which you can use to
import configurations into the NwDM database. See “Import 2216
Configurations” on page 151 for information about importing
configurations.
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Clicking... Performs this action...

Export
selected...

Displays the Export 2216 Configuration dialog, which you can use to
export configurations from the NwDM database. See “Export 2216
Configurations” on page 154 for information about exporting
configurations.

Update
selected...

Displays the Update 2216 Configuration dialog, which you can use to
load the active configuration from the NwDM database into a device. See
“Update 2216 Configuration” on page 167 for information about updating
configurations.

Audit selected... Displays the Audit 2216 Configuration dialog, which you can use to audit
2216 configurations to ensure the configuration version with a status of
Active in the NwDM database matches the configuration actually loaded
in the device.

View audit
records of
selected...

Displays the View 2216 Audit Records dialog, which you can use to view
audit records for a device.

View latest
audit records of
selected...

Displays the View Latest 2216 Audit Records dialog, which you can use
to view the latest audit records for a device.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of Configuration records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of Configuration records with a version status of active for the
Filtered List pane that. Next, you would select any or all of those records and click
Add selected to custom list to add them to the Custom List pane. Then, you
would apply a filter to generate a list of Configuration records with an approval
status of Approved. Again, select any or all of these records and apply them to the
custom list. The result is a custom list based on the results of different filters.
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Learn 2216 Configurations
Use the 2216 Learn Configurations task panel to discover the current state of a
2216 and to set a configuration version for the device that reflects that state. You
can also choose to upload the load image for this configuration into the Nways
Deployment Manager database if it does not already exist.

The 2216 Learn Configurations task is a scheduled job. If it completes successfully,
any previously active configuration defined for this device becomes inactive, and the
learned configuration becomes the active configuration for the device.

Use one of these methods to display the 2216 Learn Configurations task panel:

v Click Learn configurations from the 2216 folder of the navigation tree.

v Select a configuration from the Filtered List or Custom List of the Configurations
task panel, click Process selected... , and then click Learn selected... . See
“2216 Configurations” on page 141 for more information about the 2216
Configurations task panel.

The 2216 Learn Configurations task panel is divided into these panes:

v Options

v Candidates

After updating the information on the 2216 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2216 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to schedule when the learn task will occur.

This field... Is used to... It can contain...

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Chapter 6. Understanding 2216 Task Panels and Dialogs 147



This field... Is used to... It can contain...

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v hh is the hour of the day
(1-24)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2216 Learn Configuration
task should begin immediately (when you
click Apply).

A check mark if the box is
selected.

Upload load
image if needed

Specify that a copy of the load image in
the 2216 should be uploaded to the
NwDM database.

A check mark if the box is
selected.

Candidates Pane
The Candidates pane displays a list of 2216 devices for which the Learn
Configurations task can be performed. The list of 2216 devices displayed depends
on how you arrived at the 2216 Learn Configurations task panel:

v If you selected Learn Configurations from the 2216 folder of the navigation tree,
the list of 2216 devices will include all 2216 devices for which the current
configuration version number in the Nways Deployment Manager database is 0.

v If you selected Learn Selected... from the Filtered List pane or Custom List pane
of the Configurations panel, the list of 2216 devices will include all 2216 devices
selected on that pane.

Candidates Action Buttons
Use the Candidates action button to perform actions from the Candidates pane.
These action buttons are displayed for the Candidates pane:

Clicking this button... Performs this action...

Set all Selects all candidates listed in the Candidates pane.

Reset all Deselects all candidates listed in the Candidates pane.
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Upgrade 2216 Configurations
Use the Upgrade 2216 Configurations dialog to create an upgraded configuration
file for either a new or existing configuration. The upgraded configuration is added
only to the NwDM database. To actually load the upgraded configuration in a
device, you must perform an Update 2216 configuration task.

To display the Upgrade 2216 Configurations dialog, select a configuration from the
Filter List pane or the Custom List pane of the 2216 Configurations task panel, click
Process selected... , and then click Upgrade selected... .

Fill in these fields for the Upgrade 2216 Configurations dialog:

This field... Is used to... It can contain...

Start now Specify that the Upgrade 2216
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Create new
version

Specify whether NwDM is to create a
new configuration version on which to
perform the upgrade.

If you are upgrading an active
configuration, you must click this box.

A check mark if the box is
selected.

Use selected
load image

Specify the load image that is to be used
for the upgraded configuration.

A dot if the radio button is
selected.
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This field... Is used to... It can contain...

Image name Specify the name of the load image to
use for the upgraded configuration.

If you do not know the image name, you
can click Select image to display the
Select Image dialog.

A valid path name and load
image name.

Use latest load
image matching
version/release

Specify that the latest load image that
matches the Version number and
Release number should be used.

A dot if the radio button is
selected.

Version Specify the version number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image version.

Release Specify the release number of the load
image to use for the upgraded
configuration.

A number that corresponds
to a valid load image
release.

Use these action buttons from the Upgrade 2216 Configurations dialog:

Clicking this button... Performs this action...

Submit Schedules the Upgrade 2216 Configurations task as a job.

Cancel Exits the Upgrade 2216 Configurations dialog without
scheduling the task as a job.

Help Displays help for the Upgrade 2216 Configurations dialog.
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Import 2216 Configurations
The Import 2216 Configuration dialog allows you to import a configuration file into
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Import 2216 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2216
Configurations panel, click Process selected... , and then click Import selected... .

The Import 2216 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to import the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Import from Server File Import the configuration from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the configuration from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the configuration from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the configuration file.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the configuration file.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID.

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the FTP tab to specify information about the file name to be used for importing
the configuration and the directory where the configuration file is currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are importing only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are importing more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The imported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the configuration file
is located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the import
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a naming convention).

After entering information for the FTP tab, click Next to display the Misc tab or
Back to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be imported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Source format The format currently used for the source
configuration file.

ASCII

SRAM

Target format
for database

The format to be used when storing the
configuration file in the NwDM database.

SRAM

Version The software version to which this
configuration file applies.

A valid version number.

Release The software release to which this
configuration file applies.

A valid release number.

After entering information for the FTP tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the configuration file.

Click Import to begin importing the configuration file. The Import Configuration task
is an interactive task. The current status of the import task is displayed in the
Message window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2216 Configurations
The Export 2216 Configurations dialog allows you to export a configuration file from
the NwDM database. For example, if you need to make changes to a configuration
that requires the configuration tool, you would typically export the configuration,
modify the configuration with the configuration tool, and import the modified version.

To display the Export 2216 Configurations dialog, select one or more configurations
from either the Filtered List task pane or the Custom List task pane of the 2216
Configurations panel, click Process selected... , and then click Export selected... .

The Export 2216 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Misc

v Results

Method Tab
Use the Method tab to specify how you want to export the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the configuration to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the configuration to a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Export the configuration to an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the configuration file will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported
configuration file will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the configuration file will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
will be exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the file name to be used for exporting
the configuration file and the directory where the configuration file will be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are exporting only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are exporting more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The exported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the exported
configuration file will be located. Use a
forward slash (/) to separate directories
and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a file naming
convention).

After entering information for the File tab, click Next to display the Misc tab or Back
to return to the previous tab.

Misc Tab
Use the Misc tab to provide additional information about the file to be exported.

Enter this information on the Misc tab:

This field... Is used to specify... It can contain...

Target format The format currently used for the
exported configuration file.

If you choose to export the file in a format
that differs from the current format of the
file as it is stored in the NwDM database,
NwDM uses the GUI Configuration Tool
to convert the file to the requested
format.

ASCII

SRAM

Version The software version to which the
exported configuration file applies.

A valid version number.

Release The software release to which the
exported configuration file applies.

A valid release number.

After entering information for the Misc tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin exporting the configuration file.
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Click Export to begin exporting the configuration file. The Export Configuration task
is an interactive task. The current status of the export task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.
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2216 Load Images
Load images contain the operational code that runs in a 2216. Information about
specific load images is initially loaded into the NwDM database when you update
software inventory for the 2216 (you also have the option of loading the actual Load
Image into the database at that time). These load images correspond to the
operational code releases of the 2216 software.

Use the Load Images task panel to manage 2216 load images. To display the 2216
Load Images task panel, click Load images from the 2216 folder of the navigation
tree.

The Load Images task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Load Images task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
load images. The Filter pane contains these columns:

v Properties. The Properties column is a list of load image properties on which you
can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the load
images found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Load Image Filter List Properties
You can search on these load image properties:

This
property...

Is used to describe...

Name The name of the load image.

Version The software version to which this load image applies.

Release The software release to which this load image applies.

PTF The program temporary fix (PTF) to which this load image applies.

Modified at Date and time this load image was added to the database.

Download
URL

The URL where the load image can be found.

Information
URL

The URL where information about this load image can be found.

Image length The number of bytes in the NwDM database taken up by this load image. If
the load image is not stored in the database, this value is 0.

Build name An identifier used by NwDM to identify this load image.
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Configuration Comparison Operators
Over time the number of load image records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only load image records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Load images filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each load image as a separate row. To select a
load image, click anywhere in the row, which highlights the row. Use one of these
methods to select multiple load images:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the load image is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected load
images. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all load images listed in the Filtered List task pane.

Unselect All Deselects all selected load images listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected load images to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click the
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.
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Clicking... Performs this action...

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected load image
records. From the Print dialog, verify the print information is correct and
click Print .

Print Preview... Displays a preview of how the selected load image records will print.
Click Close to return to the Jobs List task pane.

Delete selected
Image files...

Deletes selected load images from the NwDM database. When the
Confirm Load Image File Delete dialog is displayed, click Yes to delete
the load image.

Import selected
Image files...

Displays the Import 2216 Load Images dialog, which you can use to
import a load image into the NwDM database. See “Import 2216 Load
Images” on page 161 for information about importing a load image.

Export selected
Image files...

Displays the Export 2216 Load Images dialog, which you can use to
export a load image from the NwDM database. See “Export 2216 Load
Images” on page 164 for information about exporting a load image.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of load image records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of load image records with a length of 0 for the Filtered List
pane that. Next, you would select any or all of those records and click Add
selected to custom list to add them to the Custom List pane. Then, you would
apply a filter to generate a list of load image records that apply to MRS Version 3.
Again, select any or all of these records and apply them to the custom list. The
result is a custom list based on the results of different filters.
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Import 2216 Load Images
The Import 2216 Load Images dialog allows you to import a load image into the
NwDM database. To display the Import 2216 Load Images dialog, select one or
more load images from either the Filtered List task pane or the Custom List task
pane of the 2216 Load Images task panel, click Process selected... , and then click
Import selected image files... .

The Import 2216 Load Images dialog contains these tabs:

v Method

v TFTP

v Download URL

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Use specified download
URL

Import the load image from an FTP server. You can use this
option to import the load image from an IBM web site. When
you click Next , the Download URL tab is displayed.

Import from Server File Import the load image from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the load image from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the load image from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the load image.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

Download URL Tab
Use the Download URL tab to provide the URL information for importing the load
image.

Enter this information on the Download URL tab:

This field... Is used to specify... It can contain...

Override
download URL
host with

The download host to use. If you choose
IBM-North America or IBM-Europe, the
FTP tab is updated to with the
appropriate information.

No override - use download
URL host

IBM-North America

IBM-Europe

Other FTP Host

After entering information for the Download URL tab, click Next to display the FTP
tab or Back to return to the previous tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the load image.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.
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File Tab
Use the File tab to specify information about the directory where the load image is
currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the load image is
located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Host Directory, or FTP Host
Directory, depending on the import
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the load image.

Click Import to begin importing the load image. The Import Load Images task is an
interactive task. The current status of the import task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Export 2216 Load Images
The Export 2216 Load Images dialog allows you to export a load image from the
NwDM database.

To display the Export 2216 Load Images, select one or more load images from
either the Filtered List task pane or the Custom List task pane of the 2216 Load
Images panel, click Process selected... , and then click Export selected image
files... .

The Export 2216 Load Images dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the load image to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the load image to a TFTP server. When you click Next ,
the TFTP tab is displayed.

Use FTP Export the load image to an FTP server. When you click Next ,
the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the load image will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported load
image will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the load image will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image will be
exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the directory where the load image will
be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the exported load
image will be located. Use a forward
slash (/) to separate directories and
subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Chapter 6. Understanding 2216 Task Panels and Dialogs 165



Results Tab
Use the Results tab to begin exporting the load image.

Click Export to begin exporting the load image. The Export Load Image task is an
interactive task. The current status of the export task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Update 2216 Configuration
When you update a 2216 configuration, you are changing the configuration that is
currently loaded in a 2216 (the active configuration) to another configuration that
you select. The configuration that you select must have a configuration status of
inactive. Configuration updates are scheduled as jobs (you can use the Managing
Jobs panel to view the status of an update job.

After updating the information on the 2216 Learn Configurations task panel, click
Apply to save your changes or Cancel to discard all changes (the Cancel button is
displayed only if you displayed the 2216 Learn Configurations task panel from the
Configurations task panel). To display the help for this task panel, click Help .

Options Pane
Use the Options pane to specify this information about the update task:

This field... Is used to... It can contain...

Earliest start Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 2216 Update
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.
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This field... Is used to... It can contain...

Reload Option Determine when the 2216 device is to be
restarted after the configuration has been
applied. These options are available:

v No Reload. The 2216 device is not
restarted. However, the new
configuration will not take effect in the
2216 until a reload is performed.

v Reload immediately. Restart the 2216
to load the new configuration
immediately after NwDM downloads it
to the 2216.

v Timed load. Restart the 2216 to load
the new configuration at the time
specified in the Timed Load field.

No reload

Reload immediately

Timed load

Timed load Specify the date and time that the reload
should begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Bank Option Specify how configurations currently
loaded into the IBD should be handled.
These options are available:

v Erase none. Do not erase any
configurations that are currently in the
IBD.

v Erase available if needed. Erase any
available configurations that are
currently in the IBD, if necessary.

v Erase any. Erase any configurations
that are currently in the IBD.

Erase none

Erase available if needed

Erase any

Configuration
file checking

Determines whether or not mismatches
are allowed when the device
configuration file is checked with the
configuration file in the NwDM database.

Disallow mismatches

Allow mismatches
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This field... Is used to... It can contain...

Stop at state Specify when processing for this update
job will stop. These options are available:

v None. Do not stop processing.

v Next state. Stop processing when the
current state is complete.

v Init. The initial phase.

v Prepare.The Prepare phase. During
the Prepare phase, NwDM performs
these actions:

– Loads the code and configuration
on the TFTP server.

– Deactivates timed load.

– Erases IDB banks (based on option
in Erase IBD property).

– Downloads the code and
configuration as needed.

– Modifies the status of the ″from″
configuration loaded in the NwDM
database to Obsolescent and the
″to″ configuration to Nascent.

v Perform. The Perform phase. During
the Perform phase, NwDM performs
these actions:

– Verifies the contents of the IBD.

– Verifies the 2216 boot entries.

– Reloads or restarts the device.

v Verify. The Verify phase. During the
Verify phase, NwDM performs these
actions:

– Verifies the PROM image, the load
image, and the configuration.

– Modifies the status of the
configuration loaded in the NwDM
database to either Inactive or
Active.

None

Next state

Init

Prepare

Perform

Verify
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Chapter 7. Understanding 8275-416 Task Panels and Dialogs

This chapter describes each of the task panels and dialogs provided with Nways
Deployment Manager for managing 8275 Model 416 configurations. For each task
panel or dialog, this chapter provides:

v Screen capture showing the task panel or dialog

v Description of the task panel or dialog

v Table listing each field, the purpose of the field, and valid values.

v Description of the available pop-up menu selections.

v Description of the available action buttons.
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Create 8275-416 Device
Use the 8275-416 Create Device task panel to create a record for an 8275 Model
416 in the Deployment Manager database. After creating the device, you will
typically perform a Learn Configuration task to update the database with information
about the device configuration.

To display the 8275-416 Create Device task panel, click Create device from the
8275-416 folder of the navigation tree.

After updating the information in the 8275-416 Create Device task panel, click
Apply to start the job. Deployment Manager creates a device in the database
based on the information you entered in the Main pane. In addition, an initial
configuration is created for the device (version 0) and set to a status of Incomplete.
Schedule a 8275-416 Learn Configuration task to create an Active configuration
version based on the device.

You can display the help panel for this task panel by clicking Help .

Main Pane
Use the Main pane to specify information about the device to be created.

This field... Is used to... It can contain...

Device Name Specify the name of this device in the
NwDM database.

Up to 254 characters
denoting the device name.

NwDM does not check to
make sure that the device
name is unique, which
means that you can have
multiple devices with the
same device name.

IP Address The IP address for this device. A valid IP address or host
name.

Operator ID The operator ID used for accessing this
device, if the device has been configured
for login protection.

A valid operator ID.

Password The password that corresponds to the
operator ID.

A valid password.

SNMP read
community
name

The SNMP read community to which this
device belongs.

The SNMP read community
name. The default is public.

SNMP write
community
name

The SNMP write community to which this
device belongs.

The SNMP write community
name.

TFTP Server IP
Address

The IP address of an TFTP server to
which this device can communicate.

A valid IP address of a TFTP
server.

172 NwDM User’s Guide



8275-416 Configurations
The 8275-416 Configurations task panel provides a way to manage device
configurations. You can store multiple configurations for a 8275-416 device. Each
configuration has a unique version associated with it and a configuration version
status, which can be one of these values:

v Active . The active configuration is the configuration that is currently loaded in,
and operational for, the 8275-416 device.

v Inactive . An inactive configuration is a configuration that can be loaded into the
8275-416 device. It contains all the components (load image and configuration
file) necessary to become the active configuration.

v Incomplete . An incomplete configuration is one that contains only a portion of
the components necessary to become an active configuration. It cannot be
loaded into a 8275-416 device.

To display the 8275-416 Configuration task panel, click Configurations from the
8275-416 folder in the navigation tree.

The Configurations task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Configurations task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
configurations. The Filter pane contains these columns:

v Properties. The Properties column is a list of configuration properties on which
you can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the
Configurations found in the database using the comparison operator you
specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Configuration Filter List Properties
You can search on these job properties:

This
property...

Is used to describe...

Device ID The identifier of the device. NwDM creates the Device ID when the device
is added to the NwDM database (using either the 8275-416 Create Device
task or Synchronize Databases task).

Device Name The name of the device. You specified the device name when you added
the device to the NwDM database using the 8275-416 Create Device task.

Version The configuration version. NwDM can maintain multiple version of a
configuration. Different configuration versions for a device are numbered
sequentially beginning with 0.
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This
property...

Is used to describe...

Address The IP address or host name for the device.

Version
status

The status of the configuration version. Version status can be one of these
values:

v Active . The active configuration is the configuration considered by
NwDM to be actually loaded in the device.

v Inactive . An inactive configuration is a configuration that can be loaded
into the device. It contains all of the components (load image and
updated configuration file) necessary to become an active configuration.

v Incomplete . An incomplete configuration is one that contains only a
portion of the components necessary to become an active configuration.
It cannot be loaded into a device.

v Nascent . A nascent configuration is a configuration that is in the process
of moving from an inactive status to an active status.

v Obsolescent . An obsolescent configuration is a configuration that is in
the process of moving from an active status to an inactive status.

Approval
status

The approval status of the configuration version. Approval status can be
one of these values:

v Approved .

v Unapproved .

v Rejected .

Commit
status

The commit status of the configuration version. Approval status can be one
of these values:

v Committed . When the configuration version has been committed, the
configuration is locked (no changes can be made to the configuration).

v Uncommitted . When the configuration version is uncommitted, changes
can be made to the configuration.

Remarks Text data that has been entered for this configuration.

Modified by The user ID of the person who last changed the configuration. For new
configurations, the Modified by property contains the user ID of the person
who created the configuration.

Modified at Date and time this configuration was added to the database.

SNMP read
community
name

The SNMP read community to which the device belongs.

SNMP write
community
name

The SNMP write community to which the device belongs.

Config
Modified at

The date and time the configuration was last changed.

Config
Length

The amount of memory (in bytes) used in the NwDM database for storing
the configuration Load image. If the Load image is not stored in the NwDM
database (it may reside on a TFTP server for example), the value of this
property is 0

Load image The name of the load image.

Image
version

The software version corresponding to the load image.

Image
release

The software release corresponding to the load image.
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This
property...

Is used to describe...

Image
revision

The revision number corresponding to the load image.

Hardware
maintenance
level

The hardware maintenance level.

Network
address

The network address.

Box Serial
Number

The serial number of the 8275 Model 416.

Configuration Comparison Operators
Over time the number of configuration records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only configuration records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Configuration filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each configuration as a separate row. To select
a configuration, click anywhere in the row, which highlights the row. Use one of
these methods to select multiple configurations:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select. You
can also select multiple rows by pressing and holding the Shift key while clicking
the rows that you want to select.

Information about the configuration is displayed in each of the columns. To reorder
the columns, press the Shift keys, and then click on the header of the column you
want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected
configurations. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all configurations listed in the Filtered List task pane.

Unselect All Deselects all selected configurations listed in the Filtered List
task pane.

Select active Selects all active configurations listed in the Filtered List task
pane.
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Clicking this button... Performs this action...

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected configurations to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.

For example, these columns are hidden by default in the Configurations
Filtered List task pane:

v Approval status

v Commit status

v Flash (MB)

v DRAM (MB)

v Remarks

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected job records.
From the Print dialog, verify the print information is correct and click
Print .

Print Preview... Displays a preview of how the selected job records will print. Click Close
to return to the Jobs List task pane.

Clone
selected...

Makes a new copy of selected configurations so you can create new
configurations without having to reenter each of the fields. When you
click Clone selected... , the Confirm Configuration Cloning dialog is
displayed. Click Yes to continue.

The cloned configuration contains the same configuration properties as
the original configuration with these exceptions:

v Version status. If you clone an active configuration, the cloned
configuration will have a status of inactive. Otherwise, the cloned
configuration will have the same status as the original configuration.

v Approval status. The Approval status of a cloned configuration is set to
Unapproved.

v Commit status. The Commit status is set to Uncommitted.

v Modified by. The Modified by property is set to the current user ID.

v Modified at. The Modified at property is set to the current date and
time.
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Clicking... Performs this action...

Approve
selected...

Sets the Approval status property to Approved. When the Confirm
Approve Configurations dialog is displayed, click Yes to approve selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Reject
selected...

Sets the Approval status property to Rejected. When the Confirm Reject
Configurations dialog is displayed, click Yes to reject selected
configurations.

Deployment Manager does not use the Approval status property.
However, you can use it to implement your own approval process.

Commit
selected...

Sets the Commit status to Committed. When the Confirm Configuration
Commit dialog is displayed, click Yes to commit the configuration.

Committed configurations are locked; they cannot be modified. You can
only commit a configuration with a status of active or inactive.

Modify
selected...

Displays the Modify Properties dialog, which you can use to modify
properties for configurations.

Delete
selected...

Deletes the configuration from the NwDM database. When the Confirm
Configuration Delete dialog is displayed, click Yes to delete selected
configurations.
Note: If a device has no configurations listed in the NwDM database, the
device is also deleted from the database.

Learn
selected...

Displays the Learn 8275-416 Configuration task panel, which you can
use to create active configurations based on configuration currently
loaded in the device. See “Learn 8275-416 Configurations” on page 179
for more information about the Learn 8275-416 Configuration Dialog.

Import
selected...

Displays the Import 8275-416 Configuration dialog, which you can use to
import configurations into the NwDM database. See “Import 8275-416
Configurations” on page 181 for information about importing
configurations.

Export
selected...

Displays the Export 8275-416 Configuration dialog, which you can use to
export configurations from the NwDM database. See “Export 8275-416
Configurations” on page 184 for information about exporting
configurations.

Update
selected...

Displays the Update 8275-416 Configuration dialog, which you can use
to load the active configuration from the NwDM database into a device.
See “Update 8275-416 Configuration” on page 196 for information about
updating configurations.

Audit selected... Displays the Audit 8275-416 Configuration dialog, which you can use to
audit 8275-416 configurations to ensure the configuration version with a
status of Active in the NwDM database matches the configuration
actually loaded in the device.

View audit
records of
selected...

Displays the View 8275-416 Audit Records dialog, which you can use to
view audit records for a device.

View latest
audit records of
selected...

Displays the View Latest 8275-416 Audit Records dialog, which you can
use to view the latest audit records for a device.
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Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of Configuration records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of Configuration records with a version status of active for the
Filtered List pane that. Next, you would select any or all of those records and click
Add selected to custom list to add them to the Custom List pane. Then, you
would apply a filter to generate a list of Configuration records with an approval
status of Approved. Again, select any or all of these records and apply them to the
custom list. The result is a custom list based on the results of different filters.
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Learn 8275-416 Configurations
Use the 8275-416 Learn Configurations task panel to discover the current state of a
8275 Model 416 and to set a configuration version for the device that reflects that
state.

The 8275-416 Learn Configurations task is a scheduled job. If it completes
successfully, any previously active configuration defined for this device becomes
inactive, and the learned configuration becomes the active configuration for the
device.

Use one of these methods to display the 8275-416 Learn Configurations task panel:

v Click Learn configurations from the 8275-416 folder of the navigation tree.

v Select a configuration from the Filtered List or Custom List of the Configurations
task panel, click Process selected... , and then click Learn selected... . See
“8275-416 Configurations” on page 173 for more information about the 8275-416
Configurations task panel.

The 8275-416 Learn Configurations task panel is divided into these panes:

v Options

v Candidates

After updating the information on the 8275-416 Learn Configurations task panel,
click Apply to save your changes or Cancel to discard all changes (the Cancel
button is displayed only if you displayed the 8275-416 Learn Configurations task
panel from the Configurations task panel). To display the help for this task panel,
click Help .

Options Pane
Use the Options pane to schedule when the learn task will occur.

This field... Is used to... It can contain...

Earliest start
time

Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)
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This field... Is used to... It can contain...

Latest start time Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v hh is the hour of the day
(1-24)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 8275-416 Learn
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.

Upload load
image if needed

Specify that the name of the load image
in the 8275-416 should be uploaded to
the NwDM database.

A check mark if the box is
selected.

Candidates Pane
The Candidates pane displays a list of 8275-416 devices for which the Learn
Configurations task can be performed. The list of 8275-416 devices displayed
depends on how you arrived at the 8275-416 Learn Configurations task panel:

v If you selected Learn Configurations from the 8275-416 folder of the navigation
tree, the list of 8275-416 devices will include all 8275-416 devices for which the
current configuration version number in the Nways Deployment Manager
database is 0.

v If you selected Learn Selected... from the Filtered List pane or Custom List pane
of the Configurations panel, the list of 8275-416 devices will include all 8275-416
devices selected on that pane.

Candidates Action Buttons
Use the Candidates action button to perform actions from the Candidates pane.
These action buttons are displayed for the Candidates pane:

Clicking this button... Performs this action...

Set all Selects all candidates listed in the Candidates pane.

Reset all Deselects all candidates listed in the Candidates pane.
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Import 8275-416 Configurations
The Import 8275-416 Configuration dialog allows you to import a configuration file
into the NwDM database.

To display the Import 8275-416 Configurations dialog, select one or more
configurations from either the Filtered List task pane or the Custom List task pane
of the 8275-416 Configurations panel, click Process selected... , and then click
Import selected... .

The Import 8275-416 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Import from Server File Import the configuration from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the configuration from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the configuration from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the configuration file.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the configuration file.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
is located.

A valid host name or IP
address.

Login user ID The user ID used to log in to the FTP
server

A valid user ID.

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File or Back to
return to the Method tab.

File Tab
Use the FTP tab to specify information about the file name to be used for importing
the configuration and the directory where the configuration file is currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are importing only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are importing more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The imported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the configuration file
is located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the import
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a naming convention).

After entering information for the FTP tab, click Next to display the Misc tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the configuration file.

Click Import to begin importing the configuration file. The Import Configuration task
is an interactive task. The current status of the import task is displayed in the
Message window.

From the Results tab, you can click Back to return to the previous tab.
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Export 8275-416 Configurations
The Export 8275-416 Configurations dialog allows you to export a configuration file
from the NwDM database.

To display the Export 8275-416 Configurations dialog, select one or more
configurations from either the Filtered List task pane or the Custom List task pane
of the 8275-416 Configurations panel, click Process selected... , and then click
Export selected... .

The Export 8275-416 Configurations dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the configuration file.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the configuration to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the configuration to a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Export the configuration to an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the configuration file will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported
configuration file will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the configuration file will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the configuration file
will be exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the file name to be used for exporting
the configuration file and the directory where the configuration file will be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Don’t use a
naming
convention

That no naming convention is to be used.

If you are exporting only one
configuration file, you can choose not to
use a naming convention. However, you
must still specify a file name in the
Directory field.

If you are exporting more than one
configuration file, you will not be able to
choose this option. You must use a
naming convention.

A dot if the radio button is
selected.
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This field... Is used to specify... It can contain...

Use IP address
for naming
convention

The IP address (as it is recorded in the
NwDM database). The exported file will
use the IP address as the file name.

A dot if the radio button is
selected.

Use device ID
for naming
convention

The device ID (as it is recorded in the
NwDM database). The file name will be in
this format:

DeviceID.VersionNumber

where DeviceID is the device identifier
and VersionNumber is the number
associated with this configuration version
by NwDM.

A dot if the radio button is
selected.

Directory The directory where the exported
configuration file will be located. Use a
forward slash (/) to separate directories
and subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory (and
filename if you chose not to
use a file naming
convention).

After entering information for the File tab, click Next to display the Misc tab or Back
to return to the previous tab.

Results Tab
Use the Results tab to begin exporting the configuration file.

Click Export to begin exporting the configuration file. The Export Configuration task
is an interactive task. The current status of the export task is displayed in the
Messages window.

From the Results tab, you can click Back to return to the previous tab.
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8275-416 Load Images
Load images contain the operational code that runs in a 8275-416. Information
about specific load images is initially loaded into the NwDM database when you
update software inventory for the 8275-416 (you also have the option of loading the
actual Load Image into the database at that time). These load images correspond
to the operational code releases of the 8275-416 software.

Use the Load Images task panel to manage 8275-416 load images. To display the
8275-416 Load Images task panel, click Load images from the 8275-416 folder of
the navigation tree.

The Load Images task panel is divided into these panes:

v Filter

v Filtered List

v Custom List

You can display the help panel for the Load Images task panel by clicking Help .

Filter Pane
The Filter pane provides a way to search the Deployment Manager database for
load images. The Filter pane contains these columns:

v Properties. The Properties column is a list of load image properties on which you
can search theNwDM database.

v Comparison Operator. The Comparison Operator column lists ways to refine the
search of the NwDM database.

v Property Value field. When you apply the filter to the database, Deployment
Manager compares the data you enter in the Property Value field with the load
images found in the database using the comparison operator you specified.

After entering data in the Filter pane, click Apply Filter to display the results of the
search in the Filtered List pane.

Load Image Filter List Properties
You can search on these load image properties:

This
property...

Is used to describe...

Name The name of the load image.

Version The software version to which this load image applies.

Release The software release to which this load image applies.

PTF The program temporary fix (PTF) to which this load image applies.

Modified at Date and time this load image was added to the database.

Download
URL

The URL where the load image can be found.

Information
URL

The URL where information about this load image can be found.

Image length The number of bytes in the NwDM database taken up by this load image. If
the load image is not stored in the database, this value is 0.

Build name An identifier used by NwDM to identify this load image.
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Configuration Comparison Operators
Over time the number of load image records stored in the NwDM database can
grow to be quite large. Using comparison operators allow you to refine your search
of the database so that only load image records that meet specific criteria are
returned. For a list of the comparison operators and information about entering data
into the Load images filter, see “Working with Deployment Manager Filters and
Tables” on page 10.

Filtered List Pane
The results of the search from the Filter are displayed in the Filtered List task pane.

The Filtered List task pane displays each load image as a separate row. To select a
load image, click anywhere in the row, which highlights the row. Use one of these
methods to select multiple load images:

v Click on a single row and without releasing the mouse button, drag the mouse
either up or down.

v Press and hold the Ctrl key; then click on the rows that you want to select.

Information about the load image is displayed in each of the columns. To reorder
the columns, press Ctrl and Shift keys, and then click on the header of the column
you want to move. The cursor changes to a hand. Drag the cursor to the desired
location and release both keys.

You can also sort the Filtered List by the values in a column. Click the column
header to sort the Jobs List in ascending order by the values in that column. Click
the column header again to sort the values for that column in descending order.

Filtered List Action Buttons
Use the Filtered List action button to perform actions on one or more selected load
images. These action buttons are displayed for the Filtered List task pane:

Clicking this button... Performs this action...

Select All Selects all load images listed in the Filtered List task pane.

Unselect All Deselects all selected load images listed in the Filtered List task
pane.

Process selected Displays the pop-up menu for the Filtered List task pane.

Add selected to custom
list

Adds the selected load images to the Custom List task pane.

Filtered List Pop-Up Menu
To display the Filtered List pop-up menu, select one or more rows, and click
Process selected... .

In addition to the actions available from the action buttons, these actions are
available from the Filtered List pop-up menu:

Clicking... Performs this action...

Hide Column... Displays the Visible Column dialog, which allows you to hide one or more
columns in the Filtered List task pane. From the Visible Column dialog,
click the columns that you want to hide and click Ok.

Show Column... Displays the Hidden Column dialog, which allows you to display columns
in the Filtered List task pane. From the Hidden Column dialog, click the
columns that you want to appear in the Jobs List and click Ok.
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Clicking... Performs this action...

Go to Row... Displays the Go to Row dialog, which allows you to go to a specified row
in the Filtered List task pane. From the Go to Row dialog, type a row
number and click Ok. The cursor is displayed at that row in the Filtered
List task pane.

Print... Displays the Print dialog, which allows you to print selected load image
records. From the Print dialog, verify the print information is correct and
click Print .

Print Preview... Displays a preview of how the selected load image records will print.
Click Close to return to the Jobs List task pane.

Delete selected
Image files...

Deletes selected load images from the NwDM database. When the
Confirm Load Image File Delete dialog is displayed, click Yes to delete
the load image.

Import selected
Image files...

Displays the Import 8275-416 Load Images dialog, which you can use to
import a load image into the NwDM database. See “Import 8275-416
Load Images” on page 190 for information about importing a load image.

Export selected
Image files...

Displays the Export 8275-416 Load Images dialog, which you can use to
export a load image from the NwDM database. See “Export 8275-416
Load Images” on page 193 for information about exporting a load image.

Custom List Pane
The Custom List Pane is a table similar to that displayed in the Filtered List pane.
In fact, the action buttons and pop-up menu are the same for the Custom List pane
as for the Filtered List pane (except that the Add selected to custom list action
button is replaced with Removed selected from custom list action button).

The Custom List pane provides a way to generate a list of load image records
based on the results of applying multiple filters. For example, you could apply a
filter to generate a list of load image records with a length of 0 for the Filtered List
pane that. Next, you would select any or all of those records and click Add
selected to custom list to add them to the Custom List pane. Then, you would
apply a filter to generate a list of load image records that apply to MRS Version 3.
Again, select any or all of these records and apply them to the custom list. The
result is a custom list based on the results of different filters.
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Import 8275-416 Load Images
The Import 8275-416 Load Images dialog allows you to import a load image into the
NwDM database. To display the Import 8275-416 Load Images dialog, select one or
more load images from either the Filtered List task pane or the Custom List task
pane of the 8275-416 Load Images task panel, click Process selected... , and then
click Import selected image files... .

The Import 8275-416 Load Images dialog contains these tabs:

v Method

v TFTP

v Download URL

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to import the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Use specified download
URL

Import the load image from an FTP server. You can use this
option to import the load image from an IBM web site. When
you click Next , the Download URL tab is displayed.

Import from server file Import the load image from the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Import the load image from a TFTP server. When you click
Next , the TFTP tab is displayed.

Use FTP Import the load image from an FTP server. When you click
Next , the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server from which you want to import the load image.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

Download URL Tab
Use the Download URL tab to provide the URL information for importing the load
image.

Enter this information on the Download URL tab:

This field... Is used to specify... It can contain...

Override
download URL
host with

The download host to use. If you choose
IBM-North America or IBM-Europe, the
FTP tab is updated to with the
appropriate information.

No override - use download
URL host

IBM-North America

IBM-Europe

Other FTP Host

After entering information for the Download URL tab, click Next to display the FTP
tab or Back to return to the previous tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server from which you want to import the load image.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image is
located.

A valid host name or IP
address.

Login user ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.
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File Tab
Use the File tab to specify information about the directory where the load image is
currently located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the load image is
located. Use a forward slash (/) to
separate directories and subdirectories.

This field is called Directory/Filename,
TFTP Host Directory, or FTP Host
Directory, depending on the import
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.

Results Tab
Use the Results tab to begin importing the load image.

Click Import to begin importing the load image. The Import Load Images task is an
interactive task. The current status of the import task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Export 8275-416 Load Images
The Export 8275-416 Load Images dialog allows you to export a load image from
the NwDM database.

To display the Export 8275-416 Load Images, select one or more load images from
either the Filtered List task pane or the Custom List task pane of the 8275-416
Load Images panel, click Process selected... , and then click Export selected
image files... .

The Export 8275-416 Load Images dialog contains these tabs:

v Method

v TFTP

v FTP

v File

v Results

Method Tab
Use the Method tab to specify how you want to export the load image.

Choose one of these options on the Method tab:

Click this radio button... If you want to...

Export to Server File Export the load image to the NwDM server. When you click
Next , the File tab is displayed.

Use TFTP Export the load image to a TFTP server. When you click Next ,
the TFTP tab is displayed.

Use FTP Export the load image to an FTP server. When you click Next ,
the FTP tab is displayed.

TFTP Tab
If you click Use TFTP on the Method tab, use the TFTP tab to specify information
about the TFTP server to which the load image will be exported.

Enter this information on the TFTP tab:

This field... Is used to specify... It can contain...

TFTP host The host name or IP address of the
TFTP server where the exported load
image will be located.

A valid host name or IP
address.

Timeout (secs) The length of time in seconds that a
delay in communication can occur
between the NwDM server and the TFTP
server before the TFTP operation times
out.

If the job logs for importing files contain
timeout errors, you may need to increase
this value.

A number.
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This field... Is used to specify... It can contain...

Max Retries The number of attempts that will be made
to resend data in the event of lost or
corrupt packets. If the TFTP operation
exceeds this limit, the operation fails.

A number.

After entering information for the TFTP tab, click Next to display the File tab or
Back to return to the Method tab.

FTP Tab
If you clicked Use FTP on the Method tab, use the FTP tab to specify information
about the FTP server to which the load image will be exported.

Enter this information on the FTP tab:

This field... Is used to specify... It can contain...

FTP host The host name or IP address of the
TFTP server where the load image will be
exported.

A valid host name or IP
address.

Login User ID The user ID used to log in to the FTP
server

A valid user ID

Password The password associated with the user
ID.

A valid password.

Use socks
server

Whether the FTP server resides behind a
firewall.

A check mark if the box is
selected.

Socks server
host

The host name or IP address of the
socks server.

A valid host name or IP
address.

Socks server
port

The port to be used for the socks server. A number between 1 and
65535 inclusive. The default
is 1080.

After entering information for the FTP tab, click Next to display the File tab or Back
to return to the Method tab.

File Tab
Use the File tab to specify information about the directory where the load image will
be located.

Enter this information on the File tab:

This field... Is used to specify... It can contain...

Directory The directory where the exported load
image will be located. Use a forward
slash (/) to separate directories and
subdirectories.

This field is called Directory/Filename,
TFTP Server Directory, or FTP Server
Directory, depending on the export
method you chose on the Method tab.

A valid directory.

After entering information for the File tab, click Next to display the Results tab or
Back to return to the previous tab.
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Results Tab
Use the Results tab to begin exporting the load image.

Click Export to begin exporting the load image. The Export Load Image task is an
interactive task. The current status of the export task is displayed in the Messages
window.

From the Results tab, you can click Back to return to the previous tab.
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Update 8275-416 Configuration
When you update an 8275-416 configuration, you are changing the configuration
that is currently loaded in the device (the active configuration) to another
configuration that you select. The configuration that you select must have a
configuration status of inactive. Configuration updates are scheduled as jobs (you
can use the Managing Jobs panel to view the status of an update job.

After updating the information on the 8275-416 Learn Configurations task panel,
click Apply to save your changes or Cancel to discard all changes (the Cancel
button is displayed only if you displayed the 8275-416 Learn Configurations task
panel from the Configurations task panel). To display the help for this task panel,
click Help .

Options Pane
Use the Options pane to specify this information about the update task:

This field... Is used to... It can contain...

Earliest start Specify the earliest date and time that
this task can begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Latest start Specify the latest date and time that this
task can begin. If it does not begin by this
date and time, it is not started at all.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Start now Specify that the 8275-416 Update
Configuration task should begin
immediately (when you click Apply).

A check mark if the box is
selected.

196 NwDM User’s Guide



This field... Is used to... It can contain...

Reset Option Determine when the 8275-416 device is
to be restarted after the configuration has
been applied. These options are
available:

v No Reload. The 8275-416 device is not
restarted. However, the new
configuration will not take effect in the
device until a reload is performed.

v Reload immediately. Restart the
8275-416 to load the new configuration
immediately after NwDM downloads it
to the 8275-416.

No reload

Reload immediately

Timed load Specify the date and time that the reload
should begin.

The format yy/mm/dd hh:mn
d where:

v yy is the year (1-99)

v mm is the month (1-12)

v dd is the day of the month
(1-31)

v hh is the hour of the day
(1-24)

v mn is the minute of the
hour (1-60)

v d is either AM (before
noon) or PM (before
midnight)

Bank Option Specify how configurations currently
loaded into the device should be handled.
These options are available:

v Erase none. Do not erase any
configurations that are currently in the
device.

v Erase available if needed. Erase any
available configurations that are
currently in the device, if necessary.

v Erase any. Erase any configurations
that are currently in the device.

Erase none

Erase available if needed

Erase any

Configuration
file checking

Determines whether or not mismatches
are allowed when the device
configuration file is checked with the
configuration file in the NwDM database.

Disallow mismatches

Allow mismatches
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This field... Is used to... It can contain...

Stop at state Specify when processing for this update
job will stop. These options are available:

v None. Do not stop processing.

v Next state. Stop processing when the
current state is complete.

v Init. The initial phase.

v Prepare. The Prepare phase. During
the Prepare phase, NwDM performs
these actions:

– Loads the code and configuration
on the TFTP server.

– Deactivates timed load.

– Downloads the code and
configuration as needed.

– Modifies the status of the ″from″
configuration loaded in the NwDM
database to Obsolescent and the
″to″ configuration to Nascent.

v Perform. The Perform phase. During
the Perform phase, NwDM performs
these actions:

– Reloads or restarts the device.

v Verify. The Verify phase. During the
Verify phase, NwDM performs these
actions:

– Verifies the load image and the
configuration.

– Modifies the status of the
configuration loaded in the NwDM
database to either Inactive or
Active.

None

Next state

Init

Prepare

Perform

Verify
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Appendix. Notices

This information was developed for products and services offered in the U.S.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area.

References in this publication to IBM products, programs, and services do not imply
that IBM intends to make these available in all countries in which IBM operates. Any
reference to an IBM product, program, or service is not that only IBM’s product,
program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any of IBM’s intellectual property rights may be used
instead of the IBM product, program, or service. Evaluation and verification of
operation in conjunction with other products, except those expressly designated by
IBM, are the user’s responsibility.

IBM may have patents or pending patent applications covering the subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.
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Trademarks
The following terms are trademarks of the IBM Corporation in the United States or
other countries or both:

Nways Etherstreamer Netfinity
DB2 IBM LANStreamer
DB2 Universal Database

Java and HotJava, and the Java Logo are trademarks of Sun Microsystems, Inc.

Microsoft, Windows, Windows NT, and the Windows 95 and Windows 98 logos are
trademarks or registered trademarks of Microsoft Corporation.

Pentium® is a registered trademark of Intel Corporation in the U.S and other
countries.

Navigator is a trademark of Netscape Communications Corporation.

Adobe Acrobat Reader is a registered trademark of Adobe Systems, Inc.

Other company, product, and service names may be trademarks or service marks
of others.
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Import 8275-416 Load Images task panel 190
installation

troubleshooting 5

J
job dispatching

parameters 4
job properties 45
Jobs task panel 45

L
Learn 2210 Configurations task panel 75
Learn 2212 Configurations task panel 115
Learn 2216 Configurations task panel 147
Learn 8275–416 Configurations task panel 179
learning device configurations 17
load images

2210 86
2212 126
2216 158
8275–416 187

O
overview, Deployment Manager 1

P
parameters

DB2 2
GUI configuration tool 4
job dispatching 4
Telnet 3
TFTP 2

PROM code
loading in 2210 25
updating in 2210 25

PROM Images, 2210 95
properties file 1

contents 2

properties file 1 (continued)
editing 1
sample 4

S
Set User task panel 44
setting the user ID 12
software inventory

managing different levels of code 13
updating 14
updating properties 13
viewing different levels of code 14

Software Inventory
properties 63
updating 65

synchronize databases 15
Synchronize Databases task panel 61

T
tables, using 10
task panels

2210 67
2212 107
2216 139
8275–416 171
Deployment Manager 43

Telnet
parameters 3

temp files 2
TFTP

parameters 2
troubleshooting

installation 5

U
Update 2210 Configuration task panel 104
Update 2212 Configuration task panel 135
Update 2216 Configuration task panel 167
Update 8275–416 Configuration task panel 196
Update Software Inventory task panel 65
updating

2210 configuration 24
2210 PROM code 25
2212 configuration 31
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202 NwDM User’s Guide



Readers’ Comments — We’d Like to Hear from You

Nways Deployment Manager
User’s Guide

Publication No. GA27-4246-00

Overall, how satisfied are you with the information in this book?

Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied
Overall satisfaction h h h h h

How satisfied are you that the information in this book is:

Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied
Accurate h h h h h

Complete h h h h h

Easy to find h h h h h

Easy to understand h h h h h

Well organized h h h h h

Applicable to your tasks h h h h h

Please tell us how we can improve this book:

Thank you for your responses. May we contact you? h Yes h No

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

Name Address

Company or Organization

Phone No.
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